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Basics

1 Basics

This chapter provides basic information on operating an instrument via remote control.
1.1 Remote Control Interfaces

For remote control, Ethernet or USB interface can be used. A dual interface USB/RS-232 or GPIB
interface are optional available.

SCPI (Standard Commands for Programmable Instruments) SCPl commands - messages - are
used for remote control. Commands that are not taken from the SCPI standard follow the SCPI
syntax rules.

1.1.1 USB Interface

In addition to a LAN interface, the HMO3000 series includes a USB device port. If you are using
USB you need to install an USB driver, which can be downloaded free of charge from the Hameg
homepage. The traditional version of the VCP allows the user to communicate with the instru-
ment using any terminal program via SCPI commands once the corresponding Windows drivers
have been installed. Naturally, the free software “HMExplorer” is also available for the HMO3000
series. This Windows application offers a terminal function, the option to create screenshots and
to read out the measured data from the HMO memory.

The available USB driver is fully tested, functional and released for Windows XP™,
Windows Vista™, Windows 7™ or Windows 8™, both as 32Bit or 64Bit versions.

The USB interface has to be chosen in the SETUP menu and does not need any setting.

1.1.2 RS-232

If you use RS-232 you do not need any driver. In order to set the RS-232 parameter, please press
the SETUP button and choose the soft menu key INTERFACE. Make sure the RS-232 interface

is chosen and press the button PARAMETER. In the parameter menu you can set and save all
parameter for the RS-232 communication. Setting of the RS-232 must fit the setting of the corre-
sponding PC COM Port.

1.1.3 GPIB Interface (IEC/IEEE Bus Interface)

To be able to control the instrument via the GPIB bus, the instrument and the controller have be
linked by a GPIB bus cable. A GPIB bus card, the card drivers and the program libraries for the
programming language have to be provided in the controller. The controller must address the
instrument with the GPIB instrument address.

e
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Characteristics

The GPIB interface is described by the following characteristics:

e Up to 15 instruments can be connected

e The total cable length is restricted to a maximum of 15 m; the cable lenth between two instru-
ments should not exceed 2 meters.

e A wired ,OR”-connection is used if several instruments are connected in parallel.

GPIB Instrument Address

In order to operate the instrument via remote control, it has be addressed using the GPIB
address. The remote control address is factory-set to 20, but it can be changed in the network
environment settings or in the ,Setup” menu under , Interface > Parameter”. For remote control,
addresses 0 through 30 are allowed. The GPIB address is maintained after a reset of the instru-
ment settings.

Valid VISA resource string:
GPIB::<n>::INSTR

<n> GPIB address
Example: GPIB::1::INSTR

Ethernet (LAN) Interface

The settings of the parameter will be done after selecting the menu item ETHERNET and the
soft key PARAMETER. You can set a fix IP adress or a dynamic IP setting via the DHCP function.
Please ask your IT department for the correct setting at your network.

IP address

To set up the connection the IP address of the instrument is required. It is part of the resource
string used by the program to identify and control the instrument. The resource string has the
form:

TCPIP::<IP_address>::<IP_port>::SOCKET

The default port number for SCPI socket communication is 5025. IP address and port number
are listed In the , Ethernet Settings” of the HMO3000 series, see also: chapter 1.2.2,”Configuring
LAN Parameters”.

Example:
If the instrument has the IP address 192.1.2.3; the valid resource string is:

TCPIP::192.1.2.3::5025::SOCKET

If the LAN is supported by a DNS server, the host name can be used instead of the IP address.
The DNS server (Domain Name System server) translates the host name to the IP address. The
resource string has the form:

TCPIP::<host_name»::<IP_port::SOCKET

To assign a host name to the instrument, select SETUP button » MISC » DEVICE NAME.
If the host name is HAMEGT1; the valid resource string is:

TCPIP::HAMEG1::5025::SOCKET

e
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The end character must be set to linefeed.

1.2 Setting Up a Network (LAN) Connection

1.2.1 Connecting the Instrument to the Network

Risk of network failure
Before connecting the instrument to the network or configuring the network, consult
your network administrator. Errors may affect the entire network.

The network card can be operated with a 10 Mbps Ethernet IEEE 802.3 or a 100 Mbps Ethernet
|IEEE 802.3u interface.

To establish a network connection, connect a commercial RJ-45 cable to one of the
LAN ports of the instrument and to a PC.

1.2.2 Configuring LAN Parameters

Depending on the network capacities, the TCP/IP address information for the instrument can
be obtained in different ways. If the network supports dynamic TCP/IP configuration using the
Dynamic Host Configuration Protocol (DHCP), and a DHCP server is available, all address infor-
mation can be assigned automatically. Otherwise, the address must be set manually. Automatic
Private IP Addressing (APIPA) is not supported.

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain all
address information automatically. This means that it is safe to establish a physical connection to
the LAN without any previous instrument configuration.

Risk of network errors

Connection errors can affect the entire network. If your network does not support
DHCEP, or if you choose to disable dynamic TCP/IP configuration, you must assign valid
address information before connecting the instrument to the LAN. Contact your net-
work administrator to obtain a valid IP address.

SCPI Programmers Manual 6
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Configuring LAN parameters
e Press the SETUP key and then the Interface softkey.
e Press the Ethernet and then the Parameter softkey.

If the instrument is set to use DHCP and cannot find a DHCP server, it takes about two
minutes until the Ethernet menu is available.

The ,Ethernet Settings” dialog box is displayed.

INTERFACE

Ethernet 5

DEFALLT

Fig. 1.1: Ethernet Settings dialog box

Some data is displayed for information only and cannot be edited. This includes the ,MAC"” (phy-
sical) address of the connector and the , Link” status information.

e Define the IP address of the instrument by entering each of the four blocks individually (ma-
nual mode) or choose the automatic IP-Mode.
a) In manual mode (MAN) define the first block number using the knob.
b) Press Next to move to the next block and define the number.
c) When the IP address is complete, press Down to continue with the next setting.

e Define the ,Subnetmask” and , Gateway” in the same way.

e Select the ,IP Port” - the port number for SCPI socket communication.

e Select the ,HTTP Port” used by the instrument.

e Select the , Transfer” mode. This mode can either be determined automatically (,Auto” set-
ting), or you can select a combination of a transfer rate and half or full duplex manually.

e Press Save to save the LAN parameters.

The ,,Link” status information at the bottom of the dialog box indicates whether a LAN
connection was established successfully.

e
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Checking LAN and SCPI connection

e Check the LAN connection using ping: ping XxX.yyy.zzz.XXx.

e |f the PC can access the instrument, enter the IP address of the address line of the internet
browser on your computer: http//:xxx.yyy.zzz.xxx

e The ,Instrument Home" page appears. It provides information on the instrument and the LAN
connection.

1.3 Switching to Remote Control

When you switch on the instrument, it is always in manual operation state (,local” state) and
can be operated via the front panel. When you send a command from the control computer, it is
received and executed by the instrument. The display remains on, manual operation via the front
panel is always possible.

1.4 Messages and Command Structure
1.4.1 Messages

Instrument messages are employed in the same way for all interfaces, if not indicated otherwise
in the description.

See also:

e Structure and syntax of the instrument messages: chapter 1.4.2, ,SCPI Command Structure”.
e Detailed description of all messages: chapter 2, ,Command Reference”.

There are different types of instrument messages:
e Commands
e [nstrument responses

Commands

Commands (program messages) are messages which the controller sends to the instrument.
They operate the instrument functions and request information. The commands are subdivided
according to two criteria:

According to the instrument effect:

e Setting commands cause instrument settings such as a reset of the instrument or setting the
frequency.

e Queries cause data to be provided for remote control, e.g. for identification of the instrument
or polling a parameter value. Queries are formed by appending a question mark to the com-
mand header.

According to their definition in standards:

e The function and syntax of the Common commands are precisely defined in standard IEEE
488.2. They are employed identically on all instruments (if implemented). They refer to func-
tions such as management of the standardized status registers, reset and self test.

e |nstrument control commands refer to functions depending on the features of the instrument
such as voltage settings. Many of these commands have also been standardized by the SCP!I
committee. These commands are marked as ,,SCPI compliant” in the command reference
chapters. Commands without this SCPI label are device-specific, however, their syntax follows
SCPI rules as permitted by the standard.

e
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Instrument responses

Instrument responses (response messages and service requests) are messages which the instru-
ment is sent to the controller after a query. They can contain measurement results, instrument
settings and information on the instrument status.

LAN Interface Messages
In the LAN connection, the interface messages are called low-level control messages. These
messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument

&DCL Device Clear Aborts processing of the commands just recei-
ved and sets the command processing software
to a defined initial state. Does not change the
instrument setting.

&GTL Go to Local Transition to the ,local” state (manual control).
&GTR Go to Remote Transition to the ,,remote” state (remote control).
&LLO Local Lockout Disables switchover from remote control to ma-

nual control by means of the front panel keys.

&NREN Not Remote Enable Enables switchover from remote control to ma-
nual operation by means of the front panel keys

Table 1.1: LAN Interface Messages

Universal Commands
Universal commands are encoded in the range 10 through 1F hex. They affect all instruments
connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and
sets the command processing software to a defined initial
state. Does not change the instrument settings.

IFC (Interface Clear) Resets the interfaces to the default setting.

IFC is not a real universal command, it is sent via a separate
line; it also affects all instruments connected to the bus and
does not require addressing

LLO (Local Lockout) The LOC/IEC ADDR key is disabled.
SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfi- End of the parallel-poll state.

gure)

Table 1.2: Universal Commands

SCPI Programmers Manual 9
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Addressed Commands
Addressed commands are encoded in the range 00 through OF hex. They only affect instruments
addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a
sweep). The effect of the command is the same as with
that of a pulse at the external trigger signal input.

GTL (Go to Local) Transition to the ,local” state (manual control).

GTR (Go to Remote) Transition to the ,,remote” state (remote control).
PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received

and sets the command processing software to a defined
initial state. Does not change the instrument setting.

Table 1.3: Addressed Commands

1.4.2 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more parameters. The
header and the parameters are separated by a ,white space” (ASCIl code 0 to 9, 11 to 32 deci-
mal, e.g. blank). The headers may consist of several mnemonics (keywords). Queries are formed
by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common commands).
Common and device-specific commands differ in their syntax.

Syntax for Common Commands
Common (=device-independent) commands consist of a header preceded by an asterisk (*) and
possibly one or more parameters.

*RST Reset Resets the instrument.

*ESE Event Status Enable Sets the bits of the event status enable registers.
*ESR? Event Status Query Queries the content of the event status register.
*IDN? Identification Query Queries the instrument identification string.

Table 1.4: Examples of Common Commands

SCPI Programmers Manual 10
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Syntax for Device-Specific Commands

For demonstration purposes only, assume the existence of the following commands for this
section:

e ACQuire:POINts:ARATe

CALCulate:QMATh<m>:STATe

CHANnNel<m>:DATA:POINts

BUS<b>:STATe

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper case
letters, the long form corresponds to the complete word. Either the short form or the long form
can be entered; other abbreviations are not permitted.

Example: CALCulate:QMATh<m>:STATe ON is equivalent to CALC:QMAT<m>:STAT ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or sour-
ces, the required instances can be specified by a suffix added to the command.

Numeric suffixes are indicated by angular brackets (<1...2>, <m>) and are replaced by a single
value in the command. Entries without a suffix are interpreted as having the suffix 1.

Example:
Definition: CHANnel<m>:STATe ON
Command: CHAN2:STAT ON

This command activates channel CH2.

Different numbering in remote control

For remote control, the suffix may differ from the number of the corresponding selec-
tion used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix
1 is the default state and used when no specific suffix is specified.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or omitted.
These mnemonics are marked by square brackets. The instrument must recognize the long
command to comply with the SCPI standard. Some commands are shortened by these optional
mnemonics.

Example:
HardCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

e
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Special characters

A vertical stroke in parameter definitions indicates alternative possibilities in the
sense of ,or”. The effectof the command differs, depending on which parameter is
used.

[ Example:

HardCOPy:PAGE:ORlentation LANDscape | PORTrait
HCOP:PAGE:ORI LAND specifies landscape orientation.
HCOP:PAGE:ORI PORT specifies portrait orientation.

Mnemonics in square brackets are optional and may be inserted into the header or

omitted.
(] Example:
HardCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP.
{} Parameters in curly brackets are optional.

Table 1.5: Special characters

SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The parameters
must be separated from the header by a , white space” (ASCIl code 0 to 9, 11 to 32 decimal, e.qg.
blank). Allowed parameters are:

e Numeric values

e Special numeric values

e Boolean parameters

° Text

e Character strings

e Block data

The parameters required for each command and the allowed range of values are specified in the
command description.

Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent. Values
exceeding the resolution of the instrument are rounded up or down. The mantissa may com-
prise up to 255 characters, the exponent must lie inside the value range -32000 to 32000. The
exponent is introduced by an ,E” or ,e". Entry of the exponent alone is not allowed. In the case
of physical quantities, the unit can be entered. Allowed unit prefixes are G (giga), MA (mega),
MOHM and MHZ are also allowed), K (kilo), M (milli), U (micro) and N (nano). If the unit is mis-
sing, the basic unit is used.

Example: TIMebase:SCALe 10us = TIM:SCAL 1e-5

SCPI Programmers Manual 12
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Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:
* G (giga)

¢ MA (mega), MOHM, MHz

K (kilo)

M (milli)

e U (micro)

e N (nano)

If the unit is missing, the basic unit is used.

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query, the nu-
meric value is provided.

e  MIN/MAX/DMAX/DEF

e MINimum and MAXimum denote the minimum and maximum value

Example:
CHAN1:DATA:POIN DEF
CHAN1.DATA:POIN?, Response: 6000

Boolean Parameters

Boolean parameters represent two states. The ,ON” state (logically true) is represented by ,,ON”
or a numeric value 1. The ,,OFF” state (logically untrue) is represented by ,,OFF” or the numeric
value 0. The numeric values are provided as the response for a query.

Example:
CHANZ2:STAT ON
CHANZ2:STAT?, Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered using a
short or long form. Like any parameter, they have to be separated from the header by a white
space. In the case of a query, the short form of the text is provided.

Example:
HardCOPy:PAGE:ORlentation LANDscape
HCOP:PAGE:ORI?, Response: LAND

Block data

Block data is a format which is suitable for the transmission of large amounts of data. The ASCII
character # introduces the data block. The next number indicates how many of the following
digits describe the length of the data block. In the example the 4 following digits indicate the
length to be 5168 bytes. The data bytes follow. During the transmission of these data bytes all
end or other control signs are ignored until all bytes are transmitted. #0 specifies a data block of
indefinite length. The use of the indefinite format requires a NLAEND message to terminate the
data block. This format is useful when the length of the transmission is not known or if speed or
other considerations prevent segmentation of the data into blocks of definite length.

SCPI Programmers Manual 13
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Overview of Syntax Elements
The following table provides an overview of the syntax elements:

The colon separates the mnemonics of a command. In a command line the separa-
ting semicolonmarks the uppermost command level.

The semicolon separates two commands of a command line. It does not alter the

path.
, The comma separates several parameters of a command.
? The question mark forms a query.
* The asterisk marks a common command.

Quotation marks introduce a string and terminate it.

The hash symbol introduces binary, octal, hexadecimal and block data.
— Binary: #810110

Octal: #07612

Hexa: #HF3A7

— Block: #21312

+*
|

A ,white space” (ASCII-Code 0t0 9, 11 to 32 decimal, e.g. blank) separates the
header from the parameters.

Table 1.6: Syntax Elements

Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the follow-
ing:

e a <New Line>

e a <New Line> with EOI

e an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ,,;”. If the next com-
mand belongs to a different command system, the semicolon is followed by a colon.

Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is formed
by adding a question mark to the associated setting command. According to SCPI, the re-
sponses to queries are partly subject to stricter rules than in standard IEEE 488.2.

e The requested parameter is transmitted without a header.

Example:
HCOP:PAGE:ORI?, Response: LAND

e Maximum values, minimum values and all other quantities that are requested via a special
text parameter are returned as numeric values.

Example:
CHAN1:DATA:POIN DEF
CHAN1.DATA:POIN?, Response: 6000

SCPI Programmers Manual 14
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e Truth values (Boolean values) are returned as O (for OFF) and 1 (for ON).

Example:
CHANZ2:STAT ON
CHANZ2:STAT?, Response: 1

e Text (character data) is returned in a short form.

Example:
HardCOPy:PAGE:ORlentation LANDscape
HCOP:PAGE:ORI?, Response: LAND

Command Sequence and Synchronization

A sequential command finishes executing before the next command starts executing. Com-
mands that are processed quickly are usually implemented as sequential commands. Setting
commands within one command line, even though they may be implemented as sequential
commands, are not necessarily serviced in the order in which they have been received. In order
to make sure that commands are actually carried out in a certain order, each command must be
sent in a separate command line.

As a general rule, send commands and queries in different program messages.

1.5.1

Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC? or *WAI

can be used. All three commands cause a certain action only to be carried out after the hardware
has been set. By suitable programming, the controller can be forced to wait for the correspondi-

ng action to occur.

Command Action Programming the controller
Sets the Operation Complete bit in the e Setting bit 0 in the ESE
*OPC ESR after all previous commands have e  Setting bit 5 in the SRE
been executed. e \Waiting for service request
(SRQ)
Stops command processing until 1 is Sending *OPC? directly after
returned.This is only the case after the the commandwhose processing
*OPC? Opera-tion Complete bit has been set in should be terminated beforeother
the ESR. This bit indicates that the previ- commands can be executed.

ous setting has been completed.

Stops further command processing until Sending *WAI directly after the
*WAI allcommands sent before *WAI have been | commandwhose processing
executed. should be terminated beforeother

commands are executed

Table 1.7: Synchronization using *OPC, *OPC? and *WAI
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Command synchronization using *WAI or *OPC? appended to an overlapped command is a
good choice if the overlapped command takes time to process. The two synchronization tech-
niques simply block overlapped execution of the command. For time consuming overlapped
commands it is usually desirable to allow the controller or the instrument to do other useful work
while waiting for command execution. Use one of the following methods

*OPC with a service request

Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

e Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.
Send the overlapped command with *OPC

e \Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

e Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

e Send the overlapped command with *OPC?

e \Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

e Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

e Send the overlapped command without *OPC, *OPC? or *WAI

e Poll the operation complete state periodically (by means of a timer) using the sequence:
*OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

*OPC? with short timeout

e Send the overlapped command without *OPC, *OPC? or *WAI

e Poll the operation complete state periodically (by means of a timer) using the sequence: «short
timeout; *OPC?

e A return value (LSB) of 1 indicates that the overlapped command has finished. In case of a
timeout, the operation is ongoing.

e Reset timeout to former value

e Clear the error queue with SYStem:ERRor? to remove the ,-410, Query interrupted” entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application sup-
ports threads, separate threads can be used for the application GUI and for controlling the
instrument(s) via SCPI. A thread waiting for a *OPC? thus will not block the GUI or the communi-
cation with other instruments.

1.6 Status Reporting System
The status reporting system stores all information on the current operating state of the instru-

ment, and on errors which have occurred. This information is stored in the status registers and in
the error queue. Both can be queried via LAN interface (STATus... commands).
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Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has diffe-
rent functions. The individual bits are independent of each other, i.e. each hardware status is
assigned a bit number which is valid for all five parts. Bit 15 (the most significant bit) is set to
zero for all parts. Thus the contents of the register parts can be processed by the controller as
positive integers.

15|14 |13[12 COMDition part 1 & = logical AMD
¢ i ¢ ¢ ¢ &= logical OR
1614 |13 (12 PTRansition part 1

12 MTRansition part

=] <« [ =
S ee]o o

Y
.

EVEM part

to higher-order register
&4 & & & & & &

fr ]

o P oo | | o ]

.
& Sum bit

— et o o
N

Sl i el
o o|lg— o| o ldg— =

o
—
=

| EMABle part

Fig. 1.4: The status-register model

Description of the five status register parts
The five parts of a SCPI register have different properties and functions:

CONDition

e The CONDition partis written into directly by the hardware or the sum bit of the next lower
register. Its contents reflect the current instrument status. This register part can only be read,
but not written into or cleared. Its contents are not affected by reading.

PTRansition

e The two transition register parts define which state transition of the CONDition part (none, 0
to 1, 1 to 0 or both) is stored in the EVENTt part. The Positive-TRansition part acts as a transi-
tion filter. When a bit of the CONDition part is changed from 0 to 1, the associated PTR bit
decides whether the EVENTt bit is set to 1.

PTR bit =1: the EVENt bit is set.
PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by reading.
NTRansition
e The Negative-TRansition part also acts as a transition filter. When a bit of the CONDition part is

changed from 1 to 0, the associated NTR bit decides whether the EVENt bit is set to 1.

NTR bit =1: the EVENt bit is set.
NTR bit =0: the EVENT bit is not set.

e
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This part can be written and read as required. Its contents are not affected by reading.

EVENt

e The EVENTt part indicates whether an event has occurred since the last reading, it is the
.memory” of the condition part. It only indicates events passed on by the transition filters. It
is permanently updated by the instrument. This part can only be read by the user. Reading the
register clears it. This part is often equated with the entire register.

ENABIe

e The ENABIe part determines whether the associated EVENt bit contributes to the sum bit
(see below). Each bit of the EVENTt part is ,,ANDed” with the associated ENABIe bit (symbol
,&). The results of all logical operations of this part are passed on to the sum bit via an ,,OR”
function (symbol ,+").

ENABIe bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABIe bit = 1: if the associated EVENt bit is ,, 1", the sum bit is set to ,, 1" as well.

This part can be written and read by the user as required. Its contents are not affected by rea-
ding.

Sum bit
e The sum bit is obtained from the EVENt and ENABIe part for each register. The result is then
entered into a bit of the CONDition part of the higher-order register.

Hierarchy of status registers

STB, SRE

e The STatus Byte (STB) register and its associated mask register Service Request Enable (SRE)
form the highest level of the status reporting system. The STB provides a rough overview of
the instrument status, collecting the information of the lower-level registers.

ESR, SCPI registers

e The STB receives its information from the following registers:

e The Event Status Register (ESR) with the associated mask register standard Event Status
Enable (ESE).

e The STATus:OPERation and STATus:QUEStionable registers which are defined by SCPI and
contain detailed information on the instrument.

Output buffer

® The output buffer contains the messages the instrument returns to the controller. It is not part
of the status reporting system but determines the value of the MAV bit in the STB and thus is
represented in the overview.
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All status registers have the same internal structure.
As shown in the following figure, the status information is of hierarchical structure.

0
1
Errorfevent  Qutput 2
queue buffer 3 |cOVerload
4 | TEMPerature
5
6
- _ T
0 8 | NOALigndata
1 9 [ LIMit
-&- 2 10
=B 3 11
e —————— 4 - MAY 12 | MASK
8- 5—ESB —— 13 R
& —g ROS/MSS 1; figure for this
L™ L] register
SRE 5TB —E STATus:QUEStionable
[a5] STATus:0OPERation
‘SFI{Q 0 | ALIGnment
1 | SELFtest
2 | AUToset
3 | WTRigger
4
5
& &
I 7
0]=&=|0 8
1 [-&= (1 8
2|-& |2 10
3|-& (3 11
4 [-&-4 12
5|-& 15 13
6|-& (8 14
1 -&- 1 E & = |ogical AND
ESE ESR b= logical OR

Fig. 1.5: Overview of the status registers hierarchy

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the STB is
structured according to SCPI. By analogy, the ESE can be used as the ENABle part of the ESR.

1.6.3 Contents of the Status Registers
In the following sections, the contents of the status registers are described in more detail.

Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough overview of the in-
strument status by collecting the pieces of information of the lower registers. A special feature is
that bit 6 acts as the sum bit of the remaining bits of the status byte.
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The STB can thus be compared with the CONDition part of an SCPI register and assumes the
highest level within the SCPI hierarchy. The STB is read using the command *STB or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register. Each bit of the STB
is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set in the SRE and the associa-
ted bit in the STB changes from 0 to 1, a service request (SRQ) is generated. The SRE can be set
using the command *SRE and read using the command *SRE?.

Bit No. | Meaning
0...1 Not used

Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the
2 SRE, each entry of the error queue generates a service request. Thus an error can
be recognized and specified in greater detail by polling the error queue. The poll
provides an informative error message. This procedure is to be recommended since
it considerably reduces the problems involved with remote control.

QUEStionable status sum bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the

3 associated ENABle bit is set to 1. A set bit indicates a questionable instrument
status, which can be specified in greater detail by polling the QUEStionable status
register.

MAV bit (message available)

4 The bit is set if a message is available in the output buffer which can be read. This
bit can be used to enable data to be automatically read from the instrument to the
controller.

ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status

5 register is set and enabled in the event status enable register. Setting of this bit
indicates a serious error which can be specified in greater detail by polling the event
status register.

MSS bit (master status summary bit)

6 The bit is set if the instrument triggers a service request. This is the case if one of
the other bits of this registers is set together with its mask bit in the service request
enable register SRE.

OPERation status register sum bit

The bit is set if an EVENt bit is set in the OPERation status register and the associ-

7 ated ENABle bit is set to 1. A set bit indicates that the instrument is just performing
an action. The type of action can be determined by polling the OPERation status
register.

Table 1.8: Meaning of the bits used in the status byte

Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI register. The
event status register can be read out using command *ESR?. The ESE corresponds to the ENA-
Ble part of a SCPI register. If a bit is set in the ESE and the associated bit in the ESR changes
from 0 to 1, the ESB bit in the STB is set. The ESE register can be set using the command *ESE
and read using the command *ESE?.
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Bit No. | Meaning

Operation Complete

0 This bit is set on receipt of the command *OPC exactly when all previous com-
mands have been executed.

1 Not used

Query Error

This bit is set if either the controller wants to read data from the instrument without
2 having sent a query, or if it does not fetch requested data and sends new instruc-
tions to the instrument instead. The cause is often a query which is faulty and hence
cannot be executed.

Device-dependent Error

3 This bit is set if a device-dependent error occurs. An error message with a number
between -300 and -399 or a positive error number, which denotes the error in grea-
ter detall, is entered into the error queue.

Execution Error

4 This bit is set if a received command is syntactically correct but cannot be perfor-
med for other reasons. An error message with a number between -200 and -300,
which denotes the error in greater detail, is entered into the error queue.
Command Error

5 This bit is set if a command is received, which is undefined or syntactically incor-
rect. An error message with a number between -100 and -200, which denotes the
error in greater detail, is entered into the error queue.

User Request

6 . . . .
This bit is set when the instrument is switched over to manual control.

Power On (supply voltage on)
This bit is set on switching on the instrument.

7

Table 1.9: Meaning of the bits used in the event status register

STATus:OPERation Register

In the CONDition part, this register contains information on which actions the instru-

ment is being executing. In the EVENTt part, it contains information on which actions

the instrument has executed since the last reading. It can be read using the commands
STATus:OPERation:CONDition? or STATus:OPERation[:EVENt]?. The remote commands for the
STATus:OPERation register are described in chapter 2.14.1, ,STATus:OPERation Register”.

Bit No. Meaning
0 ALIGnment
This bit is set as long as the instrument is performing a self alignment.
1 SELFtest
This bit is set while the selftest is running.
2 AUToset
This bit is set while the instrument is performing an auto setup.
3 WTRIgger
This bit is set while the instrument is waiting for the trigger.
4to 14 | Not used
15 This bit is always O.

Table 1.10: Bits in the STATus:0PERation register

e
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STATus:QUEStionable Register

This register contains information about indefinite states which may occur if the unit is operated
without meeting the specifications. It can be read using the commands
STATus:QUEStionable:CONDition and STATus:QUEStionable[:EVENT].

CHAMNR&l1
CHAMNREZ

TEMP WARM
TEMP ERRor

STATus:QUESt onable

e =R I = R ]
M Bl 2o 0@~ @O & WK =D

0
1
2 L] - - R
3 |COverloas — S TAT-QUES:COV & STAT:QUES:TEMP
4 | TEMPerature
5
6
7
8 | NOALigndata
9 |LiMi
1? j ésmr:qum:uu
STAT:QUES:MASK
13 MASK 0 | MASK1 0 | MEASY
14 ! 1 | MEASZ
15 2 2
3 3
4 4
3 5
& &
7 7
8 8
g 9
10 10
11 11
12 12
14 14
15 1=

Fig. 1.6: Overview of the STATus:QUEStionable register
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Bit No. Meaning
0to 2 Not used
COVerload
& This bit is set if a questionable channel overload occurs (please refer to
,STATus:QUEStionable:COVerload register”).
TEMPerature
4 This bit is set if a questionable temperature occurs (please refer to ,STATus:QUES
tionable:TEMPerature register”).
5to7 Not used
8 NOALigndata
This bit is set if no alignment data is available - the instrument is uncalibrated.
LIMit
9 This bit is set if a limit value is violated (please refer to
. STATus:QUEStionable:LIMit register”).
10 to 11 | Not used
MASK
12 This bit is set if a mask value is violated (please refer to
. STATus:QUEStionable:MASK register”).
13 to 14 | Not used
15 This bit is always O.

Table 1.11: Bits in the STATus:QUEStionable register

STATus:QUEStionable:COVerload register
This register contains all information about overload of the channels. The bit is set if the assigned
channel is overloaded.

Bit No. Meaning
0 CHANnRel1
1 CHANnRel2
2 CHANDRel3
3 CHANnel4

Table 1.12: Bits in the STATus:QUEStionable:COVerload register

e
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STATus:QUEStionable:TEMPerature register
This register contains information about the instrument’s temperature.

Bit No. Meaning

TEMP WARN
This bit is set if a temperature warning on channel 1, 2, 3 or 4 occured.

0

TEMP ERRor
This bit is set if a temperature error on channel 1, 2, 3 or 4 occured.

Table 1.13: Bits in the STATus:QUEStionable:TEMPerature register

STATus:QUEStionable:LIMit register
This register contains information about the observance of the limits of measurements.This bit
is set if the limits of the main or additional measurement of the assigned measurement are

violated.
Bit No. Meaning
0 MEAS1
1 MEAS2
2 MEAS3
3 MEAS4

Table 1.14: Bits in the STATus:QUEStionable:LIMit register

STATus:QUEStionable:MASK register
This register contains information about the violation of masks. This bit is set if the assigned
mask is violated.

Bit No. Meaning
0 MASK1

Table 1.15: Bits in the STATus:QUEStionable:MASK register

1.6.4 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several devices in
a measuring system. To do this and react appropriately, the controller must receive and evaluate
the information of all devices. The following standard methods are used:

e Service request (SRQ) initiated by the instrument

e Serial poll of all devices in the bus system, initiated by the controller in order to find out who
sent a SRQ and why

e Parallel poll of all devices

e Query of a specific instrument status by means of commands

e Query of the error queue
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Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the controller.
Usually this service request initiates an interrupt at the controller, to which the control program
can react appropriately. As evident from figure 1.5, an SRQ is always initiated if one or several of
bits 2, 3, 4, b or 7 of the status byte are set and enabled in the SRE. Each of these bits combines
the information of a further register, the error queue or the output buffer. The ENABIe parts of
the status registers can be set such that arbitrary bits in an arbitrary status register initiate an
SRAQ. In order to make use of the possibilities of the service request effectively, all bits should be
setto , 1" in enable registers SRE and ESE.

The SRQ is the only possibility for the instrument to become active on its own. Each controller
program should cause the instrument to initiate a service request if errors occur. The program
should react appropriately to the service request.

Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried. However,
the query is realized via interface messages and is thus clearly faster. The serial poll method is
defined in IEEE 488.1 and used to be the only standard possibility for different instruments to
poll the status byte. The method also works for instruments which do not adhere to SCPI or IEEE
488.2. The serial poll is mainly used to obtain a fast overview of the state of several instruments
connected to the controller.

Query of an instrument status
Each part of any status register can be read using queries. There are two types of commands:

e The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level registers.
e The commands of the STATus system query the SCPI registers (STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the queried re-
gister. This number is evaluated by the controller program. Queries are usually used after an SRQ
in order to obtain more detailed information on the cause of the SRQ.

Decimal representation of a bit pattern

The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of a status
register are specified and transferred as a single decimal number. To make this possible, each bit
is assigned a weighted value. The decimal number is calculated as the sum of the weighted
values of all bits in the register that are setto 1.

Bits 0 |1 |2 3 4 5 6 7

Weight

1 2 4 8 16 32 &4 128

Fig. 1.7: Decimal representation of a bit patter

Example:
The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g. the QUE-
Stionable status summary bit and the ESB bit in the STatus Byte ) are set.
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Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the error
queue are detailed plain text error messages that can be looked up in the Error Log or queried
via remote control using SYSTem:ERRor [ :NEXT]? or SYSTem:ERRor:ALL?. Each call of
SYSTem:ERRor [ :NEXT] ? provides one entry from the error queue. If no error messages are
stored there any more, the instrument responds with O, ,,No error”.

The error queue should be queried after every SRQ in the controller program as the entries de-
scribe the cause of an error more precisely than the status registers. Especially in the test phase
of a controller program the error queue should be queried regularly since faulty commands from
the controller to the instrument are recorded there as well.

Reset Values of the Status Reporting System
The following table contains the different commands and events causing the status reporting

system to be reset. None of the commands, except *RST and SYSTem: PRESet, influence the
functional instrument settings. In particular, DCL does not change the instrument settings.

Event Switching on DCL, SDC | *RST STA- | *CLS
supply-voltage | (DeviceCl | orSYS- Tus:
Power-On-Sta- | ear,Select | Tem:PRE- | PRE-
tus-Clear edDevice- | Set Set
Clear)
Effect 0 1
Clear STB, ESR - yes - - - yes
Clear SRE, ESE - yes - - - -
Clear EVENt parts of the re- yes
. - yes - - -
gisters

Clear ENABIle parts of all
OPERation and QUEStionable

registers; Fill ENABIle parts of ) yes ) i ves |-
all other registers with ,, 1.
Fill PTRansition parts with ) os ) i os |-
»1"; Clear NTRansition parts Y ¥
Clear error queue yes yes - - - yes
Clear output buffer yes yes yes 1) 1) 1)
Clear command processing

yes yes yes - - -

and input buffer

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE
TERMINATOR> clears the output buffer.

Table 1.16: Resest of the status reporting system

General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast, the
priority of remote control is the , predictability” of the instrument status. Thus, when a command
attempts to define incompatible settings, the command is ignored and the instrument status
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remains unchanged, i.e. other settings are not automatically adapted. Therefore, control pro-
grams should always define an initial instrument status (e.g. using the *RST command) and then
implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Otherwise, the
result of the query may vary depending on which operation is performed first (see also Pre-
venting Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own. Each
controller program should instruct the instrument to initiate a service request in case of malfunc-
tion. The program should react appropriately to the service request.

Error queues

The error queue should be queried after every service request in the controller program as the
entries describe the cause of an error more precisely than the status registers. Especially in the
test phase of a controller program the error queue should be queried regularly since faulty com-
mands from the controller to the instrument are recorded there as well.

e
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2 Command Reference

This chapter provides the description of all remote commands available for the HMO3000 series.
The commands are sorted according to the menu structure of the instrument. A list of com-
mands in alphabetical order ist given in the ,List of Commands” at the end of this documentati-
on.

21 Common Commands
Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These commands
have the same effect and are employed in the same way on different devices.The headers of
these commands consist of ,*” followed by three letters. Many common commands are related

to the Status Reporting System.

Available common commands:

B A L e e, 28
LS o e 28
FESE ValUB> e 29
o =] o USRI 29
B DN 2 e e 29
S0 = ORI 29
faLO ] I U P 29
P S C A CTION > ittt e e e e e e 30
R ST e 30
S R =R 61e] 0] (T ol £SO PSRRI 30
T B e e 30
Sl 1 2 (PSRRI 30
Sl S 1L SRR 31
B4 N SRR PR 31
*CAL

Calibration Query

Initiates a calibration of the instrument and subsequently queries the calibration status. Re-
sponses > 0 indicate errors.

*CLS

Clear Status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of the QUEStio-
nable and the OPERation registers to zero. The command does not alter the mask and transition

parts of the registers. It clears the output buffer.

Usage: Setting only
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*ESE <Value>
Event Status Enable

Sets the event status enable register to the specified value. The query returns the contents of the
event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255
*ESR?

Event Status Read

Returns the contents of the event status register in decimal form and subsequently sets the
register to zero.

Return values:

<Contents> Range: 0 to 255
Usage: Query only
*IDN?

|DeNtification: returns the instrument identification.

Return values:
<ID> Hameg,<device type>,<serial number>,<firmwareversion>

Example: HAMEG,HM03054,018150513,05.450
Usage: Query only
*OPC

OPeration Complete

Sets bit 0 in the event status register when all preceding commands have been executed. This bit
can be used to initiate a service request. The query form writes a ,,1" into the output buffer as soon
as all preceding commands have been executed. This is used for command synchronization.

*OPT?
OPTion identification query

Queries the options included in the instrument. For a list of all available options and their descrip-
tion refer to the CD-ROM.

Return values:

<Options> The query returns a list of options. The options are returned at fixed
positions in a comma-separated string. A zero is returned for options
that are not installed.

Usage: Query only
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*PSC <Action>
Power on Status Clear

Determines whether the contents of the ENABIe registers are preserved or reset when the
instrument is switched on. Thus a service request can be triggered when the instrument is
switched on, if the status registers ESE and SRE are suitably configured. The query reads out the
contents of the ,, power-on-status-clear” flag.

Parameters:

<Action> 01
0 The contents of the status registers are preserved.
1 Resets the status registers.

*RST

ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the descripti-
on of commands.

Usage: Setting only
*SRE <Contents>
Service Request Enable

Sets the service request enable register to the indicated value. This command determines under
which conditions a service request is triggered.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit) is always 0.
Range: 0 to 255

*STB?

STatus Byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual trigger
signal (Manual Trigger). This common command complements the commands of the TRIGger
subsystem.

Usage: Event

SCPI Programmers Manual 30



Command Reference

*TST?
self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service Manu-
al supplied with the instrument). ,,0” indicates no errors occured.

Usage: Query only

*WAI
WAIt to continue

Prevents servicing of the subsequent commands until all preceding commands have been exe-
cuted and all signals have settled (see also command synchronization and *OPC).

Usage: Event

2.2 Acquisition and Setup

Starting and Stopping ACQUISITION  ooiiii i e 31
BT LCl =7 1= SRR PPPPPP 32
Y ele | U111 4o o H USSPt 34
VL= g (o= | PR PRPPN 40
oo (o3 o F= T T 1= OO EUURRRR 47
JA 1Y <o g T | - PRSP 53
L] 07O PPUURRRR 60
Sl Al GNMNENT e e 61

2.2.1 Starting and Stopping Acquisition

RUN e 31
RUNGCONTINOUS oot e e 31
SIN G e 32
RUN SINGIE oo ettt e 32
ST O e 32
RUN

Starts the continuous acquisition.

Usage: Event
Asynchronous command

RUNContinous
Same as RUN.

Usage: Event
Asynchronous command
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SINGle
Starts a defined number of acquisition cycles.

Usage: Event
Asynchronous command

RUNSingle
Same as SINGle.

Usage: Event
Asynchronous command

STOP
Stops the running acquistion.

Usage: Event
Asynchronous command

2.2.2 Time Base

TIMeDbase:SCALE <TIME_SCalE> ..o e 32
TIMEDASEIRATIME? oo 32
TIMebase:ACQTime <ACQUISITION_TIME>  ...oiiiiiii e 33
TIMebase:RANGE <ACQUISIION_TIME>  ..iiiiiii it 33
TIMEDASEIDIVISIONS? oottt e et e e e e e e e e e e e s e e e e e e e 33
TIMebase:POSItIoN <OffSEI>  oiiiiiii e 33
TIMebase:REFerence <ReferencePoint> ... 33

TIMebase:SCALe <Time_Scale>
Sets the horizontal scale for all channel and math waveforms.

Parameters:

<Time_Scale> Range: 1E-9 to 50
Default unit: s/div
*RST: 100E-6

TIMebase:RATime?

Queries the real acquisition time used in the hardware. If FFT analysis is performed, the
value can differ from the adjusted acquisition time (TIMebase:ACQTime).

Return values:
<HWAcqTime> Default unit: s

Usage: Query only
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TIMebase:ACQTime <Acquisition_Time>
Defines the time of one acquisition, that is the time across the 12 divisions of the diagram:
Timebase Scale*12.

Parameters:
<Acquisition_Time> Range: 12ns to 600s
Default unit: s

TIMebase:RANGe <Acquisition_Time>
Defines the time of one acquisition, that is the time across the 12 divisions of the diagram:
Timebase Scale*12.

Parameters:
<Acquisition_Time> Range: 12ns to 600s
Default unit: s

TIMebase:DIVisions?
Queries the number of horizontal divisions on the screen.

Return values:
<HorizDivCount> Range: 12

Usage: Query only

TIMebase:POSition <Offset>
Defines the trigger position (trigger offset) - the time interval between trigger point and reference
point to analize the signal some time before or after the trigger event.

See also: TIMebase:REFerence

Parameters:
<Offset> Range: -500 to 500
Default unit: s

*RST: 0

TIMebase:REFerence <ReferencePoint>

Sets the reference point of the time scale (Time Reference) in % of the display. The reference
point defines which part of the waveform is shown. If the trigger position is zero, the trigger
point matches the reference point. See also: TIMebase:POSition

Parameters:

<ReferencePoint> Range: 10 to 90
Default unit: %
*RST: 50
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2.2.3 Acquisition

AUTOSCAIE oot 34
ACQuire:MODE <ACQUISIION_IMOGE>  ...iiiiiiiiiiiiie e 34
ACQuire:INTerpolate <INterpolation=> ........ccoiiiiiii e 35
ACQuire:AVERage:COUNE <Average_COUNT>  ...iiiiiiiiiiiiiie ettt 35
ACQUIre:AVERAGE I COMPIEIE? ..o 35
ACQuire:WRATe <Waveform_Rate> .. 35
CHANRNel<m>:TYPE <Decimation_MoOde> ........ccciiiiiiiiiiiiiiii e 36
CHANRNel<m>:ARIThmetics <TrAMthMETIC> ..ottt 36
TIMebase:ROLL:IENABIE <ROII> oo 37
ACQuire:FILTer:FREQency <Filter_FreqUeNCY>  .....oooiiiiiiiiee e 37
ACQUITEIPOINTSIARATE? e e 37
ACQUITEISRATE? oo 38
ACQUIre:STATE <AQUISITION_STATE>  oiiiiiiiiiiiiiiiiit et e e e e e e e e e ba e e e e e e eaes 38
ACQUIre:TYPE <AQUISTTION_TYPE>  1oiiiiiiiiiie et e e 38
ACQuire:REALtime <RaNdom_Sampling> ..o 39
ACQuire:PEAKdetect <Peak _DeEteCT> ..o 39
ACQuire:HRESOIUtion <HIgh_RES> oo 39

Segmented memory function

ACQuire:POINts[:VALue] <Record_Length> ... 39
ACQUIre:COUNt <MaxXACGCOUNTS it e e 39
ACQUIre:SEGMENTEA:STATE oo 40
ACQUIre:AVAIIEDIE? o 40
AUToscale

Performs an autoset process: analyzes the enabled channel signals, and obtains appropriate
horizontal, vertical, and trigger settings to display stable waveforms.

Usage: Event
Asynchronous command

ACQuire:MODE <Acquisition_Mode>
Selects the method of adding waveform points to the samples of the ADC in order to fill the
record length.

Parameters:
<Acquisition_Mode>  RTIMe | ETIMe

RTIMe (Real Time Mode)

At slow time base settings the sampled points of the input signal are
used to build the waveform, no waveform points are added. With fast
time base settings, the sample rate is higher than the ADC sample rate.
Waveform samples are added to the ADC samples with sin(x)/x inter-
polation.
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ETIMe (Equivalent time)
The waveform points are taken from several acquisitions of a repetive
signal at a different time in relation to the trigger point.

*RST: RTIM

ACQuire:INTerpolate <Interpolation>
Defines the interpolation mode.

Parameters:
<Interpolation> LINear | SINX | SMHD

LINear: Linear interpolation between two adjacent sample points.
SINX: Interpolation by means of a sin(x)/x curve.
SMHD: Sample & Hold causes a histogram-like interpolation.

*RST: SINX

ACQuire:AVERage:COUNt <Average_Count>
Defines the number of waveforms used to calculate the average waveform. The higher the
number, the better the noise is reduced.

Parameters:
<Average_Count> Only numbers from the 2nd progression are permitted.

ACQuire:AVERage:COMPIlete?
Queries the state of the completed average waveforms.

Return values:
<AverageComplete> 0] 1

Usage: Query only

ACQuire:WRATe <Waveform_Rate>
Defines the mode to set the sample rate (samples per second saved in the memory) and the
waveform acquisition rate (waveforms per second).

Parameters:
<Waveform_Rate> AUTO | MWAVeform | MSAMples | MANual

AUTO

To display the best waveform, the instrument selects the optimum
combination of waveform acquisition rate and sample rate using the full
memory depth.
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MWAVeform

Maximum waveform rate: The instrument combines sample rate and
memory depth to acquire at maximum waveform acquisition rate. In
combination with persistence fuction, the mode can display rare signal
anomalies.

MSAMples

Maximum sample rate: The instrument acquires the signal at maximum
sample rate and uses the full memory depth. The result is a waveform
with maximum number of waveform samples, high degree of accuracy,
and low risk of aliasing.

MANual
Activates the manual record mode for the segmented memory.

*RST: AUTO

CHANnNel<m>:TYPE <Decimation_Mode>
Selects the method to reduce the data stream of the ADC to a stream of waveform points with
lower sample rate.

Suffix:

<m> The command affects all channels regardless of the indicated channel
number. The suffix can be omitted.

Parameters:

<Decimation_Mode>  SAMPIle | PDETect | HRESolution

SAMPIle
Input data is acquired with a sample rate which is aligned to the time
base (horizontal scale) and the record length.

PDETect (Peak Detect)
The minimum and the maximum of n samples in a sample interval are
recorded as waveform points.

HRESolution (High Resolution)
The average of n sample points is recorded as waveform point.

*RST: SAMPle

CHANnel<m>:ARIThmetics <TrArithmetic>
Selects the method to build the resulting waveform from several consecutive acquisitions of the
signal.

Suffix:
<m> The command affects all channels regardless of the indicated channel
number. The suffix can be omitted.

e
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Parameters:
<TrArithmetic> OFF | ENVelope | AVERage | FILTer

OFF
The data of the current acquisition is recorded according to the
decimation settings.

ENVelope
Detects the minimum and maximum values in an sample interval over a
number of acquisitions.

AVERage

Calculates the average from the data of the current acquisition and a
number of acquisitions before. The number of used acquisitions is set
with ACQuire:AVERage:COUNTt.

FiLTer

Sets a low-pass filter with 3 db attenuation at a configurable limit fre
quency set with ACQuire:FILTer:FREQency. The filter removes higher
frequencies from the channel signals.

*RST: OFF

TIMebase:ROLL:ENABIe <Roll>
Enables the roll mode.

Parameters:
<Roll> ON | OFF

*RST: OFF

ACQuire:FILTer:FREQency <Filter_Frequency>
Sets the limit frequency if CHANnel<m>:ARIThmetics is set to , FILTer".

Parameters:
<Filter_Frequency> Limit frequency with 3dB attenuation
Default unit: Hz

ACQuire:POINts:ARATe?
Retrieves the sample rate of the ADC, that is the number of points that are sampled by the ADC
in one second.

Return values:
<AcquisitionRate> ADC sample rate
Range: 2.5E3 to 4E9 (depending on HMO model)

*RST: 4E9 (depending on HMO model)
Usage: Query only
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ACQuire:SRATe?
Returns the sample rate, that is the number of recorded waveform samples per second.

Return values:

<SampleRate> Range: 2 to 1E11
*RST: 1E7
Usage: Query only

ACQuire:STATe <Aquisition_State>
Sets the aquisition state of the instrument.

Parameters:
<Aquisition_State> RUN | STOP | COMPlete | BREak

RUN
The aquisition is running.

STOP
The acquisition will stop if finished.

COMPIlete
The current aquisition is finished and completed.

BREak
Set = break/interrupt of current acquisition
Read = acquisition is finished but interrupted

*RST: RUN

ACQuire:TYPE <Aquisition_Type>
Sets the type of the aquisition mode.

Parameters:
<Aquisition_Type> REFresh | ROLL | AVERage | ENVelope | FILTer

REFresh
The aquisitions are displayed as they are done.

ROLL
The aquisitions are done in roll mode.

AVERage
The aquisitions are averaged.

FILTer
Sets a low-pass filter with 3 db attenuation at a configurable limit
frequency

*RST: OFF

e
SCPI Programmers Manual 38



SCPI Commands HMO3000 series Remote Control

Command Reference

ACQuire:REALtime <Random_Sampling>
Enables the random sampling.

Parameters:
<Random_Sampling> AUTO | OFF

*RST: OFF
ACQuire:PEAKdetect <Peak_Detect>
Enables the peak detection.

Parameters:
<Peak_Detect> AUTO | OFF

*RST: OFF
ACQuire:HRESolution <High_Res>
Enables the high resolution mode.

Parameters:
<High_Res> AUTO | OFF

*RST: OFF

ACQuire:POINts[:VALue] <Record_Length>
Indicates the record length, the number of recorded waveform points that build the waveform
across the acquisition time. [:VALue] can be omitted.

Parameters:

<Record_Length> Number of recorded waveform points.
Range: 5000 to 1000000
Default unit: Sa

*RST: 10000
ACQuire:COUNt <MaxAcqCount>
Defines the segmentation number.

Parameters:
<MaxAcqgCount> Range: 2 to 1000 (depends on instrument settings)

*RST: 2
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ACQuire:SEGMented:STATe
Switches the segmentation function on and off.

Parameters:
<State> ON | OFF

*RST: OFF

ACQuire:AVAilable?
Queries the number of recorded segments.

Usage: Query only

Vertical

CHANRNEI<M>ISTATE <STATE> it 40
CHANNEel<mM>:COUPHNG <COUPINGS  ooiiiiiiiii et 41
CHANRNEI<M>:SCALE <SCAIE> oot 41
CHANRNEl<M>:RANGE <RANGES oottt e 41
CHANRNEl<mM>:POSIION <POSIION  ..iiiiiiiiiiiiie e 42
CHANRNEl<M>I0FFSEt <OffSET>  Loiiiiiiiiiiii e 42
CHANnNel<m>:BANDwidth <Bandwidth_Limit> ..o 42
CHANRNel<m>:POLarity <POIarity> ..o 42
CHANRNel<m>:OVERIoad <OVErload> . .c.eeiiiiiiiiie e 43
CHANNEI<M>ISKEW <SKEW> oo 43
CHANnel<m>:THReshold <Threshold> .. ......ooiiiiiii e 43
CHANRNEel<mM>:THREShOIA:HYSTEIESIS oot 44
CHANRNel<m>:THReShOId:FINDIEBVEI . cciiiiiiiiieece e 44
CHANNel<mM>:LABEl <Labels> .o 44
CHANRNEl<mM>:LABELSTATE <STAte> oo 44

Segmented Memory Fuction

CHANnNel<m>:HISTory:CURRent <CUITACOIAX>  oiviviiiiiiiiiiiiiecee et 45
CHANRNel<m>:HISTory:PLAYer:STATE <STate> ...iiiiiiiiiiiiiiiiiiiee e 45
CHANnNel<m>:HISTory:REPLay <AUto_Repeat> ......cccccciiiiiiiiiiiiccecc e 45
CHANnNel<m>:HISTory:PLAYer:SPEed <TimePerACO> .....ccoiiviiiiii e 46
CHANRNEl<mM>HISTOrY:TSDAtE?  ..eieeiiii e 46
CHANRNel<mM>:HISTory: TSABSOIULE? oo 46
CHANRNEl<mM > HISTOrY:TSREIGTIVE?  ..oeieiiiiieieieitee e eseaessseenanees 47

CHANnel<m>:STATe <State>
Switches the channel signal on or off.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<State> ON | OFF
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CHANnel<m>:COUPIling <Coupling>
Selects the connection of the indicated channel signal.

Suffix:

<m>

Parameters:
<Coupling>

Selects the input channel (1...4).
The number of channels depends on the instrument type.

DC | DCLimit | AC | ACLimit | GND

DC DC coupling with 50Q termination

DCLimit DC coupling with TMQ termination
AC AC coupling with 50Q termination

ACLimit AC coupling with TMQ termination
GND Ground

*RST: DCL

CHANnel<m>:SCALe <Scale>
Sets the vertical scale for the indicated channel.

Suffix:

<m>

Parameters:
<Scale>

Selects the input channel (1...4).
The number of channels depends on the instrument type.

Scale value in Volts per div.
Range: 1E-3to 10

*RST: bE-3

CHANnel<m>:RANGe <Range>
Sets the voltage range across the 8 vertical divisions of the diagram. Use the command alterna-
tivly instead of CHANnel<m>:SCALe.

Suffix:
<m>

Parameters:
<Range>

Selects the input channel (1...4).
The number of channels depends on the instrument type.

Voltage range value in Volt (V).
Range: 8E-3 to 80

*RST: 40E-3
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CHANnel<m>:POSition <Position>
Sets the vertical position of the indicated channel and its horizontal axis in the window.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<Position> Position value, given in divisions.

Range: -bto b

*RST: 0.00E+00

CHANnel<m>:0FFSet <Offset>
The offset voltage is subtracted to correct an offset-affected signal.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<Offset> Offset value in V.

*RST: 0.00E+00

CHANnel<m>:BANDwidth <Bandwidth_Limit>
Selects the bandwidth limit for the indicated channel.

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.
Parameters:

<BandwidthLimit> FULL | B20

FULL Full bandwidth.
B20 Bandwidth limit 20 MHz

*RST: FULL

CHANnNel<m>:POLarity <Polarity>

Turns the inversion of the signal amplitude on or off. To invert means to reflect the voltage values
of all signal components against the ground level. Inversion affects only the display of the signal
but not the trigger.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
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Parameters:
<Polarity> NORMal | INVerted
*RST: NORM
CHANnNel<m>:0OVERIload <Overload>

Retrieves the overload status of the specified channel from the status bit. When the overload
problem is solved, the command resets the status bit.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<Overload> ON | OFF
Use OFF to reset the overload status bit.
*RST: OFF
Example: CHANnNel2:OVERIoad?

Queries the overload status of channel 2.

CHANnRel2:0VERIload OFF
Resets the overload status bit.

CHANnel<m>:SKEW <Skew>
Skew or deskew compensates delay differences between channels caused by the different
length of cables, probes, and other sources. Correct deskew values are important for accurate

triggering.
Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<Skew> Deskew value in s.

CHANnel<m>:THReshold <Threshold>

Threshold value for digitization of analog signals. If the signal value is higher than the threshold,
the signal state is high (1 or true for the boolean logic). Otherwise, the signal state is considered
low (0 or false) if the signal value is below the threshold.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
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Parameters:

<Threshold> Default values are:
TTL 1,4V
ECL -1,3V
CMOS 25V

CHANnNel<m>:THReshold:HYSTeresis
Sets the hysteresis of the digital threshold.

Parameters:
<Hysteresis> SMALI | MEDium | LARGe

*RST: MED
CHANnNel<m>:THReshold:FINDlevel

Executes the analysis of all channels that are configured for the selected bus and sets
the threshold for digitization of analog signals for each channel.

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.
Usage: Event

CHANnNel<m>:LABel <Label>
Set the label for the input channel.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<lLabel> String value “xxxxxxxx” with maximum 8 ASCII characters.

CHANnNel<m>:LABel:STATe <State>
Switches the label of the channel on or off

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<State> ON | OFF

*RST: OFF
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CHANnNel<m>:HISTory:CURRent <CurrAcqldx>

Accesses a particular acquisition in the memory to display it. The query returns the index of the
segment that is shown. The segmented memory player is only visible on the HMO screen with
activated segmentation and STOP mode.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<CurrAcqldx> History index: the newest segment has the index ,,0”, older
segments have a negative index: -(n-1), .... -1, 0
where n is the number of acquired segments.
Range: 0 to -(n-1)
Example: CHANT:HIST:CURR -1

Displays the acquisition before last from the history.

CHANnNel<m>:HISTory:PLAYer:STATe <State>
Enables or disables the history display. The segmented memory player is only visible on the
HMO screen with activated segmentation and STOP mode.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<State> ON | OFF

*RST: OFF

CHANnNel<m>:HISTory:REPLay <Auto_Repeat>

If ON, the replay of the history waveform sequence repeats automatically. Otherwise, the replay
stops at the stop index set with CHANnel<m>:HISTory:STOP. The segmented memory player is
only visible on the HMO screen with activated segmentation and STOP mode.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<Auto_Repeat> ON | OFF
*RST: OFF
Usage: Asynchronous command
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CHANnNel<m>:HISTory:PLAYer:SPEed <TimePerAcq>
Sets the display time for one acquisition. The shorter the time, the faster is the replay.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<TimePerAcqg> SLOW | MEDium | FAST

CHANnel<m>:HISTory:TSDate?
Returns the date of the current acquisition that is shown in the segment table
(CHANnel<m>:HISTory:CURRent ).
Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<DateAbsString> String with date of the current acquisition (absolute time).

Example: CHANT:HIST:TSD?
Response: 2014,9,24

Usage: Query only

CHANnel<m>:HISTory:TSABsolute?
Returns the abolsute daytime of the current acquisition that is shown in the segment table
(CHANnel<m>:HISTory:CURRent ).

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.

Return values:
<TimeAbs_String> String containing the time and unit.

Example: CHANT:HIST:.TSAB?
Response: 10,22,1.600000000000E+01

Usage: Query only
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CHANnel<m>:HISTory:TSRelative?
Returns the relative time of the current acquisition - the time difference to the newest acquisition
(index = 0). See also: CHANnel<m>:HISTory:CURRent.

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.

Return values:
<Time_Relative> Default unit: s

Usage: Query only

Logic Channel

LOGIC<I>:POSItION <POSITIONS oottt ettt e 47
LOGICKI>ISIZE <SIZE> oo 48
LOGIC<I>ISTATE <STAtE> oot 48
LOGIC<I>ILABEI <LADEI> it 48
LOGic<I>:LABELState <Label>  .oiiiiiiiiiiiii e 48
POD<p>:THReshold <Threshold_MOode> .......coooiiiiiiiiiiiiii e 48
POD<p>:THReshold:UDLevel<u> <Threshold_Level> ........cccccccciiiiiiiiiiiciie e 49
POD<P>:State <STAtE> oot 49
POD<p>DATA? <DAtA> oot 49
POD <> DATAHEAD I ? e 49
POD<p>:DATA:POINLS <POINTS™>  1oiiiiiiiiiiie e 50
POD<p=>:DATAXINCIEMENT? oo 51
POD<p>:DATAIXORIGIN?  ooiiiieeiie ettt ettt ettt ettt e ssb e e rb e e ssbe e e bt e esbeeasbeeanbeeesaeeanaeeanes 51
POD<p>:DATAIYINCIEMENT?  1ooiiiiiiieiiie ettt ettt sb e e e essbe e beesnbeeerbeesnaee e 51
POD<P>DATANYORIGIN? oottt e e e et be e eabe e beeenae e 51
POD<p>:DATA:YRESOIUTION?  ..eeeiiiiiii e 52
POD P TYPE oottt ettt 52
POD<p>:CURRent:STATE:MINIMUM? oo 52
POD<p>:CURRent:STATE:MAXIMUM? ..o 52

LOGic<I>:POSition <Position>
Set the position of a logic channel.

Suffix:

<> Selects the logic channel (0...15).
Parameters:

<Position> Position value in divisions.
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LOGic<I>:SIZE <Size>
Set the size of the display of the logic channel.

Suffix:

<> Selects the logic channel (0...15).
Parameters:

<Size> SMALI | MEDium | LARGe

*RST: SMAL

LOGic<I>:STATe <State>
Switches the channel signal on or off.

Suffix:

<> Selects the logic channel (0...15).
Parameters:

<State> ON | OFF

LOGic<I>:LABel <Label>
Set the label for the logic channel.

Suffix:

<> Selects the logic channel (0...15).

Parameters:

<lLabel> String value “xxxxxxxx"” with maximum 8 ASCII characters.

LOGic<I>:LABel:State <Label>
Switches the label of the lagic channel on or off.

Suffix:

<> Selects the logic channel (0...15).
Parameters:

<lLabel> ON | OFF

POD<p>:THReshold <Threshold_Mode>

Threshold Mode for Logic Pod. If the signal value is higher than the threshold, the signal state is
high (1 or true for the boolean logic). Otherwise, the signal state is considered low (0 or false) if
the signal value is below the threshold.

Suffix:
<p> Select the Pod (1...2).
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Parameters:
<Threshold_Mode> TTL | ECL | CMOS | USER1 | USER2

TTL TTL level, set to 1.4V

ECL ECL level, set to -1.3V

CMOS CMOS level, set to 2.5V

USER1 USERT1 level, can be set with POD:THReshold:UDLevel<u>.
USER2 USER2 level, can be set with POD:THReshold:UDLevel<u>.

POD<p>:THReshold:UDLevel<u> <Threshold_Level>
Set the user high level threshold for the pod.

Suffix:

<p> Select the Pod (1...2).

<u> Select the User setting (USER1, USER2).
Parameters:

<Threshold_Level> Range: -2 t0 8

Threshold level in V.

POD<p>:State <State>
Switches the Pod on or off.

Suffix:

<p> Select the Pod (1...2).
Parameters:

<State> ON | OFF

*RST: OFF

POD<p>:DATA? <Data>
Returns the data of the POD. To set the export format, use FORMat[:DATA].

Suffix:
<p> Select the Pod (1..2).

Return values:
<Data> List of values according to the format settings.

Usage: Query only

POD<p>:DATA:HEADer?
Returns the data header of the POD.

Suffix:
<p> Select the Pod (1..2).
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Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns
3 Number of Samples 1200
4 Number of values per sample interval. 2
For PeakDetect waveforms the value is 2.

Table 2.1: Header data

Usage: Query only

POD<p>:DATA:POINts <Points>
Returns the number of available data. The setting command selects the sample range, query
returns the number of samples for the selected range.

To get correct results with settings MAX and DMAX, the acquisition must not run when the
command is used. To acquire consistent and valid data, use the SINGle command before. Do
not cancel a running acquisition with STOP because the waveform data might be incomplete or
incorrect. Please use the command ACQuire:STATe STOP to stop the acquisition.

Suffix:
<p> Select the Pod (1..2).

Return values:
<Points> Number of data points depending on the selected range.
Default unit: Samples

Setting Parameters:
<Points> DEFault | MAXimum | DMAXimum
Sets the range for the query.

DEFault
Waveform samples displayed on the screen.

MAXimum
Range is the complete memory (only available in STOP mode).

DMAXimum
Display maximum:number of samples in the current waveform record
(only available in STOP mode).

SCPI Programmers Manual 50



SCPI Commands HMO3000 series Remote Control

Command Reference

POD<p>:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<p> Select the Pod (1..2).

Return values:
<Xincrement> Timeins

Usage: Query only

POD<p>:DATA:XORigin?

Returns the time of the first sample of the indicated waveform (depending on the trigger event
t=0). The commands are relevant for data conversion, if binary data format is defined

(FORM UINT, 8 16).

Suffix:
<p> Select the Pod (1..2).

Return values:
<Xorigin> Timeins

Usage: Query only
POD<p>:DATA:YINCrement?

Returns the value per bit of the indicated waveform. The commands are relevant for data conver-
sion, if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<p> Select the Pod (1..2).
Usage: Query only

POD<p>:DATA:YORigin?
Returns the value for binary value 0 of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 16).

Suffix:
<p> Select the Pod (1..2).
Usage: Query only
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POD<p>:DATA:YRESolution?
Returns the vertical bit resolution of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<p> Select the Pod (1..2).

Return values:

<Yresolution> For default waveforms, the resolution is 8 bit.
Usage: Query only
POD<p>:TYPE

Sets the POD type.

Suffix:
<p> Select the Pod (1..2).

Return values:
<DecimationMode> SAMPIe | PDETect.

*RST: SAMP

POD<p>:CURRent:STATe:MINimum?
Queries the minimum value state of the pod.

Return values:
<RegisterValue> 0 to 255 (8 bit)

Usage: Query only

POD<p>:CURRent:STATe:MAXimum?
Queries the maximum value state of the pod.

Return values:
<RegisterValue> 0 to 255 (8 bit)

Usage: Query only
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2.2.6 Waveform Data

CHAN N M S D AT A ? ettt e e e 53
(O VA N a1 B e P B AN U AN o |y AN =Y o OO PPPPPPPPPPPRt 53
CHANRNEI<M>:DATAIENVEIODE? oottt asbeaseebesessseeeeeees 54
CHANRNel<mM>:DATA:ENVEIOPEHEADEI? ..o aaneeeaeassnananees 54
(O VA N a1 B e B B AN U AN |\ (G =Y 0 a =T 0 | R 55
CHANNel<m>:ENVelope:DATAXINCIEMENT?  ...uiiiieieireeeeiieeerereieieeeeereeeeerererererereeerererereree—————. 55
CHANRNel<m>:DATAENVElope: XORIGIN?  .oviiiiiiiiiiie e 55
CHANRNEl<mM > DATAIXORIGIN? it 55
CHANRel<m>:DATA:ENVEIOPe:YINCIrEmMENT?  ..oiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieriieeivaeebaaerereaeaeeeeereaeeeaeaaaenes 55
CHANRNEI<M>:DATAYINCIEMENT? oottt aaaesesessaasaesbesessssseaenes 55
CHANRNel<m>:DATA:ENVEIOPE:YORIGINT? oot aeaeesveanssseananees 56
CHANNEl<M > DATAYORIGIN? oo 56
CHANRNel<m>:DATAENVelope:YRESOIUTION? oo 56
CHANRNEl<mM>:DATAINYRESOIULION? oo 56
CHANRNEel<mM>:DATAIPOINTS <POINTS>  .iiiiiiiiiiiii it 56
FORMat[:DATA] <DataFormat>, <ACCUIACY>  ..uuviiiiieiiieiiiiie e e ettt e e 57
FORMat:BORDEr <BYteOIrAer> ..o 58
CHANnNel<m>:DATA?

Returns the data of the channel waveform points. For envelope waveforms, use the
CHANnNel<m>:DATA:ENVelope command.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Data> List of vertical values (voltages of recorded waveform samples) to the
format settings.

Example: CHANT:DATA?
-0.125000,-0.123016,-0.123016,-0.123016, -0.123016,-0.123016,...

Usage: Query only

CHANnNel<m>:DATA:HEADer?

Returns information on the channel waveform. For envelope waveforms, use the
CHANnNel<m>:DATA:ENVelope:HEADer command.

Position | Meaning Example
1 XStartin's -9.477E-008 = - 94,77 ns
XStopin's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
a Number of values per sample interval_. 2
For PeakDetect waveforms the value is 2.

Table 2.1: Header data
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Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<DataHeader> Comma-separated value list

Example: CHAN:DATA:HEAD?
-9.477E-008,9.477E-008,200000, 1

Usage: Query only

CHANnNel<m>:DATA:ENVelope?

Returns the data of the envelope. The envelope consists of two waveforms. Use this command
only for envelope waveforms. for all other channel waveforms use CHANnel<m>:DATA. To set
the export format, use FORMat[:DATA].

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Data> List of vertical values (voltages of envelope points) according to the
format settings. The list contains two values for each sample interval.

Usage: Query only
CHANnel<m>:DATA:ENVelope:HEADer?

Returns information on the envelope waveform. Use this command only for envelope wave-
forms. for all other channel waveforms use CHANnel<m>:DATA:HEADer.

Position | Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStopin's 9.477E-008 = 94,77 ns
3 Number of Samples 1200
a Number of values per sample interyal. 2
For envelope waveforms the value is 2.

Table 2.2: Header data

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<DataHeader> Comma-separated value list
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Example: -9.477E-008,9.477E-008,1200,2

Usage: Query only

CHANnNel<m>:DATA:XINCrement?

CHANnNel<m>:ENVelope:DATA:XINCrement?

Returns the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion, if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Xincrement> Timeins

Usage: Query only

CHANnel<m>:DATA:XORigin?

CHANnNel<m>:DATA:ENVelope:XORigin?

Returns the time of the first sample of the indicated waveform (depending on the trigger event
t=0). The commands are relevant for data conversion, if binary data format is defined (FORM
UINT, 8 16).

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Xorigin> Timeins

Usage: Query only

CHANnel<m>:DATA:YINCrement?

CHANnNel<m>:DATA:ENVelope:YINCrement?

Returns the value per bit of the indicated waveform. The commands are relevant for data conver-
sion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.

Return values:
<Yincrement> VIA

Usage: Query only
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CHANnel<m>:DATA:YORigin?

CHANnNel<m>:DATA:ENVelope:YORigin?

Returns the value for binary value 0 of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Yorigin> VA

Usage: Query only

CHANnNel<m>:DATA:YRESolution?

CHANnNel<m>:DATA:ENVelope:YRESolution?

Returns the vertical bit resolution of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 16).

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

Usage: Query only

CHANnel<m>:DATA:POINts <Points>

The setting command selects a sample range. The query returns the number of samples for the
selected range. To get correct results with settings MAX and DMAX, the acquisition must not
run when the command is used. To acquire consistent and valid data, use the SINGle command
before. Do not cancel a running acquisition with STOP because the waveform data might be
incomplete or incorrect.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.

Return values:
<Points> Number of data points in the selected range (samples). The number of
data points is depending on the timebase and channel settings.
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Setting Parameters:
<Points>

Command Reference

DEFault | MAXimum | DMAXimum
Sets the range for the query.

DEFault

Waveform samples displayed on the screen.

MAXimum

Range is the complete memory (only available with maximum sample
rate and STOP mode).

The entire oscilloscope memory can only be read out in STOP mode if the maximum
sampling has been activated in the ACQUIRE menu.

Example:

DMAXimum (Display Maximum)

Number of samples in the current waveform record.

Record mode ,,AUTOMATIC” (ACQUIRE menu) in STOP mode
CHANT:DATA:POIN MAX

CHANT:DATA:POIN?

Suffix: 700000

Record mode ,,MAX.SA.RATE” (ACQUIRE menu) in STOP mode
CHANT:DATA:POIN MAX

CHANT:DATA:POIN?

Suffix: 8388576

FORMat[:DATA] <DataFormat>,<Accuracy>
Defines the format for data export with:

CHANnNel<m>:DATA?

CHANnNel<m>:DATA:ENVelope?
CALCulate:MATH<m>:DATA?

REFCurve<m>:DATA?

CALCulate:QMATH:DATA?

Parameters:
<DataFormat>

ASCii | REAL | UINTeger | CSV

ASCii

List of values, for example, 1.23,1.22,1.24,..

<Accuracy> is 0, which means that the instrument selects the number
of digits to be returned. The query returns ASC,0.

REAL
Block data, 32 bit float values in 4 byte blocks.
<Accuracy> is always 32. The query returns REAL,32.
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UINTeger

Unsigned integer format, binary values with length 8 or 16 bit
(UINT,8 or UINT,16). The data range for UINT,8 is 0 to 255, the data
range for UINT,16 is 0 to 65.535. For data conversion, you need the
results of ....DATA:XORIigin?, ....DATA:XINCrement?, ...:.DATA:Yorigin?,
....DATA:YINCrement? and ...:.DATA:YRESolution? commands.

Csv
Comma separated value list.

*RST: ASC

<Accuracy> 08116132
Length of a data value in bit

*RST: 0
Example: FORM ASC

FORM?
ASC,0

FORMat:BORDer <ByteOrder>
Defines the byte order for binary data export if FORMat[:DATA] is set to REAL or UINT.

Parameters:
<ByteOrder> MSBFirst | LSBFirst

MSBFirst
Big endian, most significant byte first, for example:
abcd,acbe,abcf, ...

LSBFirst
Little endian, least significant byte first, for example:
dcba,ebca,fcba, ...

*RST: MSBF
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2.2.7 Waveform Data Export to File

EXPort: WWAVeform:SOURce <WaveformSourCe> ..o, 59
EXPort:WAVeform:NAME <FIleNamMEe> ..o 59
EX POt VNV AV B OIS AVE e 59

EXPort:WAVeform:SOURce <WaveformSource>
Defines the waveform to be exported.

Parameters:
<WaveformSource> CH1..4|D0..15 | QMA | MA1..5 | RE1..4

CH1..4
Selects the channel CH1 | CH2 | CH3 | CH4.
The number of channels depends on the instrument type.

DO..15
Pod, digital channels DO to D15 are exported together.

QMA
Quick mathematic waveform.

MA1..5
Mathematic waveform MA1 | MA2 | MA3 | MA4 | MAb.

RE1..4
Reference waveforms RE1 | RE2 | RE3 | RE4.

EXPort:WAVeform:NAME <FileName>

Defines the path and file name for a waveform data file that will be saved with
EXPort:WAVeform:SAVE. Depending on which USB port the flash drive is connected to, you
either choose “/USB_FRONT" or “/USB_REAR" to specify the correct location. Additionally,
the format type via FORM {ASC, REAL, UINT, CSV} and the number of points to export via
CHAN<n>:DATA:POIN <points> should be defined. Existing files will be overwritten. You can
change the storage location, file name and/or file format manually in the HMO menu. Remote
control uses the recent settings.

Parameters:
<FileName> String parameter
Example: FORM CSV

EXP:WAV:SOUR CH1

EXP:WAV:NAME “/USB_FRONT/CHANNEL1.CSV”
EXP:WAV:SAVE

The waveform data is saved to CHANNEL1.CSV.

EXPort:WAVeform:SAVE
Start the waveform export to USB drive.

Usage: Event
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2.2.8 Probes
PROBe<m > SETUDI TYPE? e 60
PROBe<m>:SETup:ATTenuation:UNIT <UNIT> .. 60
PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>  ........cccoeviiiiiiieiiiciiieeeeeee, 60
PROBe<m>:SETup:ATTenuation[:AUTO]? ... 61

PROBe<m>:SETup:TYPE?
Queries the type of the probe.

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.

Return values:

<Type> NONE | ACTive | PASSive
NONE not detected
ACTive active probe
PASSive passive probe
Usage: Query only

PROBe<m>:SETup:ATTenuation:UNIT <Unit>
Selects the unit that the probe can measure.

Suffix:
<m> Selects the input channel (1...4).
The number of channels depends on the instrument type.
Parameters:
<Unit> VIA

PROBe<m>:SETup:ATTenuation:MANual <ManualAttenuation>
Sets the attenuation or gain of the probe if the probe was not detected by the instrument.

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.
Parameters:

<ManualAttenuation> Range: 0.001 to 1000

*RST: 1
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PROBe<m>:SETup:ATTenuation[:AUTO]?
Returns the attenuation of an automatically detected probe.

Suffix:
<m> Selects the input channel (1...4).

The number of channels depends on the instrument type.

Return values:
<ProbeAttenuation> Range: 0.001 to 1000

Usage: Query only

2.2.9 Self Alignment

(O A T o7 =41 o 61
A LD AT 0N S T AT e 61
CALibration

Performs a self alignment of the instrument.

Usage: Event

CALibration:STATe?
Queries the state of the executed self alignment.

Return values:
<State> OK | ABORt | ERRor

OK Self alignment ok
ABOR Self alignment aborted

ERR Self alignment error

Usage: Query only
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2.3 Trigger

2.31

General A Trigger SETHNGS  oivviiiiiiiie ittt e e e e e e e e e e 62
(o lo =T IaTe o 1] S OO SSUURPUPRUPPPPINt 67
WIAEh (PUISE) THgGET o e 69
VAT [CTo YA IV A g 1o T 1= PSSP PRSI 70
e Nu =T A (oo 1o} I T o 1= PP STPBR 72
o LT T 1T OO PRSP PUPPPP 74

General A Trigger Settings

TRIGger:A:IMODE <Trigger_IMOOE>  ...uuiiiiiii e 62
TRIGger:A:LEVel<n>[:VALUE] <LeVEI> ... 63
TRIGger:A:LEVel<n>:RUNT:UPPer <Upper_Level> ... 63
TRIGger:A:LEVel<n>:RUNT:LOWer <Lower_Level> ......cccccooiiiiiiiii e 63
TRIGger:A:LEVel<n>:RISetime:UPPer <Upper_Level> ..o 63
TRIGger:A:LEVel<n>:RISetime:LOWer <Lower_Level> ..o 64
TRIGger: A:RUNT:POLarity <POIArty> oo 64
TRIGger:A:RISetime:SLOPE <POIAITY>  ..oiiiiiiiiiiie e 64
TRIGger:A:RISetime:RANGE <RANGE> ..o 64
TRIGger A:RISEtMETIME <TIME> oottt 65
TRIGger:A:RISetime:DELTa <Delta_Time>  ...oooiiiiiiiiiii e 65
TRIGQENA:SOURCE <SSOUMCES  .oiiiiiiiie e 65
TRIGger:EXTern:COUPIINg <EXternCoupling>  ...oiiiiiiiiiiee e 66
TRIGGENAITYPE <TYDE> oot e e e e e e e 66
TRIGger:A:HOLDoff:MODE <HoIdOff_MOdE>  ..iiiiiiiiiicieecic e 66
TRIGger:A:HOLDOff: TIME <HOIdOFf_TIME> oottt 66
TRIGger:OUT:-MODE <OUtPUT_IMOAE>  ..oiiiiiiiiie e 67
TRIGger:OUT:POLarity <POIAIItY> .o 67
TRIGger:OUT:PLENGgth <Pulse_Length> ..o 67

TRIGger:A:MODE <Trigger_Mode>
Sets the trigger mode. The trigger mode determines the behaviour of the instrument if no trigger
occurs.

Parameters:
<Trigger_Mode> AUTO | NORMal

AUTO
The instrument triggers repeatedly after a time interval if the trigger
conditions are not fulfilled. If a real trigger occurs, it takes precedence.

NORMal
The instrument acquires a waveform only if a trigger occurs.

*RST: AUTO
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TRIGger:A:LEVel<n>[:VALue] <Level>
Sets the trigger threshold voltage for all A trigger types that require a trigger level.

Suffix:

<n> Selects the trigger input.
1...4 selects the channel. The number of channels depends on the
instrument type. 5 selects the external trigger input.

Parameters:

<lLevel> Trigger level in V.

Range: Depends on vertical scale

TRIGger:A:LEVel<n>:RUNT:UPPer <Upper_Level>
Sets the upper voltage threshold for runt detection. A negative runt crosses the upper level twice
without crossing the lower level.

Suffix:

<n> Selects the trigger input.
1...4 selects the channel. The number of channels depends on the
instrument type.

Parameters:

<Upper_Level> *RST: -4.00E-04

Default unit: V

TRIGger:A:LEVel<n>:RUNT:LOWer <Lower_Level>
Sets the lower voltage threshold for runt detection. A positive runt crosses the lower level twice
without crossing the upper level.

Suffix:

<n> Selects the trigger input.
1...4 selects the channel. The number of channels depends on the
instrument type.

Parameters:

<lLower_Level> *RST: 5.00000E-01

Default unit: V

TRIGger:A:LEVel<n>:RISetime:UPPer <Upper_Level>
Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time measure-
ment starts or stops depending on the selected slope.

Suffix:

<n> Selects the trigger input.
1...4 selects the channel. The number of channels depends on the
instrument type.

Parameters:

<Upper_Level> *RST: -4.00E-04

Default unit: V
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TRIGger:A:LEVel<n>:RISetime:LOWer <Lower_Level>
Sets the lower voltage threshold. When the signal crosses this level, the rise time measurement
starts or stops depending on the selected slope.

Suffix:

<n> Selects the trigger input.
1...4 selects the channel. The number of channels depends on the
instrument type.

Parameters:

<Upper_Level> *RST: 5.00000E-01

Default unit: V

TRIGger:A:RUNT:POLarity <Polarity>
Indicates the polarity of a the runt to be searched for.

Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS

TRIGger:A:RISetime:SLOPe <Polarity>
Sets the slope to be found.

Parameters:

<Polarity> POSitive | NEGative | EITHer
POSitive Search for rise time.
NEGative Search for fall time.
EITHer Search for rise and fall time.
*RST: POS

TRIGger:A:RISetime:RANGe <Range>

Sets how the measured rise or fall time is compared with the given limit(s).
To set the rise/fall time, use TRIGger:A:RISetime:TIME.

To set the range + At, use TRIGger:A:RISetime:DELTa <DeltaTime>.

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds rise/fall times longer than the given time.

SHORter
Finds rise/fall times shorter than the given time.

WITHin
Finds rise/fall times inside the range time + At.
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OUTSide
Finds rise/fall times outside the range time + At.

*RST: SHOR

TRIGger:A:RISetime:TIME <Time>
Sets the reference rise or fall time, the nominal value for comparisons.

Parameters:
<Time> Range: Depends on various settings, mainly time base and sample rate
Default unit: s

*RST: 1.00000E-07

TRIGger:A:RISetime:DELTa <Delta_Time>

Sets a range At to the reference rise/fall time set with TRIGger:A:RISetime:TIME if
TRIGger:A:RISetime:RANGe <Range> is set to Within or Outside. The instrument finds rise/fall
times inside or outside the range time + At.

Parameters:
<Delta_Time> Range: Depends on various settings, mainly time base and sample rate
Default unit: s

*RST: 1.000E-08

TRIGger:A:SOURce <Source>
Sets the trigger source for the selected A trigger type.

Parameters:
<Source> CH1|CH2 | CH3 | CH4 | DO0...D15 | BUST | BUS2 | EXTernanalog |
LINE | NONe | PATTern

CH1| CH2 | CH3 | CH4
Selects the input channel (1...4) as trigger source.
The number of channels depends on the instrument type.

DO...D15
Slope trigger on the POD bit.

BUS1 | BUS2
Trigger on serial BUS.

EXTernanalog
External TRIG IN connector on the rear panel

LINE
AC line for the edge trigger.
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NONE
No trigger (e.g. in roll mode).

PATTern
Pattern, if logic trigger is active.

TRIGger:EXTern:COUPIling <ExternCoupling>

Sets the coupling for the external trigger input. The command is relevant if TRIGger:B:SOURce is
set to EXTernanalog.

Parameters:
<ExternCoupling> AC | DC

*RST: AC

TRIGger:A:TYPE <Type>
Sets the trigger type for the A trigger.

Parameters:
<Type> EDGE | WIDTh | TV | LOGic | BUS

EDGE Edge trigger
WIDTh Pulse trigger
TV Video trigger
LOGic Logic trigger
BUS BUS trigger, requires options for serial trigger and decode

TRIGger:A:HOLDoff:MODE <HoldOff_Mode>
Sets the trigger holdoff mode.

Parameters:
<HoldOff_Mode> TIME | OFF

*RST: OFF
TRIGger:A:HOLDoff:TIME <HoldOff_Time>
Defines the holdoff time. The next trigger only occurs after the holdoff time has passed.

Parameters:
<HoldOff_Time> Default unit: s
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TRIGger:OUT:MODE <Output_Mode>
Sets the trigger output mode.

Parameters:
<Output_Mode> OFF | TRIGger | MASK

*RST: OFF

TRIGger:OUT:POLarity <Polarity>
Sets the trigger output polarity,

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

TRIGger:OUT:PLENgth <Pulse_Length>
Sets the trigger output pulse length.

Parameters:
<Pulse_Length> <numeric value>

2.3.2 Edge Trigger

TRIGQErA:EDGE:SLOPE <SIOPE> oottt cee ettt 67
TRIGger: A:EDGE:COUPING <COUPING>  ooiiiiiiiiiiiie e 68
TRIGGer: A:IEDGE:FILTErLPASS <STate> it 68
TRIGger: A:EDGE:FILTer:NREJECt <STate>  ..iiiiiiiiiiii e 68

TRIGger:A:EDGE:SLOPe <Slope>
Sets the slope for the edge trigger (A trigger).

Parameters:
<Slope> POSitive | NEGative | EITHer

POSitive
Rising edge, a positive voltage change

NEGative
Falling edge, a negative voltage change

EITHer
Rising as well as the falling edge

*RST: POS
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TRIGger:A:EDGE:COUPIling <Coupling>
Sets the coupling for the trigger source.

Parameters:
<Coupling> DC | AC | HF | ALEVel

DC
Direct Current coupling. The trigger signal remains unchanged.

AC
Alternating Current coupling. A 5 Hz high pass filter removes the DC
offset voltage from the trigger signal.

HF

High frequency coupling. A 15 kHz high-pass filter removes lower fre-
qguencies from the trigger signal. Use this mode only with very high
frequency signals.

ALEVel (Auto Level)
*RST: DC
TRIGger:A:EDGE:FILTer:LPASs <State>
Turns an additional b5kHz low-pass filter in the trigger path on or off. This filter removes higher

frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF
TRIGger:A:EDGE:FILTer:NREJect <State>
Turns an additional T00MHz low-pass filter in the trigger path on or off. This filter removes higher

frequencies and is available with AC and DC coupling.

Parameters:
<State> ON | OFF

*RST: OFF
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2.3.3 Width (Pulse) Trigger

TRIGger: A:WIDTh:POLarity <POIArItY>  .ooiiiiiiiiiiiiiiee e 69
TRIGger: A:\WIDTh:RANGe <Range_MOode> ... 69
TRIGger: A\WIDTh:DELTa <Deltas> ..o 70
TRIGger: A\WIDTh:WIDTh <TiMeT> oo 70

TRIGger:A:WIDTh:POLarity <Polarity>
Sets the polarity of the pulse triger function.

Parameters:
<Polarity> POSitive | NEGative

POSitive
Positive going pulse, the width is defined from the rising to the falling
slopes.

NEGative
Negative going pulse, the width is defined from the falling to the rising
slopes.

*RST: POS

TRIGger:A:WIDTh:RANGe <Range_Mode>
Defines how the measured pulse width is compared with the given limit(s).

Parameters:
<Range_Mode> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide

Triggers on pulses inside or outside a range defined by time + delta.
The time is specified with TRIGger: A:WIDTh:WIDTh, the range around is
defined with TRIGger:A:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with

TRIGger:A:WIDTh:WIDTh.

*RST: LONG
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TRIGger:A:WIDTh:DELTa <Delta>
Defines a range around the width value specified using TRIGger: A:WIDTh:WIDTh.

Parameters:
<Delta> Range: £At (,Variation”)
Value range depends on the defined pulse width.

*RST: 3.2E-9

TRIGger:A:WIDTh:WIDTh <Time1>

For the ranges WITHin and OUTSide (defined using TRIGger:A:WIDTh:RANGe), the

<Time1> defines the center of a range which is defined by the limits +<Delta> (set with
TRIGger:A:WIDTh:DELTa). For the ranges SHORter and LONGer, the width defines the maximum
and minimum pulse width, respectively.

Parameters:
<Timel> Range: 19.2E-9 to 107.374E-3
Center value, maximum value or minimum value depending on the
defined range type.
*RST: 19.2E-9
Video/TV Trigger
TRIGger: A:TV:STANdard <Standard>  .....oiiiiiiiiiiii e eee e e 70
TRIGer: A:TV:POLArity <POIAIItY> oottt e 71
TRIGErATVIFIELD <Fields> oot e e 71
TRIGGENATVILINE <LiNe> oot e et e et e e nnbae e e reeeeeen 71

TRIGger:A:TV:STANdard <Standard>
Selects the color television standard.

Parameters:

<Standard> PAL | NTSC | SECam | PALM | 1576 | P720 | P1080 | 11080
PALM PAL-M
1576 SDTV 576i
P720| P1080 HDTV 720/1080p (progressive scanning)
11080 HDTV 1080i (interlaced scanning)
*RST: PAL
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TRIGger:A:TV:POLarity <Polarity>
Sets the polarity of the sync pulses. The edges of the sync pulses are used for triggering.

Parameters:
<Polarity> POSitive | NEGative

POSitive
If the video modulation is positve, the sync pulses are negative.

NEGative
If the modulation is negative, sync pulses are positive.

*RST: NEG

TRIGger:A:TV:FIELd <Field>
Sets the trigger on the beginning of the video signal fields, or on the beginning of video signal
lines.

Parameters:
<Field> EVEN | ODD | ALL | LINE | ALINe

EVEN
Triggers only on even half frames.

OoDD
Triggers only on odd half frames.

ALL
Triggers on all frames.

LINE
Triggers on the beginning of a specified line in any field.
The line number is set with TRIGger:A:TV:LINE.

ALINe
Triggers on the beginning of all video signal lines.

*RST: ALL
TRIGger:A:TV:LINE <Line>
Sets an exact line number, if TRIGger:A:TV:FIELd is set to LINE.
Parameters:
<Line> Range: 11to 525 (NTSC, PAL-M); 625 (PAL, SECAM, SDTV I-576);

750 (HDTV P720); 1125 (HDTV 11080, HDTV P1080)

*RST: 1
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2.3.5 Pattern (Logic) Trigger

TRIGger:A:PATTern:SOURCE <SOUICE_STING>  ..uviiiiiiiiiiiiiiiee e 72
TRIGger:A:PATTern:FUNCtion <FUNCLION> ..ot 72
TRIGger:A:PATTern:CONDiItion <ConditioN> ... 73
TRIGger:A:PATTern:MODE <Pattern_Mode> ... 73
TRIGger:A:PATTern:WIDTh[:WIDTh] <Numeric_Value> .......cccccoiiiiiiiiiieiiiiieeee e 73
TRIGger:A:PATTern:WIDTh:DELTa <Pattern_Deltas> ......cccceiiiiiiiiiiie e 73
TRIGger:A:PATTern:WIDTh:RANGe <Pattern_Range> . ..ccccccciiiiiiiiiiii e 74

TRIGger:A:PATTern:SOURce <Source_String>
Selects the state for each digital channel. The respective channel (CH1, CH2 or logic channels
0...7) has to be activated before state selecting.

Parameters:

<Source_String> String containing 0, 1, or X for each channel.
1 High, the signal voltage is higher than the trigger level.
0 Low, the signal voltage is lower than the trigger level.
X Don‘t care. the channel does not affect the trigger.

Example: TRIG:A:PATT:SOUR ,, 1X"

CH1 = High, CH2 = Don't care (POD deactivated)
TRIG:A:PATT:SOUR ,,00101X1X1X"
POD: 0 = High, 1 = Low, ..., 7 = Don't care (CH1 / CH2 deactivated)

TRIGger:A:PATTern:FUNCtion <Function>
Sets the logical combination of the trigger states of the channels.

Parameters:
<Function> AND | OR
AND
The required states of all channels must appear in the input signal at the
same time.
OR

At least one of the channels must have the required state.

*RST: AND
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TRIGger:A:PATTern:CONDition <Condition>
Sets the trigger point depending on the result of the logical combination of the channel
states.

Parameters:
<Condition> .TRUE” | ,FALSE"

*RST: ,TRUE"

TRIGger:A:PATTern:MODE <Pattern_Mode>
Sets the duration function of the pattern trigger.

Parameters:
<Pattern_Mode> OFF | TIMeout | WIDTh

OFF
Pattern trigger without duration.

TIMeout
Pattern trigger with duration and timeout.

WIDTh
Width duration and comparision of the logical combined channels.

*RST: OFF

TRIGger:A:PATTern:WIDTh[:WIDTh] <Numeric_Value>

For the ranges WITHin and OUTSide (defined using TRIGger:A:PATTern:WIDTh:RANGe), the
<numeric_value> defines the center of a range which is defined by the limits +<Delta> (set with
TRIGger:A:PATTern:WIDTh:DELTa). For the ranges SHORter and LONGer, the width defines the
maximum and minimum pulse width, respectively.

Parameters:

<Numeric_Value> Range: 19.2E-9 to 107.374E-3
Center value, maximum value or minimum value depending on the
defined range type.

*RST: 19.2E-9

TRIGger:A:PATTern:WIDTh:DELTa <Pattern_Delta>
Defines a range around the width value specified using TRIGger:A:PATTern:WIDTh[:WIDTh].

Parameters:
<Pattern_Delta> Range: £At (,Variation”)
Range: 3.2E-9 to maximum value depends on the defined pulse width

*RST: 3.2E-9

SCPI Programmers Manual 73



SCPI Commands HMO3000 series Remote Control

Command Reference

TRIGger:A:PATTern:WIDTh:RANGe <Pattern_Range>
Defines a range around the width value specified using TRIGger:A:PATTern:WIDTh:WIDTh.

Parameters:
<Pattern_Range> WITHin | OUTSide | SHORter | LONGer

WITHin | OUTSide

Triggers on pulses inside or outside a range defined by time + delta.
The time is specified with TRIGger:A:PATTern:WIDTh[:WIDTh], the range
around is defined with TRIGger:A:PATTern:WIDTh:DELTa.

SHORter | LONGer
Triggers on pulses shorter or longer than a time set with
TRIGger:A:PATTern:WIDTh[:WIDTh]

*RST: LONG
2.3.6 B-Trigger
TRIGQENB:ENABIE <STAtE> oo 74
TRIGQEr:B:SOURCE <SOUICE> oottt 74
TRIGer:B:EDGE:SLOPE <SIOPE> i 75
TRIGErBILEVEI <LeVeI> e 75
TRIG@er:B:MODE <MOde> oo 75
TRIGger:B:DELay <DelayTimes> oo 75
TRIGger:B:EVENTCOUNT <EVENT_CNt> oot 75

TRIGger:B:ENABIle <State>
Activates or deactivates the B-trigger. The instrument triggers, if both trigger event conditions (A
and B) are fulfilled.

Parameters:
<State> ON | OFF

*RST: OFF
TRIGger:B:SOURce <Source>
Selects one of the input channels as B-trigger source.
Parameters:
<Source> CH1 | CH2 | CH3 | CH4

The number of channels depends on the instrument type.

*RST: CH1
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TRIGger:B:EDGE:SLOPe <Slope>
Sets the edge for the B-trigger.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POS

TRIGger:B:LEVel <Level>
Sets the trigger level for the B-trigger event.

Parameters:
<Level> Default unit: V

*RST: 0

TRIGger:B:MODE <Mode>
Defines the delay type of the B-trigger.

Parameters:
<Mode> DELay | EVENts

DELay
Time delay, set with TRIGger:B:DELay

EVENts
Event count delay, set with TRIGger:B:EVENt:COUNTt

*RST: DEL

TRIGger:B:DELay <DelayTime>
Sets the time the instrument waits after an A-event until it recognizes B-events.
Before setting the delay time, TRIGger:B:MODE must be set to DELay.

Parameters:
<DelayTime> Range: 8E-9 min., depending on the instrument type
Default unit: s

*RST: 8E-9, depending on the instrument type

TRIGger:B:EVENt:COUNt <Event_Cnt>

Sets a number of B-trigger events that fulfill all B-trigger conditions but do not cause the trigger.
The oscilloscope triggers on the n-th event (the last of the specified number of events). Before
setting the event number, TRIGger:B:MODE must be set to EVENTts.

Parameters:

<Event_Cnt> Range: 1 to 65535
Number of B-events
*RST: 1
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BasiC DiSPlay SEtHNGS  oiiieiiiiiiiie et e 76
4o Yo Y2 2 TP 81
MarKers (TIMESTAMIPS)  ieiiiiiiie et e e e et e e e e e e e e eeeeaaa s 82

Basic Display Settings
This chapter describes commands that configure the screen display.

General Display Settings:

DISPIay:MODE <MOGE> oottt ettt et e e et e e e etaee e eaeeas 76
DISPlay:PALEtte <Palettes> oo 77
DISPlay:VSCReen:ENABIe <ENables> e 77
DISPlay:VSCReen:POSItION <POSITION  ...uiiiiiiiiiii e 77
XYZ-Setup:

DISPIay:XY: XSOUICE SSOUICES  wiiiiiiiiiiiiiiiie ettt e et e e e e e e ettt e e e e e e etabaeaa e 78
DISPIaY: XY Y TSOUICE SSOUMCES  .iiiiiiiiiiiiiiie ettt e e et 78
DISPIay:XY:Y2S0UICE SSOUMCES  .iiiiiiiiiiiiie et e a e 78
DISPIay:XY:ZMODE <MOAE>  ..oeiiiiiie e 78
DISPlay:XY:ZTHReshold <Z_Threshold> ... 79
DISPlay:XY:ZSOUICE <SOUICE> oo 79
Intensities

DISPlay:INTensity:WAVeform <INtENSITY> ... 79
DISPlay:INTensity:BACKIght <INTENSITY>  .ooiiiiiiii e 79
DISPlay:INTensity:GRID <INt@NSItY> oo 79
DISPlay:PERSIStENCE:STATE <STATE> oo 80
DISPlay:PERSIStENCE: TIME <TIME> oo 80
DISPlay:PERSistence:INFinite <Inf_PersistenCes>  ......ccccciiiiiiiiiiie e 80
DISPlay:PERSistenCe:TIME:AUTO <AULO>  .oiiiiiiiii ettt 80
DISPIay:PERSISTENCEICLEAN ..t 80

Waveform, Auxilary Cursors and Grid Settings
DI PIaY ST Y L <O Y B> ittt 81
DISPIaY:GRID:ISTYLE <StYIE> oo 81

DISPlay:MODE <Mode>
Sets the diagram mode.

Parameters:
<Mode> YT | XY

YT
Default time diagram with a time axis in x-direction and the signal
amplitudes displayed in y-direction.

XY
XY-diagram combines the voltage levels of two waveforms in one
diagram.

*RST: YT
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DISPlay:PALette <Palette>
Sets the color and brightness of the displayed waveform samples depending on their cumulative
occurance.

Parameters:
<Palette> NORMal | INVerse | FCOLor | IFColor

NORMal
Values that occur frequently are brighter than rare values.

INVerse
Rare values are brighter than frequent values, inverse to the NORMal
brightness.

FColor

Rare values are displayed in blue while more frequent values are red
and very frequent values are displayed in yellow or white, with various
colors inbetween.

IFColor
Inverses the FColor setting. Rare values are yellow or white while
frequent values are blue.

*RST: NORM
DISPlay:VSCReen:ENABIle <Enable>
Switches the virtual screen on or off.

Parameters:
<Enable> ON | OFF

*RST: OFF
DISPlay:VSCReen:POSition <Position>
Set the position of the virtual screen window.
Parameters:
<Position> Range: 2 to -10

Default unit: div

*RST: 0

e
SCPI Programmers Manual 77



SCPI Commands HMO3000 series Remote Control

Command Reference

DISPlay:XY:XSOurce <Source>
Defines the source to be displayed in x direction in an XY-diagram, replacing the usual time base.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4
The number of channels depends on the instrument type.

*RST: CH1

DISPlay:XY:Y1Source <Source>
Defines the (first) source to be displayed in y direction in an XY-diagram.

Parameters:
<Source> CH1|CH2 | CH3| CH4
The number of channels depends on the instrument type.

*RST: CH2

DISPlay:XY:Y2Source <Source>
Defines the y source of the second XY waveform in the diagram.

Parameters:
<Source> NONE | CH1| CH2 | CH3 | CH4
The number of channels depends on the instrument type.

*RST: NONE

DISPlay:XY:ZMODe <Mode>
Activates or deactivates the intensity control of the waveform via an additional signal source and
sets the intensity mode.

Parameters:
<Mode> ANALog | DIGital | OFF

ANALog
Modulated intensity; Intensity is modulated continuously according to
the selected source Z.

DiGital

Intensity is determined by a threshold value defined with
DISPlay:XY:ZTHReshold. If the Z signal value is below the selected
threshold, the corresponding x/y point is displayed with lowest
intensity. If the Z signal value is above the threshold, the x/y point is
displayed with the defined intensity level.

OFF
Intensity control is deactivated.

*RST: OFF
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DISPlay:XY:ZTHReshold <Z_Threshold>
Defines the threshold for intensity with a two-state modulation, if DISPlay:XY:ZMQODe is set to
DIGital.

Parameters:

<Z_Threshold> Range: -10 to 10
Threshold for visibility on the screen
Default unit: V

*RST: 0

DISPlay:XY:ZSOurce <Source>
Defines the source to be used to determine the intensity of the xy-waveform.

Parameters:
<Source> CH1 | CH2 | CH3 | CH4
The number of channels depends on the instrument type.

*RST: CH1

DISPlay:INTensity:WAVeform <Intensity>
Defines the strength of the waveform line in the diagram. *RST does not change the intensity.

Parameters:
<Intensity> Range: 0 to 100
Default unit: %

DISPlay:INTensity:BACKlight <Intensity>
Defines the intensity of the background lighting of the display. *RST does not change the intensity.

Parameters:
<Intensity> Range: 10 to 100
Default unit: %

DISPlay:INTensity:GRID <Intensity>
Defines the intensity of the grid on the screen. *RST does not change the intensity.

Parameters:
<Intensity> Range: 0 to 100
Default unit: %
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DISPlay:PERSistence:STATe <State>
Defines whether the waveform persists on the screen or whether the screen is refreshed
continuously.

Parameters:
<State> ON | OFF

ON
The waveform persists for the time defined using
DISPlay:PERSistence: TIME.

OFF
The waveform does not persist on the screen. Only the currently
measured values are displayed at any time.

*RST: OFF

DISPlay:PERSistence:TIME <Time>

Persistence time if persistence is active (please refer to DISPlay:PERSistence:STATe). Each new
data point in the diagram area remains on the screen for the duration defined here. To set infinite
persistence, use DISPlay:PERSistence:INFinite.

Parameters:
<Time> Range: 50E-3 to infinite
Default unit: s
*RST: 50E-3
DISPlay:PERSistence:INFinite <Inf_Persistence>
Sets the persistence time to infinite if DISPlay:PERSistence:STATe is ON. Each new data point

remains on the screen infinitely until this setting is changed or the persistence is cleared.

Parameters:
<Inf_Persistence> ON | OFF

*RST: OFF
DISPlay:PERSistence:TIME:AUTO <Auto>
The optimal persistence time is determined automatically by the instrument.
Parameters:
<Auto> ON | OFF
DISPlay:PERSistence:CLEar
Removes the displayed persistent waveform from the screen.

Usage: Event

SCPI Programmers Manual 80



Command Reference

DISPlay:STYLe <Style>
Defines how the waveform data is displayed

Parameters:
<Style> VECTors | DOTS

VECTors
Individual data points are connected by a line.

DOTS
Only the data points are displayed.

*RST: VECT

DISPlay:GRID:STYLe <Style>
Defines how the grid is displayed.

Parameters:
<Style> LINes | RETicle | NONE

LINes

Displays the grid as horizontal and vertical lines.

RETicle

Displays crosshairs instead of a grid.

NONE (No grid)

2.4.2 Zoom

TIMebase:ZOOM:STATE <Z00M_StAte>  ....oiiiiiiii e 81
TIMebase:ZOOM:SCALE <Z00M_SCAlE> ..ottt 82
TIMebase:ZOOMITIME <TIME>  1iiiiiiiieiie ittt ettt et stae et a et e et aanneeeeras 82
TIMebase:ZOOM:POSItION <POSITION>  1oouiiiiiiiee et 82

TIMebase:ZOOM:STATe <Zoom_State>
Switches the zoom window on or off.

Parameters:
<Zoom_State> ON | OFF

*RST: OFF
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TIMebase:ZOOM:SCALe <Zoom_Scale>
Defines the time base in the zoom diagram in seconds per division.

Parameters:

<Zoom_Scale> Scaling of the zoom time base in s/div depending on time base and
channel settings
Default unit: s/div

*RST: be-b
TIMebase:ZOOM:TIME <Time>
Defines the offset of the trigger point to the reference point of the zoom diagram.

Parameters:
<Time> Default unit: s

*RST: 0
TIMebase:ZOOM:POSition <Position>
Defines the position of the zoom reference point (the reference point of the zoom window) in
relation to the reference point of original time base.
Parameters:
<Position> Range: 0 to 100, depending on the zoom time base

Default unit: %

*RST: 5.00E+01

Markers (Timestamps)

TS aMD S ET 82
RIS E=Taal o 1AV =0 G E TSP UURRPROPUPPPPPTRN 83
TSTAMPIPREVIOUS oot 83
TS TaAMPICLEAT e 83
BIS T E=Ta 0] o JY A O] I=Y- Y RSOSSN 83
TSTamp:SET

Sets a new marker (timestamp) at the reference point of the display, unless an existing marker is
already set there. The reference point is set with TIMebase:REFerence.

Usage: Event
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TSTamp:NEXT

Moves the next marker (timestamp, to the right) to the reference point of the display or zoom
area.

Usage: Event

TSTamp:PREVious

Moves the previous marker (timestamp, to the left) to the reference point of the display or zoom
area.

Usage: Event

TSTamp:CLEar
Deletes the marker (timestamp) at the reference point. The reference point is set with
TIMebase:REFerence.

Usage: Event

TSTamp:ACLear
Deletes all markers (timestamps).

Usage: Event
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2.5 Measurements

2.5.1

This chapter describes functions that configure or perform cursor and automatic measurements.

Cursor

(01U Yo R g Py AN O SR 84
CURSOIr<mM>:STATE <STATE>  ooiiiiiiiii et 84
CURSOr<mM=>:FUNCHON STYPE>  ooiiiiiiiiiiiiiiite ettt et e e tabaa e 85
CURSOr<mM>:SOURCE SSOUIMCES  .iiiiiiiiiiiiiiiiiie ettt e 86
CURSor<m>:TRACKING[:STATE] <STAtE>  ..vvviiiiiiiiiiiiiiec et 86
CURSor<m>:XTPosition <XpOSItIONT> oot 87
CURSor<m>:X2P0Sition <XPOSItION2>  oiiiiiiiie e 87
CURSor<m>:X3P0osition <XpOSItiON3>  ooiiiiiiiiiiiiee e 87
CURSOr<m=>:YTPOSItION <YPOSIIONT S  L.oiiiiiiiiiiiiiiiieiieieietieeeeeeeeeeaeteeeaeeeeeaeeeseaeeeaesssesneesesessessnnnees 87
CURSor<m=>:Y2P0oSition <YPOSITIONZ>  ooiiiiiiiieiiiiiiiiie ettt e e aaaae e 87
CURSor<m=>:Y3P0osition <YPOSItIONS>  ooiiiiiiiiiiiiiiiiiie ettt 88
CURSor<m>:TRACKING:SCALE[:STATE] <STate> iiiuiiiiiiiiiiiiiiie et 88
CURSor<m>:XCOUPHNG <COUPING> oo 88
CURSor<m=>:YCOUPIING <COUPINGS  iiiiiiiiiiiiiiii et 88
CURSOIr<mM>IRESUI? oo 89
CURSOI<MS>ISWAVE e et 89
CURSOI<M>ISSCREEN oottt e et e e e et e e e e e e e etaareaae s 89
CURSOr<mM=>1SNPEaK<N> oo 89
CURSOIr<mM>1SPPeAK<N> oo 89
CURSOr<m>:XDELLIAIINVEISE?  ..eeeiiiiieiiieee et 90
CURSOr<mM > XD E LA VA LU ? e 90
CURSOr<m>:YDELa:SLOPE? ..o 90
CUR SO Y DE LA VA UG 2 e 90
CURsor<m=>:XRATIO:UNIT <UNIT> oottt 91
CURSOr<m=>:XRATIO[:VALUBI? oo 91
CURSor<m=>:YRATIO:UNIT <UNIt> oo e 91
CURSOIr<mM > Y RATIO VAL LU ? oo 92
CURSor<m>:AOFF

Switches the cursor off.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Usage: Event

CURSor<m>:STATe <State>
Activates or deactivates the cursor measurement.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

*RST: OFF
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CURSor<m>:FUNCtion <Type>
Defines the cursor measurement type.

Suffix:

<m>

Parameters:
<Type>

1 (the numeric suffix is irrelevant)

HORizontal | VERTical | PAIRed | HRATio | VRATio | PPCount |
NPCount | RECount | FECount | MEAN | RMS | RTIMe | FTIMe |
PEAK | UPEakvalue | LPEakvalue | STDD | PDCYcle | NDCYcle

HORizontal
Sets two horizontal cursor lines and measures the voltages at the two
cursor positions and the delta of the two values.

VERTical

Sets two vertical cursor lines and measures the time from the trigger
point to each cursor, the time between the two cursors and the fre
quency calculated from that time.

PAIRed (V-Marker)

HRATio
Ratio of the x-values (e.g. a duty cycle) between the first and second
cursors and the first and third cursors.

VRATio
Ratio of the y-values (e.g. overshooting) between the first and second
cursors and the first and third cursors.

PPCount (Count positive pulses)
NPCount (Count negative pulses)
RECount (Count rising edges)
FECount (Count falling edges)
MEAN (Mean value)

RMS (Root mean square)

RTIMe (Rise time, t)

FTIMe (Fall time, t7)
The reference level for rise and fall time measurement is set with
REFLevel<m>:RELative:MODE.

PEAK
Absolute difference between the two peak values, Vpp.

UPEakvalue (Upper peak value, Vp.)
LPEakvalue (Lower peak value, Vp.)
STDD (standard deviation)

PDCYcle (positive duty cycle)
NDCYcle (negative duty cycle)

*RST: PAIR
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CURSor<m>:SOURce <Source>
Defines the cursor measurement source as one of the active signal, reference or math channel.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Parameters:

<Source> NONE | CH1 | CH2 | CH3 | CH4 | POD1 | POD2 | DO...D15 |QMA | MAT |

MA2 | MA3 | MA4 | MA5 | RE1 | RE2 | RE3 | RE4 | XY1 | XY2

CH1| CH2 | CH3 | CH4
Active signal channels CH1 to CH4.
The number of channels depends on the instrument type.

POD1 | POD2
Active logic POD.

DO...D15
Active digital channels from DO up to D15.

QMA
Active quick math channel.

MA1 | MA2 | MA3 | MA4 | MA5
Active math channels 1 to b.

RE1 | RE2 | RE3 | RE4
Active reference channels 1 to 4

XY1 | XY2
Active XY-waveform

*RST: CH1

CURSor<m>:TRACking[:STATe] <State>
If set to ON, the V-Marker cursor measurement is enabled.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

*RST: OFF

e
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CURSor<m>:X1Position <Xposition1>
Specifies the position of the first cursor on the time axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition1> Default unit: s

CURSor<m>:X2Position <Xposition2>
Specifies the position of the second cursor on the time axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition2> Default unit: s

CURSor<m>:X3Position <Xposition3>
Specifies the position of the third cursor on the time axis for the ratio X measurement.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Xposition3> Default unit: s

CURSor<m>:Y1Position <Yposition1>
Specifies the position of the first horizontal cursor on the y-axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition1> Default unit: V

CURSor<m>:Y2Position <Yposition2>
Specifies the position of the second horizontal cursor on the y-axis.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition2> Default unit: V
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CURSor<m>:Y3Position <Yposition3>
Specifies the position of the third horizontal cursor on the y-axis for Ratio Y measurements.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Yposition3> Default unit: V

CURSor<m>:TRACking:SCALe[:STATe] <State>
Enables the adjustment of cursor lines if the vertical or horizontal scales are changed.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<State> ON | OFF

ON
Cursor lines keep their relative position to the waveform.

OFF
Cursor lines remain on their position on the display if the scaling is
changed.

*RST: OFF

CURSor<m>:YCOupling <Coupling>

CURSor<m>:XCOupling <Coupling>

If enabled, the cursors of a set are coupled so that the distance between the two remains the
same if one cursor is moved.

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Coupling> ON | OFF

*RST: OFF
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CURSor<m>:RESult?
Returns the cursor positions.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Value> Comma-separated list

Example: If CURSor<m>:FUNCtion is set to RTIM, CURSor<m=>:RESult? will
return the risetime of a slope between both cursors. If the function is
set to MEAN, CURSor<m>:RESult? will return the measured mean
value. If there is no specific value, CURSor<m=>:RESult? will return the
position of the first cursor.

Usage: Query only

CURSor<m>:SWAVe

Autoset for cursor lines, sets the cursor lines to typical points of the waveform depending on the
selected measurement type. For example, for voltage measurement, the cursor lines are set to
the upper and lower peaks of the waveform. For time measurement, the cursor lines are set to
the edges of two consecutive positive or two consecutive negative pulses.

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Usage: Event

CURSor<m>:SSCReen
Resets the cursors to their initial positions. This is helpful if the cursors have disappeared from
the display or need to be moved for a larger distance.

Suffix:
<m> 1 (the numeric suffix is irrelevant)
Usage: Event

CURSor<m>:SNPeak<n>
For FFT analysis only: Sets the selected cursor to the next (right) level peak.

Usage: Event

CURSor<m>:SPPeak<n>

For FFT analysis only: Sets the selected cursor to the previous (left) level peak.
Usage: Event
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CURSor<m>:XDELta:INVerse?
Returns the inverse time difference between the two cursors (1/At).

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Delta_Inverse> Default unit: 1/s

Usage: Query only
CURSor<m>:XDELta[:VALue]?
Returns the time difference between the two cursors (At).

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Delta> Default unit: s

Usage: Query only
CURSor<m>:YDELta:SLOPe?
Returns the inverse value of the voltage difference - the reciprocal of the vertical distance of two

horizontal cursor lines: 1/AV.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<DeltaY_slope> Inverse value

Usage: Query only
CURSor<m>:YDELta[:VALue]?
Returns the delta of the values in y-direction at the two cursors.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<DeltaY> Delta value in V

Usage: Query only
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CURsor<m>:XRATio:UNIT <Unit>
Sets the unit for X Ratio measurements with CURSor<m>:XRATio[:VALue].

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Unit> RATio | PCT | GRD | PI

RATio Floating value
PCT Percent

GRD Degree

Pl Radian

CURSor<m>:XRATio[:VALue]?
Returns the ratio of the x-values (e.g. a duty cycle) between the first and second cursors and the
first and third cursors: (x2-x1)/(x3-x1). Set the unit of the result with CURsor<m>:XRATio:UNIT.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

CURSor<m>:YRATio:UNIT <Unit>
Sets the unit for Y Ratio measurements with CURSor<m=>:YRATio[:VALue].

Suffix:

<m> 1 (the numeric suffix is irrelevant)
Parameters:

<Unit> RATio | PCT

RATio Floating value
PCT Percent
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Command Reference

CURSor<m>:YRATio[:VALue]?

Provides three cursors and measures the ratio of the y-values (e.g. overshooting) between the
first and second cursors and the first and third cursors: (y2-y1)/(y3-y1). Set the unit of the result
with CURSor<m>:YRATio:UNIT.

Suffix:
<m> 1 (the numeric suffix is irrelevant)

Return values:
<Ratio> Numeric value corresponding to the specified unit.

Usage: Query only

Automatic Measurements

MEASUremMent<mM > AOFF e 92
MEASUrement<mM>AON e 93
MEASUrement<m>:ARESUI? .. e 93
MEASUrement<m>[ENABIE] <State> ..o 93
MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>] ..........cccovviiiiiiiiiiinnnnn.n. 94
MEASUremMent<mM>:ICATEGOIY?  oiiiiiiii ittt e e e e e e et reaa e s 94
REFLevel<m>:RELative:MODE <RelativeMOode> .........cccoiiiiiiiiiiiiicee e 95
MEASurement<m>:MAIN <M@EASTYPE>  ..oooiiiiiiiiiiii e 95
MEASurement<m>:RESUIt? [<MEASTYPE>] .ooiiiiiiiiiii e 97
MEASurement<m>:RESult:AVG? [<AverageValue>] ......cccccooiiiiiiiiiiece e 98
MEASurement<m>:RESult:STDDev? [<StandardDeviation>] .....c.cooiiiiiiiiiiiiiiiieee e 98
MEASurement<m>:RESult:NPEak? [<NegativePeak>] ......c....ccccciiiiiiiiiiiiiiie e, 98
MEASurement<m>:RESult:PPEak? [<PositivePeak=>] ... 98
MEASurement<m>:RESult: WFMCount? [<WaveformCount>] .....coooiiiiiiiiiiieee e 99
MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope> ........ccccoceveiiiiiiiinnn... 99
MEASurement<m>:STATistics[:ENABIle] <StatisticEnable> ..........cccccoo 99
MEASurement<m>:STATIStICSIRESET  ..eeviiiiiiiieee e 99
MEASurement<m>:STATistics:WEIGht <AverageCount> .. .....cccooviiiiiiiiicie e 100
MEASurement<m>:AOFF

Stops the quick measurement.

Suffix:
<m> 1..6 (the numeric suffix is irrelevant)
Usage: Event



Command Reference

MEASurement<m>:AON
Starts the quick measurement.

Suffix:
<m> 1..6 (the numeric suffix is irrelevant)
Usage: Event

MEASurement<m>:ARESult?
Returns the results of the quick measurement.

Suffix:

<m> 1.6
Selects the measurement.

Return values:

<QuickMeasData> List of values
Quick measurement results are listed in the following order:
PEAK, UPE, LPE, CYCR, CYCM, PER, FREQ, RTIM, FTIM

Usage: Query only

MEASurement<m>[:ENABIle] <State>
Activates or deactivates the selected measurement (1...6). Only the results of active measure-
ments are displayed in the result table.

Suffix:
<m> 1.6
Selects the measurement.
Parameters:
<State> ON | OFF

*RST: OFF
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MEASurement<m>:SOURce <SignalSource>[,<ReferenceSource>]
Selects one of the active signal, reference or math channels as the source of the selected

measurement.

Suffix:

<m> 1.6

Parameters:

<SignalSource> NONE | CH1 | CH2 | CH3 | CH4 | DO...D15 | QMA | MAT | MA2 | MA3 |

MA4 | MAS | RE1 | RE2 | RE3 | RE4

<ReferenceSource> ~ NONE | CH1 | CH2 | CH3 | CH4 | MAT | MA2 | MA3 | MA4 | MAS |
RE1|RE2 | RE3 | RE4

CH1| CH2 | CH3 | CH4
Active signal channels 1 to 4.
The number of channels depends on the instrument type.

DO...D15
Active digital channels from DO up to D15.

QMA
Active quick math channel.

MA1 | MA2 | MA3 | MA4 | MA5
Active math channels.

RE1 | RE2 | RE3 | RE4
Active reference channels 1 to 4.

*RST: CH1
MEASurement<m>:CATegory?
Returns the measurement category. Currently, the instrument supports only yt-measurements.
Suffix:
<m> 1.6

Selects the measurement.

Return values:

<Category> AMPTime
AMPtime Yt measurements
Usage: Query only

e
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REFLevel<m>:RELative:MODE <RelativeMode>
Sets the lower and upper reference levels for rise and fall time mesurements (cursor and auto-
matic mesurements), defined as percentages of the high signal level.

Suffix:
<m> 1.7
Measurement to which the reference level belongs.
Suffix 1...6 assign the measurement places 1 to 6 (auto measure).
Suffix 7 assigns the cursor measurement.
Parameters:
<RelativeMode> TEN | TWENty
TEN 10/90%
TWENty 20/80%
Example: REFL2:REL:MODE TWENty

MEAS2:MAIN RTIM

Sets the reference level for measurement place 2 and measures the rise
time between these levels:

Lower reference level = 20% of high signal level

Upper reference level = 80% of high signal level

*RST: TEN
MEASurement<m>:MAIN <MeasType>

Defines the measurement type to be performed on the selected source. To query the results, use
MEASurement<m>:RESult.

Suffix:
<m> 1.6
Selects the measurement type.
Parameters:
<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue | PPCount |

NPCount | RECount | FECount | HIGH | LOW | AMPLitude | CRESt |
MEAN | RMS | RTIMe | FTIMe | PDCYcle | NDCYcle | PPWidth |
NPWidth | CYCMean | CYCRms | STDDev | TFRequency | TPERiode |
POVershoot | NOVershoot | DELay | PHASe

FREQuency

Frequency of the signal. The result is based on the length of the left-
most signal period within the displayed section of the waveform of the
selected channel.

PERiod
Length of the left-most signal period within the displayed section of the
waveform of the selected channel.
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PEAK
Peak-to-peak value within the displayed section of the waveform of the
selected channel.

UPEakvalue
Maximum value within the displayed section of the waveform of the
selected channel.

LPEakvalue
Minimum value within the displayed section of the waveform of the
selected channel.

PPCount (count positive pulses)
NPCount (count negative pulses)
RECount (count rising edges)
FECount (count falling edges)

HIGH
Mean value of the high level of a square wave.

Low
Mean value of the low level of a square wave.

AMPLitude
Amplitude of a square wave.

CRESt
The crest factor (peak-to-average ratio) is calculated from the maximum
value divided by the RMS value of the waveform (Crest).

MEAN
Mean value of complete displayed waveform of the selected channel.

RMS
RMS (Root Mean Square) value of the voltage of the complete
displayed waveform of the selected channel.

RTIMe | FTIMe

Rise or falling time of the left-most rising edge within the displayed
section of the waveform of the selected channel. The reference level for
this mesurement is set with REFLevel<m>:RELative:MODE.

PDCycle | NDCycle
Measure the positive or negative duty cycle.

PPWidth | NPWidth
Measure the width of positive or negative pulses.

CYCMean
Mean value of the left-most signal period of the waveform of the
selected channel.
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CYCRms
RMS (Root Mean Square) value of the voltage of the left-most signal
period of the waveform of the selected channel.

STDDev
Measures the standard deviation of the waveform.

TFRequency
Measures the frequency of the trigger signal based on the length of its
period.

TPERiode
Measures the length of the trigger signal periods (hardware counter).

POVershoot
Measures the positive overshoot of the waveform.

NOVershoot
Measures the negative overshoot (undershoot) of the waveform.

Delay

Time difference between two edges of the same or different wave
forms. The waveforms are selected with MEASurement<m=>:SOURce,
and the edges with MEASurement<m>:DELay:SLOPe.

Phase
Phase difference between two waveforms [(time difference/period) x 360].
The waveforms are selected with MEASurement<m>:SOURCce.

*RST: NONE (measurement is off)

MEASurement<m>:RESult? [<MeasType>]
Returns the result of the specified measurement type.

Suffix:
<m> 1.6
Selects the measurement type.

Return values:
<Value> Measurement result

Query Parameters:

<MeasType> FREQuency | PERiod | PEAK | UPEakvalue | LPEakvalue | PPCount |
NPCount | RECount | FECount | HIGH | LOW | AMPLitude | MEAN |
RMS | RTIMe | FTIMe | PDCYcle | NDCYcle | PPWidth | NPWidth |
CYCMean | CYCRms | STDDev | TFRequency | TPERiode | POVershoot |
NOVershoot | DELay | PHASe

Specifies the measurement type (see MEASurement<m=>:MAIN).
Usage: Query only

e
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MEASurement<m>:RESult:AVG? [<AverageValue>]
Returns the average value of the current mesurement series. The number of waveforms used for
calculation is defined with MEASurement<m>:STATistics:WEIGht.

Suffix:
<m> 1..6
Selects the measurement type.

Query parameters:
<AverageValue> Statistic value

Usage: Query only

MEASurement<m>:RESult:STDDev? [<StandardDeviation>]
Returns the statistical standard deviation of the current mesurement series. The number of wave-
forms used for calculation is defined with MEASurement<m>:STATistics:WEIGht.

Suffix:
<m> 1.6
Selects the measurement type.

Query parameters:
<StandardDeviation>  Statistic value

Usage: Query only

MEASurement<m>:RESult:NPEak? [<NegativePeak>]
Returns the minimum measurement value of the current measurement series.

Suffix:
<m> 1...6
Selects the measurement type.

Query parameters:
<NegativePeak> Minimum measurement value

Usage: Query only

MEASurement<m>:RESult:PPEak? [<PositivePeak>]
Returns the maximum measurement value of the current measurement series.

Suffix:
<m> 1.6
Selects the measurement type.

Query parameters:
<PositivePeak> Maximum measurement value

Usage: Query only
e
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MEASurement<m>:RESult:WFMCount? [<WaveformCount>]
Returns the current number of measured waveforms.

Suffix:
<m> 1..6
Selects the measurement type.

Query parameters:
<WaveformCount> Number of measured waveforms

Usage: Query only
MEASurement<m>:DELay:SLOPe <SignalSlope>,<ReferenceSlope>

Sets the edges to be used for delay measurement. The associated waveforms are defined with
MEASurement<m>:SOURCce.

Parameters:
<SignalSlope> POSitive | NEGative

Slope of source 1 (first waveform)
<ReferenceSlope> POSitive | NEGative

Slope of source 2 (second waveform)

*RST: POS

MEASurement<m>:STATistics[:ENABIle] <StatisticEnable>
Activates or deactivates the statistical evaluation for the selected measurement.

Suffix:
<m> 1..6
Selects the measurement type.
Parameters:
<StatisticEnable> ON | OFF

*RST:  OFF

MEASurement<m>:STATistics:RESet
Deletes the statistical results for the selected measurement, and starts a new statistical evaluati-
on, if the acquisition is running. The waveform count is set to 0 and all measurement values are

set to NAN.
Suffix:
<m> 1.6
Selects the measurement type.
Usage: Event
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MEASurement<m>:STATistics:WEIGht <AverageCount>
Sets the number of measured waveforms used for calculation of average and standard deviation.

Suffix:
<m> 1.6
Selects the measurement type.
Parameters:
<AverageCount> Range: 2 to 1000

Statistics average count

*RST: 1000

2.6 Search functions

S AN C o e 98
PEaK e 101
[ [ 1 T 102
LAY, 4 R 103
RUN e e e 104
RISE / Fall TIMIE et e et 106
Data 1o clock / SEtup & HOIA oo 108
PatterN o 110

2.6.1 Search

SEARCH:STATE <SarChSIate> .ttt 100
SEARCh:SOURCE <SaIrCH_SOUICE™ oo 101
SEARch:CONDItion <Search_ConditioN ..o 101
SEARCH:RESUILBCOUNT oo 102
] =AY oo o T O @ 1] ) SRR 102
SEARCHIRESUISNS? e 103
SEARCHIRESUIIALL? e 103
SEARch:RESDiagram:SHOW <ReSUIt_ShOW>  .....ooiiiiiiii e, 104
EXPort:SEARCh:NAME <FIlENGME>  ..ooiiiiiiii e 104
EXPOrt:SEARCNISAVE oo 104

SEARch:STATe <SearchState>
Enable or disable the search function

Parameters:
<SearchState> ON | OFF

*RST: OFF



SCPI Commands HMO3000 series

Remote Control

Command Reference

SEARch:SOURce <Search_Source>
Set the source for the search function.

Parameters:
<Search_Source>

CH1| CH2 | CH3| CH4 | QMA | MAT | MA2 | MA3 | MA4 | MAS |
RE1|RE2 | RE3 | RE4

CH1| CH2 | CH3 | CH4
Signal channels 1 to 4.
The number of channels depends on the instrument type.

QMA
Quick math channel.

MA1 | MA2 | MA3 | MA4 | MA5
Math channels 1 to b.

RE1 | RE2 | RE3 | RE4
Reference channels 1 to 4.

*RST: CH1

SEARch:CONDition <Search_Condition>
Set the condition for the search function

Parameters:
<Search_Condition>

EDGE | WIDTh | PEAK | RUNT | RTIMe | DATatoclock | PATTern |
PROTocol

EDGE
An edge search result is found when the waveform passes the
given level in the specified direction.

WIDTh

A width search finds pulses with an exact pulse width, or pulses
shorter or longer than a given time, or pulses inside or outside the
allowable time range.

PEAK
The peak search finds pulses exceeding a given amplitude.

RUNT

The runt search finds pulses lower than normal in amplitude. The
amplitude crosses the first threshold twice without crossing the
second one. In addition to the threshold amplitudes, you can
define a time limit for the runt in the same way as for width search:
runts with exact width, shorter or longer than a given time, or runts
inside or outside the allowable time range.
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RTIMe

The rise or fall time search finds slopes with an exact rise or fall
time, or rise/fall times shorter or longer than a given limit, or rise/
fall times inside or outside the allowable time range.

DATatoclock

The Data2Clock search - also known as setup/hold - finds violation of
setup and hold times. It analyzes the relative timing between two
signals: a data signal and the synchronous clock signal. Setup time is
the time that the data signal is steady before clock edge. Hold time is
the time that the data signal is steady after clock edge.

PATTern

The pattern search finds logical combinations of channel states inside
or outside a specified time range. For each channel, its state and
threshold level is defined. The states are combined logically, and the
time of true pattern results is compared with a specified time range.

PROTocol

The protocol search finds various events in decoded data of CAN or LIN
signals, for example, a specified frame type, identifier, data, and errors.
Available search settings depend on the configured bus type

BUS: TYPE.

*RST: EDGE
SEARch:RESult:BCOunt
Returns the maximum number of storable search results.
Return values:
<Buffered_Count> <Numeric_Value>
SEARch:RCOunt

Returns the number of events which meet the search condition.

Return values:
<Result_Count> <Numeric_Value>

*RST: 0
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SEARch:RESult<n>?
Returns the result values of the specified search result.
See also SEARch:RESult:ALL?.

Suffix:
<n> Number of the search result

Return values:
<Result> Comma-separated value list.
Optional value depending on search condition:

EDGE Unused
WIDTh Puls width
PEAK Peak value of the peak
RUNT Width of the runt
RTIMe Risetime

Example: SEARch:RESult3?

Returns the result values of the third search result.
3,-4.1660e-04,0,PEAK,NEGATIVE,-1.530e-02

Usage: Query only

SEARch:RESult:ALL?
Returns a list of the results separated by comma.

Return values:
<All_Result> List of results separeted by comma

For each result, six values are returned:

1. Result number as indicated in the search results table

2. X-position (time) of the search result

3. Y-position of the search result, currently not relevant

4. Type of the search result (Edge, Peak, ...)

5. Slope or polarity of the search result

6. For peak searches, the value contains the peak voltage. For width
searches, it contains the pulse width. For edge searches, the value is
not relevant.

Example: SEARch:RESult:ALL?
Returns all four results of a peak search:
1,-4.7750e-04,0,PEAK,NEGATIVE,-1.530e-02,
2,-4.4630e-04,0,PEAK,NEGATIVE,-1.530e-02,
3,-4.1660e-04,0,PEAK,NEGATIVE,-1.530e-02,
4,-3.8690e-04,0,PEAK,NEGATIVE,-1.530e-02

Usage: Query only
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SEARch:RESDiagram:SHOW <Result_Show>
Enable or disable list view of search results on the display.

Parameters:
<Result_Show> ON | OFF

*RST: OFF

EXPort:SEARch:NAME <FileName>

Defines the path and filename for search results that will be saved with EXPort: SEARch:SAVE.
The file format is CSV, the file name is incremented automatically. You can change the storage
location and the file name manually in the SEARCH menu. Remote control uses the recent set-

tings.

Parameters:

<FileName> String parameter
Example: STOP

EXP:SEAR:NAME ,/USB_FRONT/RESULT.CSV*
EXP:SEAR:SAV
The search result is saved to RESULT.CSV.

EXPort:SEARch:SAVE
Saves the search results and starts the export to USB drive. Saving search results is only possi-
ble in STOP mode.

Usage: Setting only

2.6.2 Peak
SEARCh:MEASuUre:PEAK:POLArity <POIAITY>  ..vvviiiiiiiiiiiiiiiiiiiieieviieieverevevereveseverereseseseseresennnnnes 104
SEARch:MEASure:LEVEL:PEAK:MAGNitude <Magnitude>  ......ccccooviiiiiiiiiiiiiiiiiiieeee e 104

SEARch:MEASure:PEAK:POLarity <Polarity>
Set the polarity of the peak

Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS

SEARch:MEASure:LEVEL:PEAK:MAGNitude <Magnitude>
Set the magnitude of the peak

Parameters:
<Magnitude> Default unit: V
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2.6.3 Edge
SEARch:TRIGger:EDGE:SLOPE <SIOPEe>  ..oviiiiiiiiiiiie e 105
SEARch:TRIGger:EDGE:LEVel <Level> e 105
SEARch:TRIGger:EDGE:LEVel:DELTa <Delta_Level> ..o, 105

SEARch:TRIGger:EDGE:SLOPe <Slope>
Set the slope of the edge.

Parameters:
<Slope> POSitive | NEGative | EITHer

*RST: POS

SEARch:TRIGger:EDGE:LEVel <Level>
Sets the voltage level for the edge search.

Parameters:
<Level> <Numeric_Value>

*RST: b0OE-3 = 500mV

SEARch:TRIGger:EDGE:LEVel:DELTa <Delta_Level>
Sets a hysteresis range above and below the search level to avoid unwanted search results
caused by noise oscillation around the level.

Parameters:
<Delta_Level> Range: Lower limit depends on vertical scale and other settings, no

upper limit

*RST: 200E-3 = 200mV
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2.6.4 Width
SEARch:TRIGger:WIDTh:POLarity <Polarity> ... 106
SEARch:TRIGger:WIDTh:LEVel <LeVel> ..o 106
SEARch:TRIGger:WIDTh:LEVel:DELTa <Delta_Level> ......cccccooiiiiiiiiiiiieece e, 106
SEARch:TRIGgerWIDTh:WIDTh <Width> ..o 106
SEARch:TRIGger:WIDTh:DELTa <Delta_Width> .. ..o 107
SEARch:TRIGger:WIDTh:RANGe <RaNge> ..o 107

SEARch:TRIGger:WIDTh:POLarity <Polarity>
Set the polarity of the pulse.

Parameters:
<Polarity> POSitive | NEGative

*RST: POS

SEARch:TRIGger:WIDTh:LEVel <Level>
Set the level of the pulse.

Parameters:
<Level> <Numeric_Value>

*RST: 500E-6

SEARch:TRIGger:WIDTh:LEVel:DELTa <Delta_Level>
Set the hysteresis of the level of the pulse.

Parameters:
<Delta_Level> Range:Lower limit depends on vertical scale and other settings, no

upper limit.

*RST: 200E-6

SEARch:TRIGger:WIDTh:WIDTh <Width>
Set the width of the pulse.

Parameters:
<Width> Default unit: s
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SEARch:TRIGger:WIDTh:DELTa <Delta_Width>
Sets a range At to the reference pulse width set with ,,SEARch:TRIGger:WIDTh:WIDTh”
if SEARch:TRIGger:WIDTh:RANGe is set to WITHin or OUTSide

Parameters:
<Delta_Width> Range: Lower limit depends on the resolution, practically no upper limit

SEARch:TRIGger:WIDTh:RANGe <Range>
Set the comparision of the width of the pulse.

Parameters:
<Range> WITHin | OUTSide | SHORter | LONGer

WITHin

Finds pulses inside the range width + At.

OUTSide

Finds pulses outside the range width + At.

SHORter

Finds pulses shorter than the given width.

LONGer

Finds pulses longer than the given width.

*RST: WITH

2.6.5 Runt

SEARch:TRIGger:RUNT:POLarity <POIarity> ... 107
SEARch:TRIGger:RUNT:WIDTh <WIidth> ..o, 108
SEARch:TRIGger:RUNT:DELTa <Delta_Width> ..o, 108
SEARch:TRIGger:RUNT:RANGE <RANGE> ..oviiiiiiiiiiiii et 108
SEARch:TRIGger:LEVel:RUNT:LOWer <Lower_Level> ... 108
SEARch:TRIGger:LEVel:RUNT:UPPer <UpperLevel> ..o 109

SEARch:TRIGger:RUNT:POLarity <Polarity>
Set the polarity of the Runt

Parameters:
<Polarity> POSitive | NEGative | EITHer

*RST: POS
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SEARch:TRIGger:RUNT:WIDTh <Width>
Sets the reference runt pulse width, the nominal value for comparisons.

Parameters:
<Width> Range: Depends on various settings, mainly time base and sample rate.

*RST: 200E-6

SEARch:TRIGger:RUNT:DELTa <Delta_Width>
Sets a range At to the reference pulse width set with ,,SEARch:TRIGger:RUNT:WIDTh"
if SEARch:TRIGger:RUNT:RANGe is set to WITHin or OUTSide.

Parameters:
<Delta_Width> Range: Depends on various settings, mainly time base and sample rate.

*RST: bOE-6

SEARch:TRIGger:RUNT:RANGe <Range>

Sets how the measured pulse width is compared with the given limit(s).
To set the width, use SEARch:TRIGger:RUNT:WIDTh .

To set the range + At, use SEARch:TRIGger:RUNT:DELTa .

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds pulses longer than the given width.

SHORter
Finds pulses shorter than the given width.

WITHin
Finds pulses inside the range width + At.

OUTSide
Finds pulses outside the range width + At.

*RST: LONG

SEARch:TRIGger:LEVel:RUNT:LOWer <Lower_Level>
Sets the lower voltage threshold for runt detection. A positive runt crosses the lower level twice
without crossing the upper level.

Parameters:
<Lower_Level> Default unit: V

*RST: 400E-3
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SEARch:TRIGger:LEVel:RUNT:UPPer <UpperLevel>
Sets the upper voltage threshold for runt detection. A negative runt crosses the upper level twice
without crossing the lower level.

Parameters:
<UpperLevel> Default unit: V
*RST: 600E-3
2.6.6 Rise/ Fall time

SEARch:TRIGger:RISetime:TIME <TIMe> oo, 109
SEARch:TRIGger:RISetime:DELTa <Delta_Time>  .ooiiiiiiiiiiiiee e 109
SEARch:TRIGger:RISetime:SLOPe <Polarity> . ..o 109
SEARch:TRIGger:RISetime:RANGe <RaNge> ... 110
SEARch:TRIGger:LEVel:RISetime:LOWer <Lower_Level> ... 110
SEARch:TRIGger:LEVel:RISetime:UPPer <Upper_Level> ... 110

SEARch:TRIGger:RISetime:TIME <Time>
Sets the reference rise or fall time, the nominal value for comparisons.

Parameters:
<Time> Range: Depends on various settings, mainly time base and sample rate.
Default unit: s

*RST: 200E-6

SEARch:TRIGger:RISetime:DELTa <Delta_Time>

Sets a range At to the reference rise/fall time set with SEARch:TRIGger:RISetime:TIME ,

if SEARch:TRIGger:RISetime:RANGe is set to Within or Outside. The instrument finds rise/fall
times inside or outside the range time + At.

Parameters:
<Delta_Time> Range: Depends on various settings, mainly time base and sample rate.
Default unit: s

*RST: 50E-6

SEARch:TRIGger:RISetime:SLOPe <Polarity>
Set the polarity for the Rise/fall time.

Parameters:

<Polarity> POSitive | NEGative | EITHer
POSitive Search for rise time
NEGative Search for fall time
EITHer Search for rise and fall time
*RST: POS
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SEARch:TRIGger:RISetime:RANGe <Range>

Sets how the measured rise or fall time is compared with the given limit(s).
To set the rise/fall time, use SEARch:TRIGger:RISetime:TIME .

To set the range = At, use SEARch:TRIGger:RISetime:DELTa .

Parameters:
<Range> LONGer | SHORter | WITHin | OUTSide

LONGer
Finds rise/fall times longer than the given time.

SHORter
Finds rise/fall times shorter than the given time.

WITHin
Finds rise/fall times inside the range time + At.

OUTSide
Finds rise/fall times outside the range time + At.

*RST: LONG

SEARch:TRIGger:LEVel:RISetime:LOWer <Lower_Level>
Sets the lower voltage threshold. When the signal crosses this level, the rise time measurement
starts or stops depending on the selected slope.

Parameters:
<Lower_Level> Default unit: V

*RST: 400E-3
SEARch:TRIGger:LEVel:RISetime:UPPer <Upper_Level>
Sets the upper voltage threshold. When the signal crosses this level, the rise/fall time measure-

ment starts or stops depending on the selected slope.

Parameters:
<Upper_Level> Default unit: V

*RST: 600E-3
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2.6.7 Data to clock / Setup & Hold

SEARch:TRIGger:DATatoclock:CEDGe <Clock_Edge> ... 111
SEARch:TRIGger:DATatoclock:CLEVel <Clock_Level> ... 111
SEARch:TRIGger:DATatoclock:DLEVel <Data_Level>  .......viiiiiiiiiiiiiiiiiiiiiiiiiiiiias 111
SEARch:TRIGger:DATatoclock:CLEVel:DELTa <lLevel_Delta> ......cccccvvueeeeeeeieiiieiiiiiiiiiieiiiiiiiens 111
SEARch:TRIGger:DATatoclock:DLEVel:DELTa <Level_Delta> ......ccccooviviiiiiiiiiiiieeeee 111
SEARch:TRIGger:DATatoclock:CSOurce <Clock_SOUrce> ....cciviiiiiiiiiiiiiiiieeececciiiieeeee e 112
SEARch:TRIGger:DATatoclock:HTIMe <HOId_TIime>  ...cciiiiiiiiiieieeeeeee e 112
SEARch:TRIGger:DATatoclock:STIMe <Setup_TiMe>  .....coiiiiiiiiiiieieiecieeeee e 112

SEARch:TRIGger:DATatoclock:CEDGe <Clock_Edge>
Sets the edge of the clock signal to define the time reference point for the setup and hold time.

Parameters:
<Clock_Edge> POSitive | NEGative | EITHer

*RST: POS

SEARch:TRIGger:DATatoclock:CLEVel <Clock_Level>
Sets the voltage level for the clock signal. Clock level and clock edge define the reference point
for setup and hold time.

Parameters:
<Clock_Level> Range: depends on vertical scale

SEARch:TRIGger:DATatoclock:DLEVel <Data_Level>
Sets the voltage level for the data signal. The data lavel defines the point of data transition.

Parameters:
<Data_Level> Range: depends on vertical scale

SEARch:TRIGger:DATatoclock:CLEVel:DELTa <Level_Delta>
SEARch:TRIGger:DATatoclock:DLEVel:DELTa <Level_Delta>

Set a hysteresis range to the clock and data levels in order to avoid unwanted search results
caused by noise oscillation around the level. For a rising edge, the hysteresis is below the search
level. Otherwise, for a falling edge the hysteresis is above the level.

Parameters:
<Level_Delta> Range: Lower limit depends on vertical scale and other settings,
no upper limit
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SEARch:TRIGger:DATatoclock:CSOurce <Clock_Source>
Selects the input channel of the clock signal.

Parameters:

<Clock_Source> CH1 | CH2 | CH3 | CH4 | MAT | MA2 | MA3 | MA4 | MAS |
RE1 | RE2 | RE3 | RE4
The number of channels depends on the instrument type.

*RST: CH1

SEARch:TRIGger:DATatoclock:HTIMe <Hold_Time>

Sets the minimum time after the clock edge while the data signal must stay steady above or
below the data level. The hold time can be negative. In this case, the hold time ends before the
clock edge, and the setup time must be positive and longer than the absolute value of the hold
time.

Parameters:
<Hold_Time> Range: depends on time base and sample interval

SEARch:TRIGger:DATatoclock:STIMe <Setup_Time>

Sets the minimum time before the clock edge while the data signal must stay steady above or
below the data level. The setup time can be negative. In this case, the setup interval starts after
the clock edge, and the hold time must be positive and longer than the absolute value of the
setup time.

Parameters:
<Setup_Time> Range: depends on time base and sample interval

2.6.8 Pattern

SEARch:TRIGger:PATTern:LEVel<n> <Threshold_Level> ......cccccccoiiiiiiiiiiiee 112
SEARch:TRIGger:PATTern:LEVel<n>:DELTa <Level_Delta> ........cccccovviiiiiiiiiiiiiiiiiiceeeee 113
SEARch:TRIGger:PATTern:WIDTh[:WIDTh] <Width> ..o, 113
SEARch:TRIGger:PATTern:WIDTh:DELTa <Delta_Time> . ...cciiiiiiiiieiiiiiiiieieeeee e 113
SEARch:TRIGger:PATTern:WIDTh:RANGE <RaNge> ..ot 113
SEARch:TRIGger:PATTern:FUNCtION <FUNCHION>  .....iiiiiiiiiiiiiiiiiiiiiiiiiiieieeeveeeeeveveeeesieees 114
SEARcCh:TRIGger:PATTern:SOURCE <PatterN> ...t 114

SEARch:TRIGger:PATTern:LEVel<n> <Threshold_Level>
Sets the threshold value for each specified source channel. You can set different levels for the
channels

Suffix:

<n> 1.4
Selects the input channel. The number of channels depends on the
instrument type.

SCPI Programmers Manual 112



SCPI Commands HMO3000 series Remote Control

Command Reference

Parameters:
<Threshold_Level> Range: Depends on vertical scale

*RST: 5.0000E-01

SEARch:TRIGger:PATTern:LEVel<n>:DELTa <Level_Delta>

Sets a hysteresis range to the level of the specified source channel in order to avoid unwanted
search results caused by noise oscillation around the level. For a rising edge, the hysteresis is
below the search level. Otherwise, for a falling edge the hysteresis is above the level.

Suffix:

<n> 1.4
Selects the input channel. The number of channels depends on the
instrument type.

Parameters:

<Level_Delta> Range: Lower limit depends on vertical scale and other settings,

no upper limit

*RST: 2.0000E-01

SEARch:TRIGger:PATTern:WIDTh[:WIDTh] <Width>
Sets the reference time of a steady pattern, the nominal value for comparisons.

Parameters:
<Width> Default unit: s

SEARch:TRIGger:PATTern:WIDTh:DELTa <Delta_Time>
Sets a range At to the reference pattern duration set with SEARch:TRIGger:PATTern:WIDTh if
SEARch:TRIGger:PATTern:WIDTh:RANGe is set to WITHin or OUTSide.

Parameters:
<Delta_Time> Default unit: s

SEARch:TRIGger:PATTern:WIDTh:RANGe <Range>

Sets the condition how the duration of a steady pattern is compared with the given reference
time. To set the reference value width, use SEARch:TRIGger:PATTern:WIDTh[:WIDTh]. To set a
range At, use SEARch:TRIGger:PATTern:WIDTh:DELTa.

Parameters:
<Range> WITHin | OUTSide | LONGer | SHORter

WITHin
Finds patterns steady for a time range width + At.

OUTSide
Finds patterns outside a time range width + At.
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LONGer
Finds patterns steady for at least the given width.

SHORter
Finds patterns shorter than the given width.

*RST: LONG

SEARch:TRIGger:PATTern:FUNCtion <Function>
Sets the logical combination of the channel states.

Parameters:
<Function> AND | OR | NAND | NOR
AND
The required states of all channels must appear in the input signal at the
same time.
OR

At least one of the channels must have the required state.

NAND

.Not and” operator, at least one of the channels does not have the
required state.

NOR
.Not or” operator, none of the channels has the required state.

*RST: AND

SEARch:TRIGger:PATTern:SOURce <Pattern>
Specifies the search pattern - the state for each channel.

Parameters:
<Pattern> String parameter

String containing 0, 1, X for each channel.

The order of channels is fixed: CH1 CH2 CH3 CH4.

The number of channels depends on the instrument type.
Example: SEAR:TRIG:PATT:SOUR ,1X10’

CH1, CH3 are high, CH4 is low. These states are logically combined
with SEARch:TRIGger:PATTern:FUNCtion. CH2 does not matter (don't
care).
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2.7 Quickmath, Mathematics and Reference Waveforms

2.71

(O 1UTTe] a0 =14 n IR 115
Y21 a 1T 0 = (ot PSP 119
ReferenCe VNVaveiOrmNS . 126
Quickmath

This chapter describes commands that configure or perform basic math functions using Quick-
math.

CALCuUlate:QMATNISTATE <STATE>  woeiiiiiii e 115
CALCulate:QMATN:SOURGCE SIMN> oottt et e e e e et e e e e e e eeenees 115
CALCulate:QMATh:OPERation <OPeration>  .......coiiiiiiieiiee et 116
CALCulate:QMATN:SCALE <SCAIE>  ooiiiiiiiiiee e 116
CALCulate:OMATh:POSItion <POSITIONS  ooiiiiiiiie e, 116
CALCUIAtE: QM AT N D AT A ? e, 116
CALCulate:QMAThIDATAIHEADEI? oo 117
CALCulate:QMATh:DATAIXINCIEMENT? .o 117
CALCulate:QMATH:DATAXORIGIN? et 117
CALCulate:OMATh:DATAYINCIEMENT? oo 17
CALCulate:OMATh:DATANYORIGIN? oo, 118
CALCulate:OMATh:DATA:YRESOIUION? oo, 118

CALCulate:QMATh:STATe <State>

Defines whether the Quickmath waveform is active or not. Only if a channel is active it is visible
on the screen and can be selected as a source for analysis and display functions. Quickmath is
only available in YT and Zoom mode.

Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:QMATh:SOURce <m>
Defines the source of the Quickmath waveform.

Parameters:
<m> 1.2
Selects the source.
<Source> CH1 | CH2 | CH3 | CH4
The number of channels depends on the instrument type.
Example: CALC:QMAT:SOUR1 CH2

*RST: 1
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CALCulate:QMATh:OPERation <Operation>
Defines the operation of the Quickmath waveform.

Parameters:

<Qperation> ADD | SUB | MUL | DIV
ADD  Addition
SUB Subtraction
MUL  Multiplication
DIV Division

Example: CALC:QMAT:OPER ADD

CALC:QMAT:OPER SUB
CALC:QMAT.OPER MUL
CALC:QMAT:OPER DIV

*RST: ADD
CALCulate:QMATh:SCALe <Scale>
Sets the vertical scale for the Quickmath waveform.
Parameters:
<Scale> Range: -1.0E-24 to 5.0E+25
Scale value, given in Volts per division.
*RST: 1
CALCulate:QMATh:POSition <Position>

Sets the vertical position of the Quickmath waveform in the window.

Parameters:
<Position> Position value, given in divisions.

*RST: 0
CALCulate:QMATh:DATA?
Returns the data of the Quickmath waveform. To set the export format, use FORMat[:DATA].

Return values:
<Data> List of values according to the format settings.

Usage: Query only
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CALCulate:QMATh:DATA:HEADer?
Returns information on the Quickmath waveform.

Position Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in s 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1

Table 2.3: Header data

Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

CALCulate:QMATh:DATA:XINCrement?
Return the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion if binary data format is defined (FORM UINT, 8| 16).

Return values:
<Xincrement> Time ins

Usage: Query only
CALCulate:QMATh:DATA:XORigin?
Return time of the first sample depending to trigger event (time=0). The commands are relevant

for data conversion if binary data format is defined (FORM UINT, 8 | 16).

Return values:
<Xorigin> Timeins

Usage: Query only
CALCulate:QMATh:DATA:YINCrement?
Return the voltage value per bit of the indicated waveform. The commands are relevant for data

conversion, if binary data format is defined (FORM UINT, 8| 16).

Return values:
<Yincrement> Voltage in V

Usage: Query only
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CALCulate:QMATh:DATA:YORIigin?
Return the voltage value for binary value 0 of the indicated waveform. The commands are rele-
vant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Return values:
<Yorigin> Voltage in V

Usage: Query only

CALCulate:QMATh:DATA:YRESolution?
Return the vertical bit resolution of the indicated waveform. The commands are relevant for data
conversion, if binary data format is defined (FORM UINT, 8 | 16).

Return values:
<Yresolution> For default waveforms, the resolution is 16 bit.

Usage: Query only
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2.7.2 Mathematics

CALCulate:MATH<M>:STATE <STATE>  .oiiiiiiiiieiiie ettt 119
CALCulate:MATH<M>:SCALE <SCalE> i 119
CALCulate:MATH<mM>:POSItion <POSItION> ..ot 120
CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplEXpr> . ...ccooiiiiiiiiiiieeeee 120
CALCUIate:MATH<M > IDATA? oo 121
CALCulate:MATH<mM>:DATAIHEADEI? oottt 121
CALCulate:MATH<mM>:LABEl <Label> ..o, 121
CALCulate:MATH<mM>:LABEL:STATE <StAte>  1oiiiiiiiiiiee ettt 122
CALCulate:MATH<mM>:DATAIENVEIOPE?  ..eeeeiieiiee e 122
CALCulate:MATH<m>:DATA:ENVelope:HEADEI? ... 122
CALCulate:MATH<m>:DATA:ENVelope: XINCrement? ..o 123
CALCulate:MATH<m>:DATA:ENVelope: XORIGIN? .. o, 123
CALCulate:MATH<mM>:DATA:ENVelope:YINCrement? ......ooooviiiiiieiiiiiiiiieee e 123
CALCulate:MATH<m>:DATA:ENVelope:YORIGIN? .. o, 124
CALCulate:MATH<m>:DATA:ENVelope:YRESOIUtION? ..ot 124
CALCulate:MATH<mM>:DATAXINCIrEMENT? ..o 124
CALCulate:MATH<mM>:DATAXORIGIN?  1oiiiiiiiie ettt 125
CALCulate:MATH<mM>:DATAIYINCIEMENT?  ..oeiiiiieiiieeiieieeeeeeeeeeeeeeeeeeeaeeaaeeaeaseeaneaaeeeensnnes 125
CALCulate:MATH<M>:DATAYORIGIN? ottt 125
CALCulate:MATH<mM>:DATAYRESOIUTION? oottt 126

CALCulate:MATH<m>:STATe <State>
Defines whether the selected mathematical channel is active or not. Only if a channel is active it
is visible on the screen and can be selected as a source for analysis and display functions.

Suffix:
<m> 1.5
Selects the math waveform.
Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:SCALe <Scale>
Sets the vertical scale for the specified math waveform.

Suffix:
<m> 1.5
Selects the math waveform.
Parameters:
<Scale> Range: -1.0E-24 to 5.0E+25

Scale value, given in Volts per division.

*RST: 1
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CALCulate:MATH<m>:POSition <Position>
Sets the vertical position of the specified math waveform in the window.

Suffix:
<m> 1..5
Selects the math waveform.
Parameters:
<Position> Position value, given in divisions.

*RST: 0

CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplExpr>
Defines the equation to be calculated for the selected math channel as a regular expression.

Suffix:
<m> 1..5

Selects the math waveform.
Parameters:

<RemComplExpr> String with regular expression

Example: Multiplication CALC:MATH1:EXPR:DEF “MUL(CH1,CH2)"

Integral CALC:MATH2:EXPR:DEF “INT(MA1)"
IR low pass CALC:MATH3:EXPR:DEF “IIRL(MAZ2,1E6)"
The mathematical expression is a string parameter, consisting of a
keyword which represents the math function, followed by the
respective sources. These may be separated by comma and written in
brackets. A query of the math function always returns the string, which
is listed under string expression.

Function ExpressionString Comment

Addition “ADD(CH1,CH2)" Alternative “CH1+CH2"

Subtraction “SUB(CH1,CH2)" Alternative “CH1-CH2"

Multiplication “MUL(CH1,CH2)” Alternative “CH1*CH2"

Division “DIV(CH1,CH2)" Alternative “CH1/CH2"

Max. amplitude “MAX(CH1,CH2)"

Min. amplitude “MIN(CH1,CH2)”

Square “SQR(CH1)"

Square root “SQRT(CH1)”

Absolute value "ABS(CH1)"

Positive wave “"POS(CH1)"

Negative wave “NEG(CH1)"

Reciprocal 1/x “REC(CHT)”

Inverse “INV(CH1)"

Common logarithm “"LOG(CH1)"”

Natural logarithm “LN(CH1)”
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Function ExpressionString Comment

Derivative “"DERI(CHT)”

Integral “INT(CH1)"
CH1 - Source

IIR low pass “lIRL(CH1,1EB)" 1e6 — Constant, limit fre-
quency of the low pass
CH1 - Source

IIR high pass “lIRH(CH1,1EB)" 1e6 — Constant, limit fre-
quency of the high pass
FFT function of the source

FFT "FFTMAG(CH1)"
waveform

Table 2.4: Math expression

CALCulate:MATH<m>:DATA?
Returns the data of the math waveform. To set the export format, use FORMat[:DATA].

Suffix:
<m> 1.5

Selects the math waveform.

Return values:
<Data> List of values depending on defined data format.

Usage: Query only

CALCulate:MATH<m>:DATA:HEADer?
Returns information on the math waveform.

Position Meaning Example

1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in's 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000

4 Number of values per sample interval, usually 1. 1

Table 2.5: Header data
Suffix:
<m> 1.5

Selects the math waveform.

Return values:

<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only

CALCulate:MATH<m>:LABel <Label>
Sets the label for the Math waveform.
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Suffix:
<m> 1.5

Selects the math waveform.
Parameters:
<lLabel> String value

“xxxxxxxx” (maximum 8 characters)
Example: . Power”

CH1=Voltage
CH2=Current
CH1*CH2=POWER

CALCulate:MATH<m>:LABel:STATe <State>
Switches the label of the math channel on or off.

Suffix:
<m> 1..5
Selects the math waveform.
Parameters:
<State> ON | OFF

*RST: OFF

CALCulate:MATH<m>:DATA:ENVelope?
Returns the math data of the envelope.

Suffix:

<m> 1..5
Selects the math waveform.

Return values:
<Data> List of values

Usage: Query only
CALCulate:MATH<m>:DATA:ENVelope:HEADer?
Returns information of the math data envelope.
Suffix:

<m> 1.6

Selects the math waveform.

Return values:
<Header> String data

Usage: Query only

e
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CALCulate:MATH<m>:DATA:ENVelope:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform of the

envelope. The commands are relevant for data conversion, if binary data format is defined
(FORM UINT, 8 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Xincrement> <Numeric Value>

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:XORigin?
Returns the time of the first sample of the indicated waveform of the envelope. The commands
are relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Xorigin> <Numeric_Value>

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:YINCrement?

Returns the voltage value per bit of the indicated waveform of the envelope. The commands are
relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1.5

Selects the math waveform.

Return values:
<Yincrement> <Numeric_Value>

Usage: Query only
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CALCulate:MATH<m>:DATA:ENVelope:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform of the envelope. The com-
mands are relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Yorigin> <Numeric_Value>

Usage: Query only

CALCulate:MATH<m>:DATA:ENVelope:YRESolution?
Returns the vertical bit resolution of the indicated waveform of the envelope. The commands are
relevant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Yresolution> <Numeric_Value>

Usage: Query only

CALCulate:MATH<m>:DATA:XINCrement?

Returns the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion if binary data format is defined (FORM UINT, 8| 16).
Suffix:

<m> 1..5

Selects the math waveform.

Return values:
<Xincrement> Time in's

Usage: Query only

e
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CALCulate:MATH<m>:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The commands are relevant for
data conversion if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<m> 1.5
Selects the math waveform.

Return values:
<Xorigin> Timeins

Usage: Query only

CALCulate:MATH<m>:DATA:YINCrement?
Returns the voltage value per bit of the indicated waveform. The commands are relevant for data
conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1..5
Selects the math waveform.

Return values:
<Yincrement> Voltage in V

Usage: Query only

CALCulate:MATH<m>:DATA:YORigin?

Returns the voltage value for binary value 0 of the indicated waveform. The commands are rele-
vant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1.5

Selects the math waveform.

Return values:
<Yorigin> Voltage in V

Usage: Query only
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CALCulate:MATH<m>:DATA:YRESolution?
Returns the vertical bit resolution of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.5

Selects the math waveform.

Return values:
<Yresolution> For default waveforms, the resolution is 16 bit.

Usage: Query only

Reference Waveforms
REFCUINVE<IMSISTATE oo 126
REFCUrve<m>:SOURCE <SOUICES oo 127
REFCurve<m>:SOURCE:CATAIOG?  ..eeeiie it 127
REFCUNVE<M>IUPDAIE  .iiiiiiiiiiiiie ettt e et e e e e e taaaaea s 128
REFCurve<m>:SAVE <File_NamMe> ... 128
REFCurve<m>:LOAD <File_NaAmME> ...t 128
REFCUNVE <M= LOADISTATE ottt 129
REFCurve<m>:HORIizontal:SCALE <SCale> ... 129
REFCurve<m>:HORIizontal:POSition <POSItION>  ......coiiiiiiiiiceee e 129
REFCurve<m>:VERTICal:SCALE <SCalIE>  ....oiiiiiiiiiie e 129
REFCurve<m>:VERTical:POSItion <POSItION>  .ioivviiiiiiiiicieiee et 130
REFCUNVE S DATA? et e et e et 130
REFCUrve<m>:DATAIHEADEI? ..o e 130
REFCurve<m>:DATAXINCIEMENT? oot 131
REFCurve<m>:DATAXORIGIN? oo 131
REFCurve<m>:DATAYINCIEMENT? it 131
REFCUrve<m > DATANYORIGIN? oo 132
REFCurve<m>:DATAINYRESOIUTION?  .oeeiiiiee et 132
REFCurve<m>:STATe
Displays or hides the selected reference waveform.
Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.
Parameters:
<State> ON | OFF

*RST: OFF
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REFCurve<m>:SOURce <Source>
Defines the source of the reference waveform.

Suffix:

<m>

Parameters:
<Source>

1.4
Selects the reference waveform, the internal reference storage.

CH1|CH2 | CH3| CH4 | POD1 | POD2 | QMA | MAT | MA2 | MA3 |
MA4 | MA5 | RE1 | RE2 | RE3 | RE4

CH1| CH2 | CH3 | CH4

Signal channels 1 to 4.

The number of channels depends on the instrument type.
POD1 | POD2

Logic POD.

QVA
Quick math channel.

MA1 | MA2 | MA3 | MA4 | MAS
Math channels 1 to b.

RE1 | RE2 | RE3 | RE4
Reference channels 1 to 4.

Any active channel, math or reference waveform.

*RST: CH1

REFCurve<m>:SOURce:CATalog?
Returns a list of waveforms that can be used as reference source. Only available waveforms can

be used.

Suffix:

<m>

Return values:
<Catalog>

1.4
Selects the reference waveform, the internal reference storage.

CH1| CH2 | CH3 | CH4 | POD1 | POD2 | QMA | MAT | MA2 | MA3 |
MA4 | MAS | RE1 | RE2 | RE3 | RE4

CH1| CH2 | CH3 | CH4
Signal channels 1 to 4.
The number of channels depends on the instrument type.

POD1 | POD2
Logic POD.
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QMA
Quick math channel.

MA1 | MA2 | MA3 | MA4 | MA5
Math channels 1 to b.

RE1 | RE2 | RE3 | RE4
Reference channels 1 to 4.

Any active channel, math or reference waveform.

Usage: Query only

REFCurve<m>:UPDate
Updates the selected reference by the waveform defined with REFCurve<m>:SOURce.

Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.
Usage: Event

REFCurve<m>:SAVE <File_Name>
Stores the reference waveform the specified file.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Setting Parameters:
<File_Name> String with path and file name.

Usage: Setting only

REFCurve<m>:LOAD <File_Name>

Loads the waveform data from the indicated reference file to the reference storage. To load the
instrument settings, use REFCurve<m>:LOAD:STATe.

Suffix:

<m> 1.4

Selects the reference waveform, the internal reference storage.

Setting Parameters:
<File_Name> String with path and file name

Usage: Setting only
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REFCurve<m>:LOAD:STATe

Loads the instrument settings in addition to the reference waveform data. The waveform data
must be loaded before the settings, see REFCurve<m>:LOAD. The settings are only available
if the file was stored to the internal storage /INT/REFERENCE and never written to an external
storage (USB stick).

Suffix:
<m> 1.4

Selects the reference waveform.
Usage: Event

REFCurve<m>:HORizontal:SCALe <Scale>
Changes the horizontal scale (timebase) of the reference waveform independent of the channel
waveform settings.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Scale> Default unit: s/div

*RST: 100E-6

REFCurve<m>:HORizontal:POSition <Position>
Changes the horizontal position of the reference waveform independent of the channel wave-
form settings.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Position> Default unit: s

*RST: 0

REFCurve<m>:VERTical:SCALe <Scale>
Changes the vertical scale of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Scale> Default unit: V/div

*RST: 1
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REFCurve<m>:VERTical:POSition <Position>
Changes the vertical position of the reference waveform.

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Position> Default unit: div

*RST: 0
REFCurve<m>:DATA?
Returns the data of the reference waveform.
Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Data> Comma-separated value list (depending on the defined data format).

Usage: Query only

REFCurve<m>:DATA:HEADer?
Returns information on the reference waveform.

Position Meaning Example
1 XStartin s -9.477E-008 = - 94,77 ns
2 XStop in s 9.477E-008 = 94,77 ns
3 Record length of the waveform in Samples 200000
4 Number of values per sample interval, usually 1. 1

Table 2.6: Header data

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.
Parameters:
<Header> Comma-separated value list
Example: -9.477E-008,9.477E-008,200000, 1
Usage: Query only
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REFCurve<m>:DATA:XINCrement?
Returns the time difference between two adjacent samples of the indicated waveform. The com-
mands are relevant for data conversion if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Xincrement> Time in's

Usage: Query only

REFCurve<m>:DATA:XORigin?
Returns the time of the first sample of the indicated waveform. The commands are relevant for
data conversion if binary data format is defined (FORM UINT, 8| 16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Xorigin> Timeins

Usage: Query only

REFCurve<m>:DATA:YINCrement?

Returns the voltage value per bit of the indicated waveform. The commands are relevant for data
conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:

<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Yincrement> Voltage in V

Usage: Query only

e
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REFCurve<m>:DATA:YORigin?
Returns the voltage value for binary value 0 of the indicated waveform. The commands are rele-
vant for data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.4

Selects the reference waveform, the internal reference storage.

Return values:
<Yorigin> Voltage in V

Usage: Query only

REFCurve<m>:DATA:YRESolution?
Returns the vertical bit resolution of the indicated waveform. The commands are relevant for
data conversion, if binary data format is defined (FORM UINT, 8 | 16).

Suffix:
<m> 1.4
Selects the reference waveform, the internal reference storage.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit. Its resolution is

depending on the source waveform. The maximum is 16 bit.

Usage: Query only
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2.8 FFT
CALCulate:MATH<m>:ARIThmetics <ArthmetiCS> .......cccciiiiiiiiiii e 133
CALCulate:MATH<m>:FFT:AVERage:COUNL ..o 134
CALCulate:MATH<mM>:FFT:MAGNItUude:SCALE ..o 134
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJuSted?  ........evveieiiiiieiiiiiiiiiiiiiiiiiiiens 134
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]: AUTO <SpanRBW_Coupling> ............. 135
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBW_Ratio> .................. 135
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <Resolution_BW> ................. 135
CALCulate:MATH<m>:FFT:CFRequency <Center_Freq> .....ccocociiiiiiiiiiiiiieeeecciee e 135
CALCulate:MATH<M>FFTIFULLSPAN oo 136
CALCulate:MATH<mM>:FFT:SPAN <Freq_Span> ..o 136
CALCulate:MATH<mM>:FFT:START <Start_Freq> oo 136
CALCulate:MATH<mM>:FFT:STOP <StOP_Freq>  oviiiiiiiee e, 136
CALCulate:MATH<mM>:FFT:WINDow:TYPE <WIiNndow_Type> ...cccccovviiiiiiiieeeeieiiiiieeee e 137
CALCulate:MATH<m>:FFT:TIME:RANGe <Window_Width> ..o, 137
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Position> .......cccccciiiiiiiiiiiiiieeeeece 138
CALCulate:MATH<m>:FFT:SRATe? <Sample_Rate> ......ccccoiiiiiiiiiiiiieeeceeeee 138
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Width> ... 138
CALCulate:MATH<m>:FFT:TIME:Range <Window_Position> ........c.ccccoceiiiiiiiiiiiiicccec 138

CALCulate:MATH<m>:ARIThmetics <Arithmetics>
Defines the mode for FFT calculation and display.

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)
Parameters:

<Arithmetics> OFF | ENVelope | AVERage

OFF

The FFT is performed without any additional weighting or postproces-
sing of the acquired data. The new input data is acquired and displayed,
and thus overwrites the previously saved and displayed data.

ENVelope

In addition to the normal spectrum, the maximal oscillations are saved
separately and updated for each new spectrum. The maximum values
are displayed together with the newly acquired values and form an
envelope. This envelope indicates the range of all FFT trace values that
occurred.

AVERage

The average of several spectrums is calculated. The number of
spec-trums used for the averaging is defined using the command
CALCulate:MATH<m=>:ARIThmetics. This mode is useful for noise rejection.

*RST: OFF
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CALCulate:MATH<m>:FFT:AVERage:COUNt
Defines the number of spectrums used for averaging if CALCulate:MATH<m>:ARIThmetics is set

to AVERage.

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)
Parameters:

<AverageCount> Range: 2 to 512

Integer value

*RST: 2
CALCulate:MATH<m>:FFT:MAGNitude:SCALe
Defines the scaling of the y-axis.

Suffix:
<m> 1...4 (the numeric suffix is irrelevant)

Parameters:
<Magnitude_Scale> LINear | DBM | DBV

LINear Linear scaling; displays the RMS value of the voltage.
DBM Logarithmic scaling; related to TmW
DBV Logarithmic scaling; related to 1Veff

Example: CALC:MATH:FFT:MAGN:SCAL DBM

CALC:MATH:SCAL 20
Set the Y-scale of the FFT window to 20 dBm.

*RST: DBM
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJusted?
Returns the effective resolution bandwidth.

Suffix:
<m> 1...4 (the numeric suffix is irrelevant)

Return values:
<AdjResBW> Range: -100E+24 to 100E+24
Default unit: Hz

*RST: 1.221E+3

Usage: Query only
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CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:AUTO <SpanRBW_Coupling>
Couples the frequency span to the RBW.

Suffix:
<m> 1...4 (the numeric suffix is irrelevant)

Parameters:
<SpanRBW_Coupling> ON | OFF

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBW_Ratio>
Defines the ratio resolution bandwidth (Hz) / span (Hz).

Suffix:
<m> 1...4 (the numeric suffix is irrelevant)

Parameters:
<SpanRBW_Ratio> Range: the value is changed in 2”n steps from 2710 to 2715
(1024, 2048,4096,8192,16384, 32768).
*RST: 4096

CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <Resolution_BW>
Defines the resolution bandwidth.

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)
Parameters:

<Resolution_BW> Range: depends on various other settings

Default unit: Hz

CALCulate:MATH<m>:FFT:CFRequency <Center_Freq>
Defines the position of the displayed frequency domain, which is (Center - Span/2) to (Center +
Span/2). The width of the domain is defined using the CALCulate:MATH<m>:FFT:SPAN com-

mand.

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)

Parameters:

<Center_Freq> Range: limited by the first data point (minimum) and last data point

(maximum) of the FFT curve.

Default unit: Hz
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CALCulate:MATH<m>:FFT:FULLspan
Performs FFT calculation for the full frequency span.

Suffix:
<m> 1...4 (the numeric suffix is irrelevant)
Usage: Event

CALCulate:MATH<m>:FFT:SPAN <Freq_Span>

The span is specified in Hertz and defines the width of the displayed frequency range, which is
(Center - Span/2) to (Center + Span/2). The position of the span is defined using the CALCulate:
MATH<m>:FFT:CFRequency command.

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)

Parameters:

<Freqg_Span> Range: depends on various other settings, mainly on time base and

span/RBW ratio.
Default unit: Hz
CALCulate:MATH<m>:FFT:STARt <Start_Freq>

Defines the start frequency of the displayed frequency domain (instead of defining a center
frequency and span).

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)

Parameters:

<Start_Freqg> Range: depends on various other settings, mainly on time base, span/

RBW ratio, and center frequency.
Default unit: Hz
CALCulate:MATH<m>:FFT:STOP <Stop_Freq>

Defines the stop frequency of the displayed frequency domain (instead of defining a center
frequency and span).

Suffix:

<m> 1...4 (the numeric suffix is irrelevant)

Parameters:

<Stop_Freq> Range: depends on various other settings, mainly on time base,

span/RBW ratio, and center frequency.
Default unit: Hz
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CALCulate:MATH<m>:FFT:WINDow:TYPE <Window_Type>
Window functions are multiplied with the input values and thus can improve the FFT display.

Suffix:

<m> 1 (the numeric suffix is irrelevant)

Parameters:

<Window_Type> RECTangular | HAMMing | HANNing | BLACkmanharris

RECTangular

The rectangular window multiplies all points by one. The result is a high
frequency accuracy with thin spectral lines, but also with increased noi-
se. Use this function preferably with pulse response tests where start
and end values are zero.

HAMMing

The Hamming window is bell shaped. Its value is not zero at the bor-
ders of the measuring interval. Thus, the noise level inside the spectrum
is higher than Hanning or Blackman, but smaller than the rectangular
window. The width of the spectral lines is thinner than the other bell-
shaped functions. Use this window to measure amplitudes of a periodi-
cal signal precisely.

HANNing

The Hanning window is bell shaped. Unlike the Hamming windowy, its
value is zero at the borders of the measuring interval. Thus, the noise
level within the spectrum is reduced and the width of the spectral lines
enlarges. Use this window to measure amplitudes of a periodical signal
precisely.

BLACkmanharris

The Blackman window is bell shaped and has the steepest fall in its
wave shape of all other available functions. Its value is zero at both bor-
ders of the measuring interval. In the Blackman window the amplitudes
can be measured very precisely. However, determining the frequency is
more difficult. Use this window to measure amplitudes of a periodical
signal precisely.

*RST: HANN

CALCulate:MATH<m>:FFT:TIME:RANGe <Window_Width>
Defines the width of the time base extract from the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Width> Range: depends on the time base
Default unit: s

e
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CALCulate:MATH<m>:FFT:TIME:POSition <Window_Position>
Defines the position of the time base extract in the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Position> Range: depends on the time base and the width of the FFT time base
Default unit: s

CALCulate:MATH<m>:FFT:SRATe? <Sample_Rate>
Returns the sample rate of data used in an FFT analysis.

Return values:
<Sample_Rate> Default unit: Sa/s

Usage: Query only

CALCulate:MATH<m>:FFT:TIME:POSition <Window_Width>
Defines the position of the time base extract in the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Width> Range: depends on the time base and the width of the FFT time base
Default unit: s

CALCulate:MATH<m>:FFT:-TIME:Range <Window_Position>
Defines the width of the time base extract from the Y(t)-window for which the FFT is calculated.

Parameters:
<Window_Position> Range: depends on the time base
Default unit: s
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2.9 Masks
MASKISTATE <STAE>  ooiiiiiiiiiiii e e e e 139
MASKITEST <TBSE> oot 139
MASK:LOAD <File_NAME> ..o 140
MASK:SAVE <FIle_NAME> ..o 140
MASKISOURGCE SSOUICES oot 140
M ASK I CH C OPY ittt e e e e et e e e e e 140
MASK:YPOSIHION <YPOSIIONS  1oiiiiiiiiiiiiiiiieee e e e 140
MASKIYSCALE <YSCAIE> oottt 141
MASKYWIDth <Yaddition> ..o 141
MASKXWIDth <Xaddition> ..o 141
MASKICOUNT? e 141
MASKIVCOUNT? et 141
Y AN 1 G B AN 1 A SR 142
MASKIDATAIHEADEI? oo e 142
MASK:DATAXINCIEMENT? ittt e e e e et 142
MASKDATAXORIGIN? et 142
MASK:DATAIYINCIEMENT? et 143
MASKDATAIYORIGIN? ettt ettt e et e e e e et e eaeeeaaeeenaeea 143
MASKDATANYRESOIUTION oo 143
MASK:ACTion:SOUNd:EVENt:MODE <Event_Mode> ........ccoiiiiiiiiiiee e 143
MASK:ACTion:PRINt:EVENt:MODE <Event_Mode> .....ccc.ooiiiiiieeceee e 143
MASK:ACTion:PULSe:EVENt:MODE <Event_Mode> . .....cooooiiiiie e 143
MASK:ACTion:SCRSave:EVENt:MODE <Event_Mode> .....cccccccoiiiiiiiiiiiiecicciieeee e 143
MASK:ACTion:WFMSave:EVENt:MODE <Event_ Mode> ... 143
MASK:ACTion:STOP:EVENt:MODE <Event_ Mode> ..o 143
MASK:ACTIoN:STOP:EVENTCOUNL  .oeeiiiiee e 144
MASK:ACTion:SCRSAVE:DESTINGTION  .iiiiiiieiiiiii e e 144
MASK:ACTion:WFMSave:DESTINGION  ..uviiiiiiiiiiiii et 144
MASK:ACTION:YOUT:ENABIE <YOUL>  .ooiiiieiiii e 144
MASKIRESEECOUNIEE oo e e et 144

MASK:STATe <State>
Turns the mask test mode on or off. When turning off, any temporarily stored new masks are
deleted.

Parameters:
<State> ON | OFF

*RST: OFF

MASK:TEST <Test>
Starts, finishes or interrupts a mask test.

Parameters:
<Test> RUN | STOP | PAUSe

*RST: STOP
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MASK:LOAD <File_Name>
Loads a stored mask from the specified file.

Setting Parameters:
<File_Name> String parameter (path and file name)

Usage: Setting only
MASK:SAVE <File_ Name>
Saves the current mask in the specified file.

Setting Parameters:
<File_Name> String parameter (path and file name)

Usage: Setting only
MASK:SOURce <Source>

Defines the channel to be compared with the mask.
Parameters:

<Source> CH1 | CH2 CH3|CH4

The number of channels depends on the instrument type.

*RST: CH1

MASK:CHCopy
Creates a mask from the envelope waveform of the test source set with MASK:SOURce.

Usage: Event

MASK:YPOSition <Yposition>
Moves the mask vertically within the display.

Parameters:

<Yposition> Range: -200 to 200
Mask offset from the vertical center
Default unit: div

*RST: 0
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MASK:YSCALe <Yscale>
Changes the vertical scaling to stretch or compress the mask in y-direction.

Parameters:

<Yscale> A value over 100% stretches the amplitudes; a value less than 100%
compresses the amplitudes.
Range: 10 to 1000
Default unit: %

*RST: 100

MASK:YWIDth <Yaddition>
Changes the width of the mask in vertical direction.

Parameters:

<Yaddition> The value is added to the y-values of the upper mask limit and sub-
tracted from the y-values of the lower mask limit.
Range: 0 t0 5.12
Default unit: div

*RST: 0

MASK:XWIDth <Xaddition>
Changes the width of the mask in horizontal direction.

Parameters:

<Xaddition> The value is added to the positive x-values and subtracted from the
negative x-values of the mask limits in relation to the mask center.
Range: 0 to 10
Default unit: div

*RST: 0
MASK:COUNt?
Returns the number of tested acquisitions.

Return values:

<Total_Count> Total number of tested acquisitions
Usage: Query only
MASK:VCOunt?

Returns the number of acquistions that hit the mask.

Return values:
<Violation_Count> Number of violated acquisitions

Usage: Query only
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MASK:DATA?

Returns the data of the mask waveform.

Return values:
<Data> List of values

Usage: Query only

MASK:DATA:HEADer?

Returns information on the mask waveform.

Return values:

<Data_Header> Comma-separated value list
Position | Meaning Example

1 XStartin's 0.000E+00
XStop in's 5.990E+02

3 Number of Samples 600
Number of values per sample interval. 2

4 .
For envelope waveforms the value is 2.

Table 2.7: Header data

Example: 0.000E+00,5.990E+02,600,2

Usage: Query only

MASK:DATA:XINCrement?

Return the time difference between two adjacent samples of the mask waveform.

Return values:
<Xincrement> Timeins

Usage: Query only
MASK:DATA:XORigin?
Return the time of the first sample of the indicated mask waveform.

Return values:
<Xorigin> Timeins

Usage: Query only

SCPI Programmers Manual 142



SCPI Commands HMO3000 series Remote Control

Command Reference

MASK:DATA:YINCrement?
Return the voltage value per bit of the indicated mask waveform.

Return values:
<Yincrement> Voltage in V

Usage: Query only

MASK:DATA:YORigin?
Return the voltage value for binary value 0 of the indicated mask waveform.

Return values:
<Yorigin> Voltage in V

Usage: Query only

MASK:DATA:YRESolution
Return the vertical bit resolution of the indicated waveform.

Return values:
<Yresolution> For default waveforms, the resolution is 8 bit.

Usage: Query only

MASK:ACTion:SOUNd:EVENt:MODE <Event_Mode>
MASK:ACTion:STOP:EVENt:MODE <Event_Mode>
MASK:ACTion:PULSe:EVENt:MODE <Event_Mode>
MASK:ACTion:SCRSave:EVENt:MODE <Event_Mode>
MASK:ACTion:PRINt:EVENt:MODE <Event_Mode>
MASK:ACTion:WFMSave:EVENt:MODE <Event_Mode>
Defines when and how often the action will be executed.

e SOUNd: Generates a beep sound.

e STOP: Stops the waveform acquisition.

e PULSe: Emits an impulse.

e PRINt: Prints a screenshot to a printer connected to the USB connector on the front
or rear panel.

e SCRSave: Saves a screenshot according to printer output settings.

e WFMSave: Saves the waveform data according to the screenshot output settings.

Parameters:
<Event_Mode> OFF | EACH

OFF No action is executed.
EACH The selected action is executed on each violation of the mask.

*RST: OFF
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MASK:ACTion:STOP:EVENt:COUNt
Sets the number of mask violations after which the action is executed.

Parameters:
<Event_Count> Integer value, number of mask violations

MASK:ACTion:SCRSave:DESTination
Defines the storage location whether the violated mask screenshot is saved. For output settings,
see chapter ,Data and File Management”.

MASK:ACTion:WFMSave:DESTination
Defines whether the violated mask trace (waveform) is printed. For output settings, see chapter
.Data and File Management”.

MASK:ACTion:YOUT:ENABIe <Yout>
Enable or disable of pulses at the Y-OUTput if mask is distorted.

Parameters:
<Yout> ON | OFF

*RST: OFF

MASK:RESet:COUNter
Sets the counters of passed and failed acquisitions to Zero.

Usage: Event
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2.10 Digital Voltmeter

DVM N> TYPE e e 145
DVM<M>ISOURCE oot 145
DVMIENABIE oo 146
DVIMEPOSIION e e e 146
DVM<m>:RESUIEACTUAN? oo 146
DVM <M > RESURACTUAITSTATUS oo e s 146

DVM<m>:TYPE
Selects the measurement type of the digital voltmeter function.

Suffix:
<m> 1.4
Selects the measurement place.
Parameters:
<MeasurementType>  MEAN | DCRMs | STDD | UPEakvalue | LPEakvalue | PEAK |
CRESt | OFF
MEAN DC
DCRMs RMS
STDDeviation Standard deviation
UPEakvalue Peak +
LPEakvalue Peak -
PEAK Peak peak value (Maximum-Minimum)
CRESt Crest factor (|X|max/Xrwms)
OFF Measurement display deactivated
Example: DVM1:TYPE PEAK

Selects the DVM type PEAK for measurement place 1.

DVM<m>:SOURce
Selects the source for the digital voltmeter function.

Suffix:

<m> 1.4
Selects the measurement place.

Parameters:

<Source> CH1 | CH2 | CH3 | CH4
The number of channels depends on the instrument type.
*RST: CH1

Example: DVM1:SOUR CH2

Selects source = CH2 for measurement place 1.
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DVM:ENABIe
Activates or deactivates the digital volmeter function.

Parameters:
<Voltmeter_Enable> ON | OFF

*RST: OFF

DVM:POSition
Selects the display position of the digital voltmeter values.

Parameters:

<Position> TLEFt | TRIGht | BLEFt | BRIGht
TLEFt Display position top left.
TRIGht Display position top right.
BLEFt Display position bottom left.
BRIGht Display position bottom right.
*RST: TLEF

DVM<m>:RESult[:ACTual]?
Queries the actual voltmeter measurement result.

Suffix:
<m> 1.4
Selects the measurement place.
Response:
<CurrentValue> Numeric value
Example: DVM1:RES?
Received the voltmeter value of measurement place 1.
Usage: Query only

DVM<m>:RESult[:ACTual]:STATus
Queries the actual voltmeter measurement result with status register.

Suffix:
<m> 1.4
Selects the measurement place.
Response:
<Current_Value> Numeric value
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Command Reference

Protocol Analysis

GNBIAl e e 147
Paralle] BUS e 150
Sl 1652
SO Pl 160
2 e s 162
(AN 1 O 173
AN e 180
L N e 196
General

BUS<D>ISTATE <STAE>  ooiiiiieiii e 147
BUSKD>TYPE <TYPES> oo e 147
BUS<b>:FORMat <FOrMats> ..o 148
BUS<b>:DSIZe <DIsSplay_SiZe> ....cooiiiiiieee e 148
BUS<b>:DSIGNals <BitS_Signals> .o 148
BUS<b>:POSIHION <POSIIONS ..o 148
BUS<b>:LABEl <Label> oo 149
BUS<b>:LABELSTATE <STAtE>  ooiiiiiiiiiiiiiiee e e 149
SOURce:FUNCtion[:SHAPe] <Signal_Shape> . ..o 149
SOURce:FREQUENCY <FreqUENCY> oot 149

BUS<b>:STATe <State>
Switches the protocol display on or off.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<State> ON | OFF

*RST: OFF

BUS<b>:TYPE <Type>
Defines the bus or interface type for analysis. For most types, a special option to the instrument
is required.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Type> PARallel | CPARallel | 12C | SPI'| SSPI | UART | CAN | LIN

*RST: PAR
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BUS<b>:FORMat <Format>
Sets the decoding format for the display on the screen.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Format> ASCii | HEXadezimal | BINary | DECimal

*RST: HEX

BUS<b>:DSIZe <Display_Size>
Sets the height of the decoded bus signal on the sreen.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Display_Size> SMALI | MEDium | LARGe

*RST: MED

BUS<b>:DSIGnals <Bits_Signals>
Displays the individual bit lines above the decoded bus line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Bits_Signals> ON | OFF

*RST: ON

BUS<b>:POSition <Position>
Sets the vertical position of the decoded bus signal in divisions on the sreen.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Position> Default unit: div

*RST: -3.5
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BUS<b>:LABel <Label>
Sets the label for the Bus.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<lLabel> String value

“xxxxxxxx" (maximum 8 characters)

BUS<b>:LABel:STATe <State>
Swichtes the label of the bus on or off.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<State> ON | OFF

*RST: ON
SOURce:FUNCtion[:SHAPe] <Signal_Shape>
Define the function of the internal bus signal source.

Parameters:
<Signal_Shape> SQUare | RANDom | 12C | SPI'| COUNt | UART

*RST: SQU
SOURce:FREQuency <Frequency>
Define the frequency of the internal bus signal source.
Parameters:

<Frequency> Numeric value, depending of the function choosen for the internal BUS
signal source.

Square, Random: 1000, 1000000

UART: 9600, 115200, 1000000
SPI: 100000, 250000, 1000000
12C: 100000, 400000, 1000000
Count: 1000, 1000000

*RST: 1000

e
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2.11.2 Parallel Bus

BUS<b>:PARallel:DATA<mM>:SOURCE <SOUICE> ...iiiiiiiiiiiiiiiiee et 150
BUS<b>:PARallel:WIDTh <Bus_Width> ... 150
BUS<b>:PARAIIBEFCOUNT? e 150
BUS<b>:PARallel:FRAMeE<N>:STARL? e 151
BUS<b>:PARallel:FRAMe<n>:STOP? ... 151
BUS<b>:PARallel:FRAME<N>STATE?  .ooiieeeei e 151
BUS<b>:PARallel:FRAME<N> DATA? oo 152

BUS<b>:PARallel:DATA<m>:SOURce <Source>
Sets the input channels for the data bit lines. The suffix <m> selects the bit line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> DO .... D15

*RST: DO

BUS<b>:PARallel:WIDTh <Bus_Width>
Sets the number of lines to be analyzed.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Bus_Width> Range: 1to 16

Maximum number is the number of input channels.
Default unit: Bit

*RST: 4

BUS<b>:PARallel:FCOunt?
Returns the number of received frames of the active parallel bus.

Return values:
<Frame_Count> Total number of decoded frames.

Usage: Query only
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Command Reference

BUS<b>:PARallel:FRAMe<n>:STARt?
Returns the start time of the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> Select the frame.

Return values:
<Start_Time> Range: depends on sample rate, record length, time base
Default unit: s

Usage: Query only

BUS<b>:PARallel:FRAMe<n>:STOP?
Returns the end time of the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> Select the frame.

Return values:
<Stop_Time> Range: depends on sample rate, record length, time base
Default unit: s

Usage: Query only

BUS<b>:PARallel:FRAMe<n>:STATe?
Returns the state of the sync field for the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> Select the frame.

Return values:
<Sync_Field_State> OK| ERR | INS

ERR Error
INS Incomplete
Usage: Query only
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BUS<b>:PARallel:FRAMe<n>:DATA?
Returns the data bytes of the specified frame.

Suffix:
<b> 1,2

Select the bus.
<n> Select the frame.

Return values:

<Frame_Data> Comma-separated list of decimal values of the data bytes.
Usage: Query only
2.11.3 SPI

SPI - Configuration

BUS<b>:SPICS:SOURCE <SOUICES  .ouiiiiiiiiii e 153
BUS<b>:SPI:CS:POLarity <POIArItY> oo 153
BUS<b>:SPI:CLOCK:SOURCE <SOUICES  evviiiiiiieee e 153
BUS<b>:SPI:CLOCK:POLarity <Polarity> ...t 154
BUS<b>:SPI:DATA:SOURCE <SOUICES  .oviiiiiiiiiiiiiie et 154
BUS<b>:SPI:DATA:POLarity <POIarity> ..o 154
BUS<b>:SPIIBORDEr <Bit_Orders .ooiiiiiieie e 155
BUS<b>:SPI:SSIZe <Symbol_Size> ..o 155
Trigger

TRIGQErA:SPEEMODE <MOGE> ..o 155
TRIGger:A:SPI:PATTern <Data_Patterns>  ......coooiiiiiiiii e 156
TRIGger:A:SPI:PLENgth <Pattern_Length> ..o 156
TRIGger:A:SPI:POFFset <Pattern_BitOffset>  ......ocoiiiiiiii e 156
Decode

BUS<b>:SPIEFCOUNt? <Frame_COoUnt> .. 156
BUS<b>:SPI:FRAMe<n>:STATUS? <StatuS> . iiiiiiiiiiiii i 157
BUS<b>:SPI:FRAMe<n>:STARL? <Start_TiMe> ..o 157
BUS<b>:SPI:FRAMe<n>:STOP <Stop_TiME>  ociiiiiii i 157
BUS<b>:SPIEFRAMe<n>:DATA? <Data>  ...ooooiiiiiiie e 158
BUS<b>:SPI:FRAMe<n>:WCOuUNt? <Word_Count> ......cccceiiiiiiiiii 158
BUS<b>:SPI:FRAMe<n>:WORD<0>STARt? <Start_Time>  ......cccoveiiiiiieccee e 158
BUS<b>:SPI:FRAMe<n>:WORD<0>STOP? <Stop_Time> ...ccccooiiiiiieeie e 159
BUS<b>:SPI:FRAMe<n>:WORD<0>MISO? <Data> ....ccc.coooieeeiiiieeeee e 159
BUS<b>:SPI:FRAMe<n>:WORD<0>MOSI? <Data> .....ccccociiiiiiiiiiiieeeeeeeeeeee e 159



SCPI Commands HMO3000 series

Remote Control
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BUS<b>:SPI:CS:SOURce <Source>
Selects the input channel of the chip select line.

Suffix:
<b>

Parameters:
<Source>

1,2

Selects the bus.

CH1|CH2|CH3|CH4 | DO ... D15 | EXTern

The number of channels depends on the instrument type.

The external trigger input of the 2-channel instrument (HMO3002

series) can be used as chip select source.

*RST: CH1

BUS<b>:SPI:CS:POLarity <Polarity>
Selects whether the chip select signal is high active (high = 1) or low active (low = 1).

Suffix:
<b>

Parameters:
<Polarity>

1,2
Selects the bus.

POSitive | NEGative

POSitive High active
NEGative Low active
*RST: POS

BUS<b>:SPI:CLOCk:SOURce <Source>
Selects the input channel of the clock line.

Suffix:

<b>

Parameters:
<Source>

1,2
Selects the bus.

CH1|CH2|CH3|CH4|DO ... D15
The number of channels depends on the instrument type.

*RST: CH1
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BUS<b>:SPI:CLOCk:POLarity <Polarity>
Selects if data is stored with the rising or falling slope of the clock. The slope marks the begin of

a new bit.
Suffix:

<b>

Parameters:
<Polarity>

1,2
Selects the bus.

POSitive | NEGative

POSitive Rising slope
NEGative Falling slope
*RST: NEG

BUS<b>:SPI:DATA:SOURce <Source>
Selects the input channel of the data line.

Suffix:
<b>

Parameters:
<Source>

1,2
Selects the bus.

CH1|CH2 | CH3|CH4 | DO .... D15
The number of channels depends on the instrument type.

*RST: CH1

BUS<b>:SPI:DATA:POLarity <Polarity>
Selects whether transmitted data is high active (high = 1) or low active (low = 1).

Suffix:

<b>

Parameters:
<Polarity>

1,2
Selects the bus.

POSitive | NEGative

POSitive High active
NEGative Low active
*RST: POS
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BUS<b>:SPI:BORDer <Bit_Order>
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least signifi-

cant bit).
Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Bit_Order> MSBFirst | LSBFirst

*RST: MSBFirst

BUS<b>:SPI:SSIZe <Symbol_Size>
Sets the word length, the number of bits in a message.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Symbol_Size> Range: 4 to 32

Default unit: Bit

*RST: 8 Bit

TRIGger:A:SPI:MODE <Mode>
Specifies the trigger mode for SPI/SSPI protocols.

Parameters:
<Mode> BSTart | BEND | NTHBit | PATTern

BSTart
Burst start, sets the trigger event to the start of the frame. The frame
starts when the chip select signal CS changes to the active state.

BEND
Burst end, sets the trigger event to the end of the message.

NTHBit
Sets the trigger event to the specified bit number. To define the bit
number, use TRIGger:A:SPI:POFFset.

PATTern

Sets the trigger event to a serial pattern. To define the pattern,
use TRIGger:A:SPI:PATTern. For a complete configuration of the
pattern mode, you also have to set TRIGger:A:SPI:PLENgth and
TRIGger:A:SPI:POFFset.

*RST: BST
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TRIGger:A:SPI:PATTern <Data_Pattern>
Defines the bit pattern as trigger condition.

Parameters:
<Data_Pattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.
Example: TRIGger:A:SPI:PATTern “0011XXXX0110"

Sets a 12bit pattern.

TRIGger:A:SPI:PLENgth <Pattern_Length>
Defines how many bits build up the serial pattern.

Parameters:
<Pattern_Length> Range: 1 to 32

*RST: 4
TRIGger:A:SPI:POFFset <Pattern_BitOffset>
Sets the number of bits before the first bit of the pattern.
Parameters:
<Pattern_BitOffset> Number of ignored bits

Range: 0 to 4095

*RST: 0
BUS<b>:SPI:FCOunt? <Frame_Count>
Returns the number of frames.

Suffix:
<b> 1,2

Selects the bus.

Return values:
<Frame_Count> Total number of decoded frames.

Usage: Query only
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BUS<b>:SPI:FRAMe<n>:STATus? <Status>
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Status> OK | INCFirst | INCLast | INSufficient
OK: Frame is o.k.
INCFirst: First frame is incomplete
INCLast: Last frame is incomplete

INSufficient: Frame is insufficient

Usage: Query only

BUS<b>:SPI:FRAMe<n>:STARt? <Start_Time>
Returns the start time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Start_Time> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:SPI:FRAMe<n>:STOP <Stop_Time>
Returns the stop time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Stop_Time> Range: depends on sample rate and time base
Unit: s
Usage: Query only
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BUS<b>:SPI:FRAMe<n>:DATA? <Data>
Returns the comma separeted frame data.

Suffix:

<b>

<n>

Return values:
<Data>

Example:

Usage:

1,2
Selects the bus.

Selects the frame.

List of decimal values of data bytes

BUS:SPI:FRAMS:DATA?

Query only

BUS<b>:SPI:FRAMe<n>:WCOunt? <Word_Count>
Returns the number of words of a frame.

Suffix:

<b>

<n>

Return values:

<Word_Count>

Usage:

1,2
Selects the bus.

Selects the frame.

Number of words (numeric value).

Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>STARt? <Start_Time>
Returns the start time of a word of a frame.

Suffix:

<b>

<n>

<0>

Return values:

<Start_Time>

Usage:

1,2
Selects the bus.

Selects the frame.

Selects the word number.

Numeric Value

Range: depends on sample rate and time base
Unit: s

Query only

e
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BUS<b>:SPIl:FRAMe<n>:WORD<0>STOP? <Stop_Time>
Returns the stop time of a word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:

<Stop_Time> Numeric Value
Range: depends on sample rate and time base.
Unit: s

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>MISO? <Data>
Returns the decimal value of a data word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<Data> Decimal value of a data word

Usage: Query only

BUS<b>:SPI:FRAMe<n>:WORD<0>MOSI? <Data>
Returns the decimal value of a data word of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<Data> Decimal value of a data word.

Usage: Query only
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2.10.4 SSPI
BUS<b>:SSPI:CLOCK:SOURCE <SOUICE> oottt 160
BUS<b>:SSPI:CLOCK:POLarity <Polarity> ..o 160
BUS<b>:SSPI:DATA:SOURCE <SOUICE> oot 160
BUS<b>:SSPI:DATA:POLarity <Polarity> ... 161
BUS<b>:SSPI:BITime <BUrst_IdIeTiMe> ..ot 161
BUS<b>:SSPI:BORDEr <Bit_Order> .iiiiiiiiiiiiiiiiiee et 161
BUS<b>:SSPI:SSIZe <Symbol_Size> ..o, 162

BUS<b>:SSPI:CLOCk:SOURce <Source>
Selects the input channel of the clock line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2|CH3|CH4| DO ... D15

The number of channels depends on the instrument type.

*RST: CH1

BUS<b>:SSPI:CLOCk:POLarity <Polarity>
Selects if data is stored with the rising or falling slope of the clock. The slope marks the begin of

a new bit.

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive Rising slope
NEGative Falling slope
*RST: POS

BUS<b>:SSPI:DATA:SOURce <Source>
Selects the input channel of the data line.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2|CH3|CH4 | DO .... D15

The number of channels depends on the instrument type.

*RST: CH1

e
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BUS<b>:SSPI:DATA:POLarity <Polarity>
Selects whether transmitted data is high active (high = 1) or low active (low = 0).

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive High active
NEGative Low active
*RST: POS

BUS<b>:SSPI:BITime <Burst_IldleTime>

Within the idle time the data and clock lines are low. A new frame begins when the idle time has
expired and the clock line has been inactive during that time. If the time interval between the
data words is shorter than the idle time, the words are part of the same frame.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Burst_ldleTime> Range: 16E-9 to 1E-3

Default unit: s

*RST: 100E-6

BUS<b>:SSPI:BORDer <Bit_Order>
Defines if the data of the messages starts with MSB (most significant bit) or LSB (least signifi-

cant bit).
Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Bit_Order> MSBFirst | LSBFirst

*RST: MSBF

e
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Command Reference

BUS<b>:SSPI:SSIZe <Symbol_Size>
Sets the word length, the number of bits in a message.

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Symbol_Size> Range: 4 to 32
Default unit: Bit
*RST: 8 Bit

12Cc

I2C - Configuration

BUS<b>:12C:CLOCK:SOURCE <SOUICES  .iviiiiiiiieiciiie e 163
BUS<b>:12C:DATA:SOURCE <SOUICES  iiiiiiiiiieiee e 163
Trigger

TRIGer:AlI2C:MODE <MOOE> ..o 163
TRIGENAIZ2ZC:ACCESS SACCESSS  ciiiiietiiiiiee e e e e et e e e e e e e e e e e e e eae e 164
TRIGger:A:I2C:AMODE <AdIr_MOGE> ..o 164
TRIGger:A:12C:ADDResS <AdAress_StriNg>  ..ooviiiiiieiiiiiiie et 164
TRIGger:A:I2C:PATTern <Data_Pattern=> ..ot 165
TRIGger:A:I2C:PLENgth <Pattern_Length> ... 165
TRIGger:A:12C:POFFset <Pattern_ByteOffset> ..o 165
Decode

BUS<b>:12C:FCOUNt? <Frame_COUNT> oo 166
BUS<b>:12C:FRAMe<n>:STATUS? <State> ....ciiiiieiieei e 166
BUS<b>:12C:FRAMe<n>:STARt? <Start_TimMe> . .occcciiioiiiii e 166
BUS<b>:12C:FRAMe<n>:STOP? <StOp_TIME>  ..iiiiiiiiiceiee e 167
BUS<b>:12C:FRAME<N>:ACCESS? <ACCESS>  iiiiiiiiiiieeiiiiiiiee et e ettt et 167
BUS<b>:12C:FRAMe<n>:AMODe? <Address_Mode> .......cccoceiiiiiiiiiiiie e 168
BUS<b>:12C:FRAMe<n>:AACCess? <Acknowledge> . ....cccccciiiiiiiiiiiiieeceeeee e 168
BUS<b>:12C:FRAMe<n>:ADDRess? <Address_Value> ... 168
BUS<b>:12C:FRAMe<n>:ADEVice? <Slave_Address> ... 169
BUS<b>:12C:FRAMe<n>:ASTart? <Start_TIMe> .....cccooiiiiiieiieee e 169
BUS<b>:12C:FRAMe<n>:ADBStart? <Ack_StartTime> ...ccccccciiiiiiiiiiiiiee e 169
BUS<b>:12C:FRAMe<n>:ACOMplete? <Address_Complete> .....cocoviviiiiiiiiiiiiiiieeeeeciiiiee, 170
BUS<b>:12C:FRAMe<n>:BCOunt? <ByteCount_InFrame> .........ccccceiiiiiiiiiiiiiiiceeeecciieee, 170
BUS<b>:12C:FRAMe<n>:DATA? <DataWords_InFrame> ..........cccooiiiiiiiiiiiiiiiiceeeeeciee. 170
BUS<b>:12C:FRAMe<n>:BYTE<o>VALue? <Byte_Value> .......cccccooiiiiiiiiiiiiiiieeeceie 171
BUS<b>:12C:FRAMe<n>:BYTE<0>STARL? <Start_ TiMe> .ooueeei e 171
BUS<b>:12C:FRAMe<n>:BYTE<0o>ACKStart? <Ack_StartTime> .....cccooovviiiiiiiiieiiieiiiee 172
BUS<b>:12C:FRAMe<n>:BYTE<0>ACCess? <Acknowledge> ......ccccccceeiiiiiiiiiiiieieieiiiiieeenn, 172
BUS<b>:12C:FRAMe<n>:BYTE<o>COMPlete? <Byte_Complete> .......cccccovviiiiiiiiiiiiiiniinen.n. 173
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BUS<b>:12C:CLOCk:SOURce <Source>
Sets the input channel to which the clock line is connected.

Suffix:
<b>

Parameters:
<Source>

1,2
Selects the bus.

CH1|CH2 | CH3|CH4|DO0...D15
The number of channels depends on the instrument type.

*RST: CH1

BUS<b>:12C:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:

<b>

Parameters:
<Source>

1,2
Selects the bus.

CH1|CH2|CH3|CH4|DO0...D15
The number of channels depends on the instrument type.

*RST: CH1

TRIGger:A:12C:MODE <Mode>
Specifies the trigger mode for 12C.

Parameters:
<Mode>

STARt | RESTart | STOP | MACKnowledge | PATTern

STARt
Start of the message. The start condition is a falling slope on SDA while
SCL is high.

RESTart
Restarted message. The restart is a repeated start condition.

STOP
End of the message. The stop condition is a rising slope on SDA while
SCL is high.

MACKnowledge
Missing acknowledge. If the transfer failed, at the moment of the
acknowledge bit the SCL and the SDA lines are both on high level.
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PATTern
Triggers on a set of trigger conditions: read or write access of the ma
ster, to an address, or/and to a bit pattern in the message.

For a complete configuration of the pattern mode, you have to set:
TRIGger:A:12C:ACCess (read/write access), and
TRIGger:A:12C:AMODe and TRIGger:A:I12C:ADDRess (address), and/or
TRIGger:A:12C:POFFset and TRIGger:A:I12C:PLENgth and
TRIGger:A:12C.PATTern (pattern)

*RST: STAR
TRIGger:A:12C:ACCess <Access>
Toggles the trigger condition between Read and Write access of the master.

Parameters:
<Access> READ | WRITe

*RST: READ

TRIGger:A:12C:AMODe <Adr_Mode>
Sets the lenght of the slave address.

Parameters:

<Adr_Mode> NORMal | EXTended
NORMal 7 bit address
EXTended 10 bit address
*RST: NORM

TRIGger:A:12C:ADDRess <Address_String>
Sets the address of the slave device. The address can have 7 bits or 10 bits.

Parameters:
<AddressString> Binary pattern with max. 10 bit. Characters 0, 1, and X are allowed.
Example: TRI:A:I2C:ADDR “10X1"
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TRIGger:A:12C:PATTern <Data_Pattern>
Defines the bit pattern as trigger condition. Make sure that the correct pattern length has been
defined before with TRIGger:A:12C:PLENgth (see command below).

Parameters:
<DataPattern> String with max. 24 characters. Characters 0, 1, and X are allowed.
X can be assigned to a specified bit. If you define a pattern shorter than
the pattern length, the missing LSB are filled with X. If you define a
pattern longer than the pattern length, the pattern string is not valid.
Example: TRIG:A:12C:PLEN 2
TRIG:A:I2C:PATT ,,70XT0000XXXX1111"
TRIG:A:I12C:PATT?
Return value (2 bytes):,, T0XT0000XXXX1111"
Example: TRIG:A:12C:PLEN 1

TRIG:A:12C:PATT ,, 110"
TRIG:A:12C:PATT?
Return value (1 byte):,, TTOXXXXX"

TRIGger:A:12C:PLENgth <Pattern_Length>
Defines how many bytes are considered in the trigger condition. To set the pattern for these
bytes, use TRIGger:A:12C:PATTern.

Parameters:

<Pattern_Length> Number of bytes
Range: 1t0 3
*RST: 1

TRIGger:A:12C:POFFset <Pattern_ByteOffset>
Sets the number of bytes before the first byte of interest, relating to the end of the address
bytes.

Parameters:
<Pattern_ByteOffset>  Number of ignored bytes
Range: 0 to 4095

*RST: 0
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BUS<b>:12C:FCOunt? <Frame_Count>
Returns the number of frames.

Suffix:
<b>

Return values:
<Frame_Count>

Usage:

1,2
Selects the bus.

Total number of decoded frames.

Query only

BUS<b>:12C:FRAMe<n>:STATus? <State>
Returns the status of frames.

Suffix:
<b>

<n>

Return values:
<State>

Usage:

1,2
Selects the bus.

Selects the frame.

INComplete | OK | UNEXpstop | INSufficient | ADDifferent

INComplete Frame is incomplete

OK Frame is o.k.
UNEXpstop Frame stop is unexpected
INSufficient Frame is insufficient
ADDifferent Frame is different

Query only

BUS<b>:12C:FRAMe<n>:STARt? <Start_Time>
Returns the start time of a frame.

Suffix:
<b>

<n>

Return values:

<Start_Time>

Usage:

1,2
Selects the bus.

Selects the frame.
Range: depends on sample rate and time base
Unit: s

Query only

e
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BUS<b>:12C:FRAMe<n>:STOP? <Stop_Time>
Returns the stop time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Stop_Time> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:12C:FRAMe<n>:ACCess? <Access>
Returns the read/write access.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Access> INComplete | READ | WRITE | EITHer | UNDF
INComplete Frame is incomplete
READ Read frame
WRITE Write frame
EITHer Either write or read frame
UNDF Frame is undefined
Usage: Query only
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BUS<b>:12C:FRAMe<n>:AMODe? <Address_Mode>
Returns the adress mode.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Address_Mode> BIT7 | BIT10

BIT7 7 Bit address
BIT10 10 Bit address

Usage: Query only

BUS<b>:12C:FRAMe<n>:AACCess? <Acknowledge>
Returns the address acknowledge of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Acknowledge> INComplete | ACK | NACK | EITHer

INComplete Acknowledge is incomplete

ACK Acknowledge

NACK Not Acknowledge

EITHer ACK or NACK
Usage: Query only

BUS<b>:12C:FRAMe<n>:ADDRess? <Address_Value>
Returns the read/write address as a decimal value (including RW bit).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Address_Value> Range: 0 to 2047 (decimal value)

Usage: Query only
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BUS<b>:12C:FRAMe<n>:ADEVice? <Slave_Address>
Returns the read/write address as a decimal value (excluding RW bit).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Slave_Address> Range: 0 to 1023

Usage: Query only

BUS<b>:12C:FRAMe<n>:ASTart? <Start_Time>
Returns the start time of a address of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Start_Time> Range: depends on sample rate and time base
Unit: s
Usage: Query only

BUS<b>:12C:FRAMe<n>:ADBStart? <Ack_StartTime>
Returns the start time of a address acknowledge of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Ack_StartTime> Range: depends on sample rate and time base
Unit: s
Usage: Query only
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BUS<b>:12C:FRAMe<n>:ACOMplete? <Address_Complete>
Returns the info whether an address was received complete.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Address_Complete> ON | OFF

Usage: Query only

BUS<b>:12C:FRAMe<n>:BCOunt? <ByteCount_InFrame>
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ByteCount_InFrame> Number of words (bytes)

Example: BUS1:12C:FRAM2:BCO?
Response: 4
Usage: Query only

BUS<b>:12C:FRAMe<n>:DATA? <DataWords_InFrame>
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<DataWords_InFrame> Comma-separated list of decimal values of the data bytes

Example: BUS:12C:FRAMZ2:DATA?
Response: 69,158,174,161

Usage: Query only

SCPI Programmers Manual 170



Command Reference

BUS<b>:12C:FRAMe<n>:BYTE<o>VALue? <Byte_Value>
Returns the value of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Byte_Value> Decimal value
Range: 0 to 255

Example: BUS:I2C:FRAM2:BYTE2:VAL?
Response: 158

Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<0>STARt? <Start_Time>
Returns the start time of data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Start_Time> Range: depends on sample rate and time base
Default unit: s

Usage: Query only
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BUS<b>:12C:FRAMe<n>:BYTE<o>ACKStart? <Ack_StartTime>
Returns the start time of the acknowledge bit of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Ack_StartTime> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:12C:FRAMe<n>:BYTE<o>ACCess? <Acknowledge>
Returns the acknowledge bit of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Acknowledge> INComplete | ACK | NACK | EITHer

INComplete Acknowledge is incomplete

ACK Acknowledge

NACK Not Acknowledge

ElTHer ACK or NACK
Usage: Query only

e
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BUS<b>:12C:FRAMe<n>:BYTE<o>COMPIlete? <Byte_Complete>
Returns the information whethera data byte of a frame is received complete.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:

<Byte_Complete> ON | OFF

ON Data byte was received completely.
Usage: Query only
UART

UART - Configuration

BUS<b>:UART:DATA:SOURCE <SOUICE>  .iiiiiiiiiiieiiee e 174
BUS<b>:UART:DATA:POLarity <Polarity> ... 174
BUS<b>:UART:SSIZe <SymMDOI_SIZE>  ..oveiiiiiii e 174
BUS<b>:UART:PARItY <Parity> ..o 175
BUS<b>:UART:SBIT <StopBit_NUMDEIr> ...t 175
BUS<b>:UART:BAUDrate <Baudrates> ......ccccciiiiiiiiiiii i 175
BUS<b>:UART:BITime <Burst_IdIETIME> ...t 176
Trigger

TRIGGerAIUART:MODE <MOGE> ittt 176
TRIGger: A:UART:PATTern <Data_Pattern=> . ...t 177
TRIGger: A:UART:PLENgth <Pattern_Length> ..., 177
TRIGger:A:UART:POFFset <Pattern_ByteOffset>  .....ccccoiiiiiiiiiiiiii e 177
Decode

BUS<b>:UART:FCOUNt? <Frame_COUNT> ..o 177
BUS<b>:UART:FRAMe<n>:WORD<0>:VALuUe? <Value> .......cccoiiiiiiiiiiiiiieee e 178
BUS<b>:UART:FRAMe<n>:WCOuUNt? <Word_Count>  ......coooiiiiiiiiicieee e 178
BUS<b>:UART:FRAMe<n>:WORD:STARt? <Start_Time> . .cccccceoiieeiiiie e 178
BUS<b>:UART:FRAMe<n>:WORD<0>:STOP? <Stop_Time> ....cccceeiiiieiiieeeeiee e 179
BUS<b>:UART:FRAMe<n>:WORD<0>:STATe? <Frame_Status> ......ccccccceeviuviviieeeeiiiiiiiieeennn. 179
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BUS<b>:UART:DATA:SOURce <Source>
Selects the input channel of the UART signal.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2|CH3|CH4|DO ... D15

The number of channels depends on the instrument type.

*RST: CH1

BUS<b>:UART:DATA:POLarity <Polarity>
Defines if the transmitted data on the bus is high (high = 1) or low (low = 1) active.

Suffix:

<b> 1,2
Selects the bus.

Parameters:

<Polarity> POSitive | NEGative
POSitive High active
NEGative Low active
*RST: POS

BUS<b>:UART:SSIZe <Symbol_Size>
Sets the number of data bits in a message.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Symbol_Size> Range: 5to 9

Default unit: Bit

*RST: 8
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BUS<b>:UART:PARity <Parity>
Defines the optional parity bit that is used for error detection.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Parity> ODD | EVEN | NONE

*RST: NONE

BUS<b>:UART:SBIT <StopBit_Number>
Sets the stop bits.

Suffix:
<b> 1,2

Selects the bus.
Parameters:

<StopBit_Number> B1|B1_5|B2
1, 1.5 or 2 stop bits are possible.

*RST: B1

BUS<b>:UART:BAUDrate <Baudrate>
Sets the user defined number of transmitted bits per second.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Baudrate> Range: 100 to 78.1E6

Upper limit depends on instrument type
Default unit: Bit

*RST: 1.15200E+05
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BUS<b>:UART:BITime <Burst_IldleTime>
Sets the minimal time between two data frames (packets), that is, between the last stop bit and
the start bit of the next frame.

Suffix:
<b>

Parameters:
<Burst_ldleTime>

1,2
Selects the bus.

Range: 12.8E-9 to 53.68E-3
Default unit: s

*RST: 64E-9

TRIGger:A:UART:MODE <Mode>
Specifies the trigger mode for UART/RS-232 interfaces.

Parameters:
<Mode>

BSTart | SBIT | NTHSymbol | SYMBol | PATTern | PERRor | FERRor |
BREak

BSTart
Burst start. Sets the trigger to the begin of a data frame. The frame start
is the first start bit after the idle time.

SBIT
The start bit is the first low bit after a stop bit.

NTHSymbol
Sets the trigger to the n-th symbol of a burst.

SYMBol
Triggers if a pattern occurs in a symbol at any position in a burst.

PATTern

Triggers on a serial pattern at a defined position in the burst.
To define the pattern, use TRIGger:A:UART:PLENgth and
TRIGger:A:UART:PATTern.

To define the position, use TRIGger:A:UART:POFFset.

PERRor
Parity Error: Triggers if a bit error occured in transmission.

FERRor
Triggers on frame error.

BREak
Triggers if a start bit is not followed by a stop bit within a defined time.
During the break the stop bits are at low state.

*RST: SBIT
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TRIGger:A:UART:PATTern <Data_Pattern>
Defines the bit pattern as trigger condition.

Parameters:
<Data_Pattern> Binary pattern with max. 32 bit. Characters 0, 1, and X are allowed.

*RST: 1 (=,,00000001")

TRIGger:A:UART:PLENgth <Pattern_Length>
Defines how many symbols build up the serial pattern.

Parameters:

<Pattern_Length> Number of symbols
Range: 1to 6
The maximum number of symbols are depending on the symbol size
of the UART protocol.

Symbol size | Max. symbols
5
6 5
7 4
8 4
9 3
*RST: 1

TRIGger:A:UART:POFFset <Pattern_ByteOffset>
Sets the number of symbols before the first symbol of the pattern.

Parameters:
<Pattern_ByteOffset>  Number of ignored symbols
Range: 0 to 4095
*RST: 0
BUS<b>:UART:FCOunt? <Frame_Count>
Returns the number of frames.
Suffix:
<b> 1,2

Selects the bus.

Return values:
<Frame_Count> Total number of decoded frames.

Usage: Query only
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BUS<b>:UART:FRAMe<n>:WORD<o0>:VALue? <Value>
Return the value of the specified symbol (word) on the data line.

Response:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the word number.

Return values:
<Value> Decimal value
Range: 0 to 511

Usage: Query only

BUS<b>:UART:FRAMe<n>:WCOunt? <Word_Count>
Returns the number of symbols in the specified frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Word_Count> Number of words (symbols, characters)

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD:STARt? <Start_Time>
Returns the start time of the specified symbol (word).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Start_Time> Range: depends on sample rate, record length and time base
Default unit: s

Usage: Query only
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BUS<b>:UART:FRAMe<n>:WORD<0>:STOP? <Stop_Time>
Returns the stop time of a word of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Stop_Time> Range: depends on sample rate, record length and time base
Default unit: s

Usage: Query only

BUS<b>:UART:FRAMe<n>:WORD<o0>:STATe? <Frame_Status>
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Frame_Status> OK'| FRSTart | FRENd | FRMError | STERror | SPERror | PRERror |
INSufficient
OK Frame o.k.
FRSTart Frame start
FRENd Frame end
FRMError Frame error
STERror Start bit error
SPERror Stop bit error
PRERror Parity error

INSufficient Frame insufficient
*RST: OK

Usage: Query only
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2.11.7 CAN

CAN - Configuration

BUS<b>:CAN:DATA:SOURCE <SOUICES  .oiiiiiiiiiiiiiiiee et 181
BUS<b>:CANITYPE <Signal_TYPE>  eiiiiiiiiii ittt 181
BUS<b>:CAN:SAMPIlepoint <Sample_Point> .. ..o 182
BUS<b>:CAN:BITRate <Bit_Rate> . .ccooiiiiiiiee e 182
Trigger

TRIGGerA:CAN:TYPE <Trigger_TYPE>  iueiiieieieiiiiiee e e 182
TRIGger: A:CAN:FTYPe <Frame_TyPe> ..o 183
TRIGger: A:CAN:ITYPe <ldentifiler_TYPE>  ..iiiiiiiiiiieie et 183
TRIGger:A:CAN:ICONdition <ldentifier_Condition>  .......c.ccooiiiiiiiii e 183
TRIGger:A:CAN:IDENTtifier <Identifiers ... 183
TRIGger:A:CAN:DCONdition <Data_ConditioN>  ......ccooiiiiiiiiiiiieccccieee e 184
TRIGQErA:CAN:DATA <DAtA> e e 184
TRIGger:A:CAN:DLENgth <Data_Length> ... 184
TRIGger:A:CAN:ACKerror <Acknowledge_Error> ... 184
TRIGger:A:CAN:CRCerror <CRC_EIMTOI> it 185
TRIGger:A:CAN:FROMerror <FOrM_EImOr= ... 185
TRIGger:A:CAN:BITSterror <BitStuffing_Error> ..o 185
Decode

BUS<b>:CAN:FCOUNt? <Frame_CoUnt> ... 185
BUS<b>:CAN:FRAMe<n>:STATUS? <Frame_StatuS> ....ccoiiimiiie i 186
BUS<b>:CAN:FRAME<nN>:STARL? <Start_ TiMeE>  ooeeeiee e 186
BUS<b>:CAN:FRAME<N>:STOP? <Stop_TiMeE> . oiiiiiiiiiiiiiiie e 186
BUS<b>:CAN:FRAME<n>:TYPE? <Frame_Type> ... 187
BUS<b>:CAN:FRAME<n>:DATA? <Frame_Data> .......cccccooiiiiiiiiee e 187
BUS<b>:CAN:FRAME<n>:ACKState? <Acknowledge_State> .......ccccccceeiiiiiiiiiiiieieiiiiiinee, 187
BUS<b>:CAN:FRAME<n>:CSState? <Checksum_State> .........ccccooviiiiiiiiiiiiiiiiiceeeeeciiieee, 188
BUS<b>:CAN:FRAME<n>:DLCState? <DatalLength_CodeState> .........cccccceiiiiiiieiiiiiiinnee.n. 188
BUS<b>:CAN:FRAME<n>:IDSTate? <ldentifier_State> ....ooomeieiieeeeee e 188
BUS<b>:CAN:FRAME<n>:ACKValue? <Acknowledge_Value> ............cccccooviiiiiiiieiiiieeeen 189
BUS<b>:CAN:FRAME<n>:CSValue? <Checksum_Value> .........ccccccooviiiiiiiiiiiiieeeeeeee 189
BUS<b>:CAN:FRAME<n>:DLCValue? <DataLength_CodeValue> ...........cccoerriviiiieiniiiinnnnnn.n. 189
BUS<b>:CAN:FRAME<n>:IDTYpe? <ldentifier_Type> .....coooieiiiiieeiee e 190
BUS<b>:CAN:FRAME<n>:IDValue? <ldentifier_Value> .......c.cccooiiiiiiiiiiiiicee e 190
BUS<b>:CAN:FRAME<n>:BSEPosition? <BitStuffing_ErrorPosition> .........cccccccciiiinn. 190
BUS<b>:CAN:FRAME<n>:BCOuUNt? <Byte_CoUNt> .. ..iiciiiiiiiiiiiiiieeee e 191
BUS<b>:CAN:FRAME<n>:BYTE<0>:STATe? <Byte_Status> ......ccccooveiiiiiiiiiiiieeeeeeee e 191
BUS<b>:CAN:FRAME<n>:BYTE<0>:VALue? <Byte_Value> ..........ccccccciiii 191
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Search Protocol

SEARch:PROTocol:CAN:CONDition <Search_Condition> . ..cccciiiiiiiiiiiiiieecccceee e 192
SEARch:PROToCol:CAN:FRAME <Frame> ... 193
SEARch:PROTocol:CAN:CRCerror <CRC _EIMOrs .o 193
SEARch:PROTocol:CAN:ACKerror <Acknowledge_Error> ......cccccoiiiiiiiiiiiiiiiecee e 193
SEARch:PROTocol:CAN:FORMEITOr <FOrmM_Ermors ..o 193
SEARch:PROTocol:CAN:BITSterror <BitStuffing_Error> ... 194
SEARCh:PROTOCOICANITYPE oottt 194
SEARCh:PROTOCOICAN:FTYPE e, 194
SEARch:PROTocol:CAN:DLENgth <Data_Length>  .....ccccciiiiiiiiieeeeeee e 194
SEARch:PROTocol:CAN:ICONdition <Id_Condition>  .....cooiiiiiiiieee e 195
SEARch:PROTocol:CAN:DCONdition <Data_ConditioN> .....cooiiiiiieee e 195
SEARch:PROTocol:CAN:IDENtifier <ldentifiers . ..o 195
SEARCh:PROTOCOI:CAN:DATA <Datas oottt 195

BUS<b>:CAN:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Parameters:
<b> 1,2
Selects the bus.
<Source> CH1|CH2|CH3|CH4|DO0...D15

The number of channels depends on the instrument type.

*RST: CH1

BUS<b>:CAN:TYPE <Signal_Type>
Sets the signal type of the CAN.

Parameters:
<b> 1,2

Selects the bus.
<Signal_Type> CANH | CANL

CANH CAN High
CANL CAN Low

*RST: CANH
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BUS<b>:CAN:SAMPIlepoint <Sample_Point>
Sets the sample point for the CAN Decoder within the bit period.

Parameters:
<b> 1,2
Selects the bus.
<Sample_Point> Range: 25 to 90
Unit: %
*RST: 50

BUS<b>:CAN:BITRate <Bit_Rate>
Sets the user defined bit rate for the CAN Decoder.

Parameters:
<b> 1,2
Selects the bus.
<Bit_Rate> Range: 100Bit/s to 4.03MBit/s

Unit: Bit/s

*RST: 5.0000E+04

TRIGger:A:CAN:TYPE <Trigger_Type>
Specifies the trigger type for CAN.

Parameters:

<Trigger_Type> STOFrame | EOFrame | ID | IDDT | FTYPe | ERRCondition
STOFrame Sets the trigger to the start of a frame.
EOFrame Sets the trigger to the end of a frame.
ID Sets the trigger to the ID of a frame.
IDDT Sets the trigger to the ID and data of a frame.
FTYPe Sets the trigger to the frame type.

ERRCondition Sets the trigger to the error condition of a frame.

*RST: STOF
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TRIGger:A:CAN:FTYPe <Frame_Type>
Specifies the frame type for CAN.

Parameters:

<Frame_Type> DATA | REMote | ERRor | OVERIoad | ANY
DATA Sets the frame type to data.
REMote Sets the frame type to remote.
ERRor Sets the frame type to error.
OVERIoad Sets the frame type to overload.
ANY Sets the frame type to any.
*RST: ERR

TRIGger:A:CAN:ITYPe <ldentifier_Type>
Specifies the identifier type for CAN. If the trigger type ID is set, only B11 or B29 are allowed.

Parameters:
<ldentifier_Type> B11|B29 | ANY
If trigger type ID is set, only B11 or B29 is allowed.

B11 Sets the identifier type 11Bit.
B29 Sets the identifier type 29Bit.
ANY  Sets the identifier type to any.

*RST: B11
TRIGger:A:CAN:ICONdition <lIdentifier_Condition>
Specifies the condition for the identifier.

Parameters:
<ldentifier_Condition> EQUual | NEQual | GTHan | LTHan

EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater than.
LTHan Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:CAN:IDENtifier <ldentifier>
Specifies the identifier, depending of TRIGger:A:CAN:ITYPe <IdentifierType> setting only string
with 11 or 29 characters is possible.

Parameters:
<ldentifier> String containing binary pattern with max. 29 bit.
Characters 0, 1 and X are allowed.
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TRIGger:A:CAN:DCONdition <Data_Condition>
Specifies the condition for the data.

Parameters:

<Data_Condition> EQUual | NEQual | GTHan | LTHan
EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater than.
LTHan Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:CAN:DATA <Data>
Specifies the data for CAN trigger. Depending of TRIGger:A:CAN:DLENgth <DatalLength> set-
ting the number of characters is fixed, all bytes need to be complete.

Parameters:
<Data> String containing binary pattern with max. 64 bit.

Characters 0, 1 and X are allowed. Make sure to enter complete bytes.
Example: TRIG:A:CAN:DATA ,,10010110"

TRIGger:A:CAN:DLENgth <Data_Length>
Specifies the data length for the CAN trigger.

Parameters:

<Data_Length> Range: 0 to 8
Unit: Byte
*RST: 1

TRIGger:A:CAN:ACKerror <Acknowledge_Error>

Specifies the trigger on acknowledge error when trigger type is set to error, using
TRIGger:A:CAN:TYPE <TriggerType>. An acknowledgement error occurs when the transmitter
does not receive an acknowledgment - a dominant bit during the Ack Slot.

Parameters:
<Acknowledge_Error> ON | OFF

*RST: OFF
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TRIGger:A:CAN:CRCerror <CRC_Error>
Specifies the trigger on checksum error when trigger type is set to error, using
TRIGger:A:CAN:TYPE <TriggerType>.

Parameters:
<CRC_Error> ON | OFF

*RST: OFF
TRIGger:A:CAN:FROMerror <Form_Error>
Specifies the trigger on form error when trigger type is set to error, using TRIGger:A:CAN:TYPE

<TriggerType>. A form error occurs when a fixed-form bit field contains one or more illegal bits.

Parameters:
<Form_Error> ON | OFF

*RST: OFF
TRIGger:A:CAN:BITSterror <BitStuffing_Error>
Specifies the trigger on stuff bit error when trigger type is set to error, using

TRIGger:A:CAN:TYPE <TriggerType>.

Parameters:
<BitStuffing_Error> ON | OFF

*RST: ON
BUS<b>:CAN:FCOunt? <Frame_Count>
Returns the number of frames.

Suffix:
<b> 1,2

Selects the bus.

Return values:
<Frame_Count> Total number of decoded frames.

Usage: Query only
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BUS<b>:CAN:FRAMe<n>:STATus? <Frame_Status>
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Frame_Status> OK | BTST | CRC | FORM | NACK | INSufficient
OK Frame is valid.
BTST Bit stuff error occured.
CRC Cyclic redundancy check failed.
FORM Wrong CRC, ACK delimiter or end of frame occured.
NACK Acknowledge is missing.
INSufficient Frame is incomplete.
Usage: Query only

BUS<b>:CAN:FRAME<n>:STARt? <Start_Time>
Returns the start time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Start_Time> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:CAN:FRAME<n>:STOP? <Stop_Time>
Returns the stop time of a frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Stop_Time> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

e
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BUS<b>:CAN:FRAME<n>:TYPE? <Frame_Type>
Returns the frame type.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<Frame_Type> DATA | REMote | ERR | OVLD
DATA Frame type is data.
REMote Frame type is remote.
ERR Frame type is error.
OVLD Frame type is overload.
Usage: Query only

BUS<b>:CAN:FRAME<n>:DATA? <Frame_Data>
Returns a comma separated list of decimal values.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Frame_Data> Comma separated list of decimal values of data bytes of a frame:

Usage: Query only

BUS<b>:CAN:FRAME<n>:ACKState? <Acknowledge_State>
Returns the status of the acknowledge field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Acknowledge_State> OK'| UNDF

OK Acknowledge state is o.k.
UNDF Acknowledge state is undefined.

Usage: Query only

e
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BUS<b>:CAN:FRAME<n>:CSState? <Checksum_State>
Returns the status of the checksum field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Checksum_State> OK | UNDF

OK Acknowledge state is 0.k.
UNDF Acknowledge state is undefined.

Usage: Query only

BUS<b>:CAN:FRAME<n>:DLCState? <DataLength_CodeState>
Returns the status of the data length code of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Datalength_CodeState> OK | UNDF

OK Data length code state is o.k.
UNDF Data length code state is undefined.

Usage: Query only

BUS<b>:CAN:FRAME<n>:IDSTate? <ldentifier_State>
Returns the status of the identifier field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ldentifier_State> OK | UNDF

OK Identifier state is 0.k.
UNDF Identifier state is undefined.

Usage: Query only
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BUS<b>:CAN:FRAME<n>:ACKValue? <Acknowledge_Value>
Returns the value of the acknowledge bit of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Acknowledge_Value> Decimal value

Usage: Query only

BUS<b>:CAN:FRAME<n>:CSValue? <Checksum_Value>
Returns the value of the checksum of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Checksum_Value> Decimal value

Usage: Query only

BUS<b>:CAN:FRAME<n>:DLCValue? <DataLength_CodeValue>
Returns the value of the data length code field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Datalength_CodeValue> Non-negative integer

Usage: Query only
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BUS<b>:CAN:FRAME<n>:IDTYpe? <lIdentifier_Type>
Returns the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN extended

frames.
Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.

Return values:
<ldentifier_Type> B11|B29 | ANY

B11 Identifier type is 11 bit

B29 Identifier type is 29 bit

ANY identifier type is any
Usage: Query only

BUS<b>:CAN:FRAME<n>:IDValue? <ldentifier_Value>
Returns the value of the identifier of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ldentifier_Value> Decimal value

Usage: Query only

BUS<b>:CAN:FRAME<n>:BSEPosition? <BitStuffing_ErrorPosition>
Returns the position time of the bit stuffing error in the specified frame (if available).

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<BitStuffing_ErrorPosition> Default unit: s
*RST: 0
Usage: Query only
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BUS<b>:CAN:FRAME<n>:BCOunt? <Byte_Count>
Returns the number of data bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Byte_Count> Number of words (bytes)

Usage: Query only

BUS<b>:CAN:FRAME<n>:BYTE<0>:STATe? <Byte_Status>
Returns the state of the a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Byte_Status> OK| UNDF

OK Data byte state is o.k.
UNDF Data byte state is undefined.

Usage: Query only

BUS<b>:CAN:FRAME<n>:BYTE<o0>:VALue? <Byte_Value>
Returns the value of the data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Byte_Value> Decimal value

Usage: Query only
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SEARch:PROTocol:CAN:CONDition <Search_Condition>
Sets the event or combination of events to be searched for. Depending on the selected event,
further settings are required.

Parameters:
<Search_Condition> FRAMe | ERRor | IDENtifier | IDData | IDERror

FRAMe
Search for a frame type.
Set the frame type with: SEARch:PROTocol:CAN:FRAMe.

ERRor

Search for errors of one or more error types.
Set the error types with:
SEARch:PROTocol:CAN:ACKerror,
SEARch:PROTocol:CAN:BITSterror,
SEARch:PROTocol:CAN:CRCerror and
SEARch: PROTocol: CAN: FORMerror.

IDENTtifier

Search for identifier. Specifiy the identifier with:
SEARch:PROTocol:CAN:FTYPe,
SEARch:PROTocol:CAN:ITYPe,
SEARch:PROTocol:CAN:ICONdition and
SEARch:PROTocol:CAN:IDENTtifier.

IDData

Search for identifier and data.

Set the identifier (see IDENtifier) and the data with:
SEARch:PROTocol:CAN:DLENgth,
SEARch:PROTocol:CAN:DCONdition and
SEARch:PROTocol:CAN:DATA .

IDERror

Search for errors that occur with a specified identifier. Set the
identifier (see IDENTtifier) and the errors to be found

(see ERRor).

*RST: FRAM
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SEARch:PROTocol:CAN:FRAMe <Frame>
Selects the frame type to be searched for. The command is relevant if
SEARch:PROTocol:CAN: CONDition is set to FRAMe.

Parameters:

<Frame> SOF | EOF | OVERIoad | ERRor | DTA11 | DTA29 | REM11 | REM29
SOF Start of frame
EOF End of frame
OVERIoad Overload frame
ERRor Error frame
DTA11 Data frame with 11bit identifier
DTA29 Data frame with 29bit identifier
REM11 Remote frame with 11bit identifier
REM29 Remote frame with 29bit identifier
*RST: SOF

SEARch:PROTocol:CAN:CRCerror <CRC_Error>
Searches for errors in the Cyclic Redundancy Check. The command is relevant if
SEARch:PROTocol:CAN:CONDition is set to ERRor or IDERror.

Parameters:
<CRC_Error> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:ACKerror <Acknowledge_Error>

Searches for acknowledgement errors. An acknowledgement error occurs when the transmitter
does not receive an acknowledgment - a dominant bit during the Ack Slot. The command is
relevant if SEARch:PROTocol: CAN:CONDition is set to ERRor or IDERror.

Parameters:
<Acknowledge_Error> ON | OFF

*RST: OFF
SEARch:PROTocol:CAN:FORMerror <Form_Error>
Searches for form errors. A form error occurs when a fixed-form bit field contains one or more
illegal bits. The command is relevant if SEARch:PROTocol: CAN:CONDition is set to ERRor or

IDERror.

Parameters:
<Form_Error> ON | OFF

*RST: OFF

SCPI Programmers Manual 193



SCPI Commands HMO3000 series Remote Control

Command Reference

SEARch:PROTocol:CAN:BITSterror <BitStuffing_Error>
Searches for bit stuffing errors. See also: , Stuff bit”. The command is relevant if
SEARch:PROTocol:CAN:CONDition is set to ERRor or IDERror.

Parameters:
<BitStuffing_Error> ON | OFF

*RST: OFF

SEARch:PROTocol:CAN:ITYPe

Selects the length of the identifier: 11 bit for CAN base frames, or 29 bits for CAN extended fra-
mes. The command is relevant if SEARch:PROTocol:CAN: CONDition is set to IDENTtifier, IDData,
or IDERror.

Parameters:
<Id_Type> B11|B29

B11 Identifier length is 11 bit
B29 Identifier length is 29 bit
ANY identifier length is any

*RST: B11

SEARch:PROTocol:CAN:FTYPe
Specifies the frame type to be searched for if SEARch:PROTocol:CAN:CONDition is set to
IDENtifier.

Parameters:
<Frame_Type> DATA | REMote | ANY

SEARch:PROTocol:CAN:DLENgth <Data_Length>
Defines the length of the data pattern - the number of bytes in the pattern. The command is
relevant if SEARch:PROTocol: CAN:CONDition is set to IDData.

Parameters:
<Data_Length> Range: 0 to 8
Default unit: Byte

*RST: 1
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SEARch:PROTocol:CAN:ICONdition <ld_Condition>

Sets the comparison condition for the identifier: If the pattern contains at least one X (don't care),
you can trigger on values equal or not equal to the specified value. If the pattern contains only O
and 1, you can also trigger on a range greater than or lower than the specified value. The com-
mand is relevant if SEARch:PROTocol:CAN:CONDition is set to IDENtifier, IDData, or IDERror.

Parameters:

<ld_Condition> EQUal | NEQual | GTHan | LTHan
EQUual Sets the ID condition to equal.
NEQual Sets the ID condition to not equal.
GTHan Sets the ID condition to greater than.
LTHan Sets the ID condition to less than.
*RST: EQU

SEARch:PROTocol:CAN:DCONdition <Data_Condition>

Sets the comparison condition for data: If the pattern contains at least one X (don‘t care), you
can trigger on values equal or not equal to the specified value. If the pattern contains only 0 and
1, you can also trigger on a range greater than or lower than the specified value. The command
is relevant if SEARch:PROTocol:CAN:CONDition is set to IDData.

Parameters:

<Data_Condition> EQUal | NEQual | GTHan | LTHan
EQUual Sets the data condition to equal.
NEQual Sets the data condition to not equal.
GTHan Sets the data condition to greater than.
LTHan Sets the data condition to less than.
*RST: EQU

SEARch:PROTocol:CAN:IDENtifier <ldentifier>
Defines the identifier pattern. The pattern length is defined with SEARch:PROTocol:CAN:ITYPe. The
command is relevant if SEARch:PROTocol:CAN:CONDition is set to IDENtifier, IDData, or IDERror.

Parameters:
<Identifier> String containing binary pattern with max. 29 bit.
Characters 0, 1 and X are allowed.

SEARch:PROTocol:CAN:DATA <Data>
Defines the data pattern. The pattern length is defined with SEARch:PROTocol:CAN:DLENgth.
The command is relevant if SEARch:PROTocol: CAN:CONDition is set to IDData.

Parameters:

<Data> String containing binary pattern with max. 64 bit.
Characters 0, 1 and X are allowed.
Make sure to enter complete bytes.
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2.11.8 LIN

LIN - Configuration

BUS<b>:LIN:DATA:SOURCE <SOUIMCES  .oviiiiiiiiiiiiiii ettt 197
BUS<b>:LIN:POLarity <POlarity> ..o 197
BUS<b>:LIN:STANdard <Standard> ......oooiiiiiii e 197
BUS<b>:LIN:BITRate <Bit_Rate> .. .ccciiiiiiiiiee e 198
Trigger

TRIGGerALIN:TYPE <Trigger_TYPe> it 198
TRIGger:A:LIN:ICONdition <ldentifier_Condition>  .......ccoiiiiiiiiiii e 198
TRIGger:A:LIN:IDENtifier <Identifiers ... 198
TRIGger:A:LIN:DCONdition <Data_Condition>  .....cccoooiiiiiiiiiie e 199
TRIGErAILIN:DATA <DATIAS  eriiiiiieiiiiiiiiie ettt e e e e et e e e e e e e tnbaeeeee s 199
TRIGger:A:LIN:DLENgth <Data_Length> ... 199
TRIGger:A:LIN:CHKSerror <CheckSUM_EITors ..o 199
TRIGger:A:LIN:IPERerror <ldentifier_ParityErrors> ... 200
TRIGger:A:LIN:SYERror <Synchronisation_Errors ... 200
Decode

BUS<b>:LIN:FCOUNt? <Frame_Count> ..o 200
BUS<b>:LIN:FRAME<n>:STATUS? <Frame_StatusS> .....ccccoiiiiiieiiiiiiiiiiice e 201
BUS<b>:LIN:FRAME<n>:STARt? <Start_TiIMe> .. .cccoiiiiii e 201
BUS<b>:LIN:FRAME<n>:STOP? <StOp_TiMe> .iiiiiiiiiiiiiie et 202
BUS<b>:LIN:FRAME<n>:VERSION? <Frame_Version> ... 202
BUS<b>:LIN:FRAME<nN>:DATA? <Frame_Datas ..o 202
BUS<b>:LIN:FRAME<n>:IDSTate <ldentifier_State> .......ccccooeiiiiiiiii e 203
BUS<b>:LIN:FRAME<n>:IDValue? <ldentifier_Value> .........cc.cccooviiiioiiiiiceeeeeee e 203
BUS<b>:LIN:FRAME<N>:IDP_ValUB? ..o 203
BUS<b>:LIN:FRAME<N>:SYSTAE?  oeoeiiioeee e 204
BUS<b>:LIN:FRAME<n>:CSSTate? <Checksum_State> ........cccccoiiiiiiiieiiiiiiiiiecee e 204
BUS<b>:LIN:FRAME<n>:CSValue? <Checksum_Value> ......ccccoiiiiiiiiiie e 204
BUS<b>:LIN:FRAME<n>:BCOuUNt? <Byte_CoUNt> ... 205
BUS<b>:LIN:FRAME<n>:BYTE<0>:STATe? <Byte_StatuS> .......ccooviiiiieiiiiiiieeeee e 205
BUS<b>:LIN:FRAME<n>:BYTE<0>:VALue? <Byte_Value> .......ccccccovviiiiiiiiiiiiieeeece 205

Search Protocol

SEARch:PROTocol:LIN:CONDition <Search_Condition> . ...cccccviiiiiiiiiiiiiiieee e 206
SEARch:PROTOCOI:LIN:FRAME <Frames> ... 206
SEARch:PROTocol:LIN:CHKSerror <CheckSUM_Errors ... 207
SEARch:PROTocol:LIN:IPERror <ld_ParityErrors ... 207
SEARch:PROTocol:LIN:SYERror <SYNC_Ermors> .o 207
SEARch:PROTocol:LIN:ICONdition <ld_Condition>  .....ccooiiiiiiieee e 207
SEARch:PROTocol:LIN:IDENTtifier <ldentifiers ..o, 208
SEARch:PROTocol:LIN:DLENgth <Data_Length> ..o 208
SEARch:PROTocol:LIN:DCONdition <Data_Condition> . ...ccociiiiiiiiiiiiiiiiieeeeeeciiee e 208
SEARCh:PROTOCOILIN:DATA <Datas>  .ooiiieiieiieee e 208
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BUS<b>:LIN:DATA:SOURce <Source>
Sets the input channel to which the data line is connected.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Source> CH1|CH2|CH3|CH4| DO ... D15

The number of channels depends on the instrument type.

*RST: CH1

BUS<b>:LIN:POLarity <Polarity>
Sets the polarity of the LIN.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Polarity> POSitive | NEGative

*RST: POS

BUS<b>:LIN:STANdard <Standard>

Selects the version of the LIN standard that is used in the DUT. The setting mainly defines

the checksum version used during decoding. The most common version is LIN 2.x. For mixed
networks, or if the standard is unknown, set the LIN standard to AUTO.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Standard> V1X | V2X | J2602 | AUTO

V11X LIN Standard V1.x

V2X LIN Standard V2.x

J2602 LIN Standard J206 (sets also BitRate to 10.417 KBit/s)
AUTO Any standard

*RST: V1X

e
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BUS<b>:LIN:BITRate <Bit_Rate>
Sets the user defined bit rate for the CAN Decoder.

Suffix:
<b> 1,2
Selects the bus.
Parameters:
<Bit_Rate> Range: 100Bit/s to 4.03MBit/s

Unit: Bit/s

*RST: 9.6E+03

TRIGger:A:LIN:TYPE <Trigger_Type>
Specifies the trigger type for LIN.

Parameters:
<Trigger_Type> SYNC | WKFRame | ID | IDDT | ERRCondition
SYNC Sets the trigger to the synchronisation.
WKFRame Sets the trigger to the wake up frame.
ID Sets the trigger to the ID of a frame.
IDDT Sets the trigger to the ID and data of a frame.

ERRCondition Sets the trigger to the error condition of a frame.
*RST: SYNC

TRIGger:A:LIN:ICONdition <ldentifier_Condition>

Specifies the condition for the identifier.

Parameters:
<ldentifier_Condition> EQUual | NEQual | GTHan | LTHan

EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater than.
LTHan Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:LIN:IDENtifier <ldentifier>
Specifies the identifier, only 6 character are allowed.

Parameters:

<ldentifier> String containing binary pattern. Characters 0, 1, and X are allowed.
Enter the 6 bit identifier without parity bits, not the protected identifier.

Example: TRIG:A:LIN:IDEN ,,100001"
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TRIGger:A:LIN:DCONdition <Data_Condition>
Specifies the condition for the data.

Parameters:

<Data_Condition> EQUual | NEQual | GTHan | LTHan
EQUual Sets the condition for identifier to equal.
NEQual Sets the condition for identifier to not equal.
GTHan Sets the condition for identifier to greater than.
LTHan Sets the condition for identifier to less than.
*RST: EQU

TRIGger:A:LIN:DATA <Data>
Specifies the data for LIN trigger. Depending of TRIGger:A:LIN:DLENgth <DatalLength> setting
the number of characters is fixed, all bytes need to be complete.

Parameters:

<Data> String containing binary pattern with max. 64 bit.
Characters 0, 1 and X are allowed.

Example: TRIG:A:LIN:DATA ,10100101"

TRIGger:A:LIN:DLENgth <Data_Length>
Defines the length of the data pattern - the number of bytes in the pattern.

Parameters:

<Data_Length> Range: 1to 8
Default unit: Byte
*RST: 1

TRIGger:A:LIN:CHKSerror <Checksum_Error>

Triggers on a checksum error when trigger type is set to error condition, using
TRIGger:A:LIN:TYPE <TriggerType>. The checksum verifies the correct data transmission. It is
the last byte of the frame response.

Parameters:
<Checksum_Error> ON | OFF

*RST: ON
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TRIGger:A:LIN:IPERerror <ldentifier_ParityError>

Triggers on a parity error when trigger type is set to error condition, using TRIGger:A:LIN:TYPE
<TriggerType>. Parity bits are the bits 6 and 7 of the identifier. They verify the correct transmissi-
on of the identifier.

Parameters:
<ldentifier_ParityError> ON | OFF

*RST: OFF

TRIGger:A:LIN:SYERror <Synchronisation_Error>
Specifies the trigger on synchronisation error when trigger type is set to error, using
TRIGger:A:LIN:TYPE <TriggerType>.

Parameters:
<Synchronisation_Error> ON | OFF

*RST: OFF

BUS<b>:LIN:FCOunt? <Frame_Count>
Returns the number of received frames of the active LIN bus.

Suffix:
<b> 1,2
Selects the bus.

Return values:
<Frame_Count> Total number of decoded frames.

Usage: Query only
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BUS<b>:LIN:FRAME<n>:STATus? <Frame_Status>
Returns the status of frames.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<State> OK | CHKS | PRER | WAK | SYER | INS | ERR | LEN
OK Frame is valid.
CHKS Checksum error occured
PRERror Parity error
WAKeup Wake up occured
SYER Synchronisation error
INSufficient Identifier is insufficient.
ERRor Error
LENer Length error

Usage: Query only

BUS<b>:LIN:FRAME<n>:STARt? <Start_Time>
Returns the start time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Start_Time> Range: depends on sample rate and time base
Default unit: s

Usage: Query only
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BUS<b>:LIN:FRAME<n>:STOP? <Stop_Time>
Returns the stop time of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Stop_Time> Range: depends on sample rate and time base
Default unit: s

Usage: Query only

BUS<b>:LIN:FRAME<n>:VERSion? <Frame_Version>
Returns the version of LIN.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Frame_Version> VIX|V2X | J2602 | UNK

V1X LIN version is 1.x

V2X LIN version is 2.x
J2602 LIN version is J2602
UNK LIN version is unknown

Usage: Query only

BUS<b>:LIN:FRAME<n>:DATA? <Frame_Data>
Returns a comma separated list of decimal values of the data bytes.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Frame_Data> Comma separated list of decimal values of data bytes of a frame.

Usage: Query only
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BUS<b>:LIN:FRAME<n>:IDSTate <ldentifier_State>
Returns the status of the identifier field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:

<ldentifier_State> OK'| PRERror | UVAL | INSufficient
OK Identifier state is o0.k.
PRERror Parity error at the identifier.
UVAL Address is undefined.
INSufficient Identifier is insufficient.
Usage: Query only

BUS<b>:LIN:FRAME<n>:IDValue? <ldentifier_Value>
Returns the value of the identifier of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ldentifier_Value> Decimal value

Usage: Query only

BUS<b>:LIN:FRAME<n>:IDP_Value?
Returns the value of the parity of the identifier of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<ldentifier_ParityValue> Decimal value

Usage: Query only
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BUS<b>:LIN:FRAME<n>:SYSTate?
Returns the status of synchronization field of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<SyncField_State> OK| ERR | UNDF

oK Sync field state is o.k.

ERR Sync error.

UNDF Sync field state is undefined.
Usage: Query only

BUS<b>:LIN:FRAME<n>:CSSTate? <Checksum_State>
Returns the state of the checksum of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Checksum_State> OK | ERR | UNDF

OK Checksum field state is o.k.

ERR Checksum error.

UNDF Checksum state is undefined.
Usage: Query only

BUS<b>:LIN:FRAME<n>:CSValue? <Checksum_Value>
Returns the value of the checksum of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Checksum_Value> Decimal value

Usage: Query only
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BUS<b>:LIN:FRAME<n>:BCOunt? <Byte_Count>
Returns the number of bytes of a frame.

Suffix:
<b> 1,2

Selects the bus.
<n> Selects the frame.

Return values:
<Byte_Count> Number of words (bytes)

Usage: Query only

BUS<b>:LIN:FRAME<n>:BYTE<0>:STATe? <Byte_Status>
Returns the status of a data byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Byte_Status> OK | INS | UART

OK Byte status is o.k.

INS Byte status is insufficient.

UART Error within the byte.
Usage: Query only

BUS<b>:LIN:FRAME<n>:BYTE<o>:VALue? <Byte_Value>
Returns the value of the byte of a frame.

Suffix:
<b> 1,2
Selects the bus.
<n> Selects the frame.
<0> Selects the byte number.

Return values:
<Byte_Value> Decimal value

Usage: Query only
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SEARch:PROTocol:LIN:CONDition <Search_Condition>
Sets the event or combination of events to be searched for. Depending on the selected event,
further settings are required.

Parameters:
<SearchCondition>

FRAMe | ERRor | IDENtifier | IDData | IDERror

FRAMe
Search for a frame type.
Set the frame type with: SEARch:PROTocol:LIN:FRAMe .

ERRor

Search for errors of one or more error types.

Set the error types with: SEARch:PROTocol:LIN:CHKSerror,
SEARch:PRQOTocol:LIN:IPERror and
SEARch:PROTocol:LIN:SYERror .

IDENTtifier

Search for identifier.

Specifiy the identifier with: SEARch:PROTocol:LIN:ICONdition and
SEARch:PROTocol:LIN:IDENTHifier.

IDData

Search for identifier and data.

Set the identifier (see IDENtifier) and the data with:
SEARch:PROTocol:LIN:DLENgth,
SEARch:PROTocol:LIN:DCONdition and
SEARch:PROTocol:LIN:DATA.

IDERror
Search for errors that occur with a specified identifier. Set the identifier

(see IDENTifier) and the errors to be found (see ERRor).

*RST: FRAM

SEARch:PROTocol:LIN:FRAMe <Frame>
Selects the frame type to be searched for. The command is relevant if
SEARch:PROTocol:LIN:CONDition is set to FRAMe.

Parameters:
<Frame>

SOF | WAKeup

SOF Start of frame
WAKeup Wakeup frame
*RST: SOF
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SEARch:PROTocol:LIN:CHKSerror <Checksum_Error>
Searches for checksum errors. The command is relevant if SEARch:PROTocol:LIN:CONDition is
set to ERRor or IDERror.

Parameters:
<Checksum_Error> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:IPERror <Id_ParityError>
Searches for parity errors. The command is relevant if SEARch:PROTocol:LIN:CONDition is set to
ERRor or IDERror.

Parameters:
<Id_ParityError> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:SYERror <Sync_Error>
Searches for synchronization errors. The command is relevant if
SEARch:PROTocol:LIN:CONDition is set to ERRor or IDERror.

Parameters:
<Sync_Error> ON | OFF

*RST: OFF

SEARch:PROTocol:LIN:ICONdition <ld_Condition>

Sets the comparison condition for the identifier: If the pattern contains at least one X (don't
care), you can trigger on values equal or not equal to the specified value. If the pattern contains
only 0 and 1, you can also trigger on a range greater than or lower than the specified value. The
command is relevant if SEARch:PROTocol:LIN:CONDition is set to IDENTtifier, IDData or IDERror.

Parameters:

<Id_Condition> EQUal | NEQual | GTHan | LTHan
EQUual Sets the ID condition to equal.
NEQual Sets the ID condition to not equal.
GTHan Sets the ID condition to greater than.
LTHan Sets the ID condition to less than.
*RST: EQU
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SEARch:PROTocol:LIN:IDENtifier <ldentifier>
Defines the identifier pattern. The command is relevant if SEARch:PROTocol:LIN:CONDition is
set to IDENtifier, IDData or IDERror.

Parameters:
<Identifier> String containing binary pattern.
Characters 0, 1 and X are allowed.
Enter the 6 bit identifier without parity bits, not the protected identifier.

SEARch:PROTocol:LIN:DLENgth <Data_Length>
Defines the length of the data pattern - the number of bytes in the pattern. The command is
relevant if SEARch:PROTocol:LIN:CONDition is set to IDData.

Parameters:
<Data_Length> Range: 1to 8
Default unit: Byte

*RST: 1

SEARch:PROTocol:LIN:DCONdition <Data_Condition>

Sets the comparison condition for data: If the pattern contains at least one X (don't care), you
can trigger on values equal or not equal to the specified value. If the pattern contains only 0 and
1, you can also trigger on a range greater than or lower than the specified value. The command
is relevant if SEARch:PROTocol:LIN:CONDition is set to IDData.

Parameters:

<Data_Condition> EQUal | NEQual | GTHan | LTHan
EQUual Sets the data condition to equal.
NEQual Sets the data condition to not equal.
GTHan Sets the data condition to greater than.
LTHan Sets the data condition to less than.
*RST: EQU

SEARch:PROTocol:LIN:DATA <Data>
Defines the data pattern. The pattern length is defined with SEARch:PROTocol:LIN:DLENgth. The
command is relevant if SEARch:PROTocol:LIN:CONDition is set to IDData.

Parameters:

<Data> String containing binary pattern with max. 64 bit.
Characters 0, 1 and X are allowed.
Make sure to enter complete bytes.
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2.12 Data and File Management

2121

This chapter describes commands that store or restore data and measurement results.

Output Control

[ (OX @ 1V I A A SR 209
HCOPY:DESTINAtioN <MEAIUM>  oooiiiiiiiieeeee et 209
MMEMOry:NAME <File_NAmME> .. .o 209
HCOPY[IMMEIAE] oo 210
HCOPY:LANGUAGE <FOIMMAts> oot 210
HCOPY:PAGE:SIZE <SIiZE> i 210
HCOPy:PAGE:ORlentation <Orientation>  ......ooiiiiiiiiii e 210
HCOPyY:COLOR:SCHeme <Color_SCheme> . ..o 210
SYSTem:COMMUNIcate:PRINEICSET oo 211
SYSTem:COMMunicate:PRINter:SELect <Printer_Name> .........cccccoiiiiiiiiiiiiiiiciieeee e, 211
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? ... 211
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]? oo 211
HCOPy:DATA?

Returns the actual display content (screenshot). The DATA? query responses the screenshot data
in binary format.

Usage: Query only

HCOPy:DESTination <Medium>
Defines whether the screenshot is saved or printed.

Parameters:
<Medium> ~.MMEM" | ,SYST.COMM:PRIN"

+~MMEM"”
Saves the screenshot to a file.
Specify the file name and location with: MMEMory:NAME.

+SYST:COMM:PRIN"

Prints on the printer specified with SYSTem:COMMunicate:PRINter:SEL
ect. The printer must be specified before the HCOPy:DESTination is
sent.

*RST: ,MMEM"

MMEMory:NAME <File_Name>
Defines the file name to store an image of the display with HCOPy[:IMMediate].

Parameters:
<File_Name> String parameter
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HCOPy[:IMMediate]

Prints an image of the display to the printer or saves an image to a file or the clipboard, depen-
ding on the HCOPy:DESTination setting.

The printer is defined by SYSTem:COMMunicate:PRINter:SELect.

The file name for storage is defined by MMEMory:NAME.

Usage: Event

HCOPy:LANGuage <Format>
Defines the format of the printed or saved screenshot.

Parameters:

<Format> GDI | BMP | PNG | GIF
GDI For output on printer
BMP | PNG | GIF File formats for saved screenshots
*RST: PNG

HCOPy:PAGE:SIZE <Size>
Defines the page size to be used.

Parameters:
<Size> A4 | Ab | B5| B6 | EXECutive

HCOPy:PAGE:ORIlentation <Orientation>
Defines the page orientation.

Parameters:
<Orientation> LANDscape | PORTrait

HCOPy:COLOR:SCHeme <Color_Scheme>
Defines the color mode for saved and printed screenshots.

Parameters:
<Color_Scheme> COLor | GRAYscale | INVerted

INVerted
Inverts the colors of the output, i.e. a dark waveform is printed on a

white background.

*RST: COLor
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SYSTem:COMMunicate:PRINter:CSET
Sets the printer language.

Parameters:
<PrinterLanguage> PS | PCL5 | PCLXL

PS Postscript

*RST: PS

SYSTem:COMMunicate:PRINter:SELect <Printer_Name>
Selects a configured printer.

Parameters:

<Printer_Name> String parameter
Enter the string as it is returned with
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt or
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT].

SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?
Queries the name of the first printer in the list of printers. The names of other installed
printers can be queried with the SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT] command.

Return values:

<Printer_Name> String parameter
Enter the string as it is returned with
SYSTem: COMMunicate:PRINter: ENUMerate: FIRSt? or
SYSTem: COMMunicate:PRINter: ENUMerate[: NEXT]?:
If no printer is configured an empty string is returned.

Usage: Query only

SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?

Queries the name of the next printer installed.

The SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt command should be sent previously to
return to the beginning of the printer list and query the name of the first printer.

Return values:

<Printer_Name> String parameter
After all available printer names have been returned, an empty string
enclosed by quotation marks (,,) is returned for the next query. Further
queries are answered by a query error.

Usage: Query only
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2.12.2 MMEMory Commands
The MMEMory subsystem provides commands to access the storage media and to save and
reload instrument settings.

The oscilloscope has two storage devices indicated as drives:

e /INT: internal storage with default directories for each data type
e /USB_FRONT: USB connector on the front panel

e /USB_REAR:USB connector on the rear panel

Common computer and network drives like C:, D:, \\server\share are not available.

Name conventions

The names of files and directories have to meet the following rules:
e Only the 8.3 format with ASCII characters is supported.

e No special characters are allowed.

e Use/ (slash) instead of \ (backslash).

MMEMOIY:DRIVES? ..o 212
MMEMory:MSIS [<Mass_StoragelS>] ..o 213
MMEMOIY:DCATAIOG? ..ot 213
MMEMory:DCATalog:LENGth? <Path_Name> ........cccccciiiiiiiiiii e 214
MMEMory:MDIRectory <DireCtory_NAME> . ..cociiiiiiiiiiiiiiiee e 214
MMEMory:CDIRectory [<Directory_NamMe>] ..o 214
MMEMory:RDIRectory <Directory_NamME> . ..iiiiiiiiiiii i 215
MMEMory:CATalog? <Path_Name>[,<Format>] .....ccccciiiiiii e 215
MMEMory:CATalog:LENGth? <Path_Name> . ... 216
MMEMory:COPY <File_Source>,<File_Destination> .........cccccciiiiiiii 216
MMEMory:MOVE <File_Source>,<File_Destination> . ...cccccoeoiiiiiiiiiiiiee e 216
MMEMory:DELete <File_SOUICE> ..ot 217
MMEMory:DATA <File_Name>,<Data> .......ccccoiiiiiiiiiiiiiie e 217
MMEMory:STORe:STATe <State_Number>,<File_Name> ..........cccoiiiiiiiiiiiiiiiie, 217
MMEMory:LOAD:STATe <State_Number>,<File_Name> .........cccccoiiiiiiiiiiiiiiieeeeecee 218
MMEMory:DRIVes?

Returns the storage devices available on the oscilloscope.

Return values:
<Drive> List of strings

/INT Internal storage
/USB_FRONT USB connector on the front panel
/USB_REAR USB connector on the rear panel

Usage: Query only
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MMEMory:MSIS [<Mass_StoragelS>]
Changes the storage device (drive).

Parameters:
<Mass_StoragelS> One of the available drives: /INT, /JUSB_FRONT or /USB_REAR

Example: MMEM:MSIS ,/USB_FRONT"
Sets USB stick connected to the front panel as storage device.

MMEMory:DCATalog?
Returns the subdirectories of the specified directory. The result corresponds to the number of
strings returned by the MMEMory:DCATalog:LENgth? command.

Query Parameters:
<Path_Name> String parameter
Specifies the directory.

Return values:

<File_Entry> String parameter
List of subdirectory strings separated by commmas. If the specified
directory does not have any subdirectory, the current and the parent
directories are returned (“.,,0”, “..,,0")

Example: MMEM:DCAT? “/USB_FRONT"
received “"SCREENSHOTS", "DATA”

Example: Query for directories in the current directory:
MMEM:CDIR “/USB_FRONT/DATA/"
MMEM:DCAT? “*"
received ”.,,0",”..,,0","JANUARY,,0”,”FEBRUARY,,0"
MMEM:DCAT:LENG? “*”
received 4

Example: Query with filter:
MMEM:DCAT? ,/USB_FRONT/DA*"
received “DATA,,0”,"DATA_NEW,,0"
MMEM:DCAT:LENG? “/USB_FRONT/DA*"
received 2

Usage: Query only
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MMEMory:DCATalog:LENGth? <Path_Name>
Returns the number of directories in specified directory. The result corresponds to the number of
strings returned by the MMEMory:DCATalog? command.

Query Parameters:
<Path_Name> String parameter

Specifies the directory.

Return values:

<File_Entry_Count> Number of directories.

Example: MMEM:DCAT:LENG? “/USB_FRONT"
received 2

Usage: Query only

MMEMory:MDIRectory <Directory_Name>
Creates a new directory with the specified name.

Setting Parameters:
<Directory_Name> String parameter
Complete path including the storage device.

Example: Create directory DATA on the front USB flash device, with absolute path:
MMEM:MDIR “/USB_FRONT/DATA"”

Usage: Setting only
MMEMory:CDIRectory [<Directory_Name>]
Changes the default directory for file access.
Setting Parameters:
<Directory_Name> String parameter to specify the directory.
If the string also contains the storage device, the command

MMEM:MSIS is executed implicitely.

Example: MMEM:CDIR “/USB_FRONT/DATA”
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MMEMory:RDIRectory <Directory_Name>
Deletes the specified directory. All subdirectories and all files in the specified directory and in the
subdirectories will be deleted. You cannot delete the current directory or a superior directory.

Setting Parameters:
<Directory_Name> String parameter

Example: MMEM:RDIR “/INT/TEST"
Deletes the directory TEST in the internal storage device, and all files
and subdirectories in the directory.

Usage: Setting only

MMEMory:CATalog? <Path_Name>[,<Format>]
Returns the a list of files contained in the specified directory. The result corresponds to the
number of files returned by the MMEMory:CATalog:LENgth? command.

Query Parameters:
<Path_Name> String parameter
Specifies the directory.

<Format> ALL | WTIMe
ALL Extended result including file, date, time and attributes
WTIMe Extended result including file, date, time

Return values:

<Used_Memory> Total amount of storage currently used in the directory, in bytes.
<Free_Memory> Total amount of storage available in the directory, in bytes.
<File_Entry> String parameter
All files of the directory are listed with their file name, format and size in
bytes.
Example: MMEM:CAT? ,/INT/HELP/ENGLISH/* HTM'

Returns all english help files

Usage: Query only
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MMEMory:CATalog:LENGth? <Path_Name>
Returns the number of files in the specified directory. The result corresponds to the number of
files returned by the MMEMory:CATalog? command.

Query Parameters:
<Path_Name> String parameter
Directoty to be queried

Return values:
<Count> Number of files

Usage: Query only

MMEMory:COPY <File_Source>,<File_Destination>
Copies data between the instrument and a USB stick.

Setting Parameters:
<File_Source> String parameter
Name and path of the file to be copied.

<File_Destination> String parameter
Name and path of the new file. If the file already exists, it is overwritten
without notice.

Example: MMEM:COPY “/INT/SETTINGS/SET001.SET",
“/USB_FRONT/SETTINGS/TESTSET1.SET”

Usage: Setting only

MMEMory:MOVE <File_Source>,<File_Destination>
Moves an existing file to a new location.

Setting Parameters:

<File_Source> String parameter

Path and name of the file to be moved.

<File_Destination> String parameter
Path and name of the new file.

Example: MMEM:MOVE “/INT/SETTINGS/SET001.SET",
“/USB_FRONT/SETTINGS”

Usage: Setting only
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MMEMory:DELete <File_Source>
Removes a file from the specified directory.

Setting Parameters:

<File_Source> String parameter
Name and directory of the file to be removed. If the path is omitted,
the specified file will be deleted in the current directory. Filters are not
allowed.

Usage: Setting only

MMEMory:DATA <File_Name>,<Data>
Stores data to the storage location specified using MMEMory:CDIRectory.

Parameters:

<Data> 488.2 block data
The block begins with character ,#'. The next digit is the length of the
length information, followed by this given number of digits providing
the number of bytes in the binary data attached.

Parameters for setting and query:
<File_Name> String parameter
The name of the file the data is stored to.

Example: MMEM:DATA ,abc.txt' #216This is the file
#2: the length infomation has two digits
16: the binary data has 16 bytes.
MMEM:DATA? ,abc.txt”
received: This is the file

MMEMory:STORe:STATe <State_Number>,<File_Name>
Saves the current device settings to the specified file.

Setting Parameters:
<State_Number> State O (low) or 1 (high)1

<File_Name> String parameter
Path and file name

*RST: 1

Example: MMEM:CDIR “/USB_FRONT/DATA"
MMEM:STOR:STAT 1,"MORNING.SET”

Usage: Setting only
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MMEMory:LOAD:STATe <State_Number>,<File_Name>
Loads the device settings from the specified file.

Setting Parameters:
<State_Number> State O (low) or 1 (high)

<File_Name> String parameter
Path and file name

*RST: 1

Example: MMEM:CDIR “/USB_FRONT/DATA""
MMEM:LOAD:STAT 1,"MORNING.SET"

Usage: Setting only

General Instrument Setup

DISPIaY:DIALOGICLOSE oo 218
DISPIay:DIALOGIMESSAGE .ttt 218
DISPlay:LANGUAgE <LaNQUAGES  .iiiiiiiiiiiiiieee ettt 219
DISPlay:LANGuage:ADD <lLanguage>,<File_Path> ..., 219
DISPlay:LANGuage:REMOVE <LanNQUages> ....cooiiiiiiiiei e 219
DISPlay:LANGuage:CATalog? <LangUages>  ..ociiiiiiiieiciiiieeiie e 220
SYSTEMINAME e 220
SYSTem:DATE <Year>,<Month>,<Day> ......oooiiiiiiiiee e 220
SYSTem:TIME <Hour>,<Minute>, <SECONA>  .iiiiiiiiiiiiee et 221
SYSTEMITREE? ettt ettt e bt et et e et et e et et e et e s 221
SYSTEMISET SSEIUDS>  woiiiiiiitii ettt ettt ettt et et et e et e tt e e etaeeeras 221
SYSTem:ERROMINEXT? < ErTOrs et 221
SYSTeMERROINALL? <EITOr> e 222
N G I R = 7=1 USSP 222
SYSTEM:BEEPREITIMMEIATE] oo 222
SYSTem:BEEPer:TRIG:STATe <Trigger_Beep> . ..o 222
SYSTem:BEEPer:CONTrol:STATe <Control_Beep> ..icvviiiiiiiiiiiiiee e 222
SYSTem:BEEPer:ERRor:STATe <Error_Beep> ..o 222

DISPlay:DIALog:CLOSe
Closes the remote message box on the screen.

Usage: Setting only

DISPlay:DIALog:MESSage
Shows a remote message box with a specified text.

Example: DISP:DIAL:MESS , TEST"
The instrument shows a remote message box with TEST on the screen.

Usage: Setting only
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DISPlay:LANGuage <Language>
Sets the language in which the softkey labels, help and other screen information can be
displayed. Supported languages are listed in the ,Specifications” data sheet.

Parameters:

<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese
SCHinese Simplified Chinese
TCHinese Traditional Chinese

*RST: Reset does not change the language

DISPlay:LANGuage:ADD <Language>,<File_Path>
Adds the selected language to the device including softkey labels and help. To change the dis-
played language, use DISPlay: LANGuage.

Parameters:

<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese

<File_Path> String parameter contains the source path and the filename of the
language installation file.

Example: DISPlay:LANGuage:ADD FRENch,”/USB_FRONT/HMO_LNOO.HLU"
Loads the language installation file HMO_LNOO.HLU from the USB
device on the front panel and adds the french language.

Usage: Setting only

DISPlay:LANGuage:REMove <Language>
Removes the selected language from the device including softkey labels and help.

Parameters:
<Language> ENGLish | GERMan | FRENch | SPANish | RUSSian | SCHinese |
TCHinese
Example: DISPlay:LANGuage:REMove FRENch
Can be used to remove french language from the device.
Usage: Setting only

e
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DISPlay:LANGuage:CATalog? <Languages>
Returns a list of available languages of the device.

Return values:

<lLanguages> List of available languages.

Example: DISPlay:LANGuage:CAT?
Returns ENGL,GERM,FREN, if english, german and french languages
are installed.

Usage: Query only.

SYSTem:NAME
Defines an instrument name.

Parameters:
<Name> String with max. 20 characters
Example: SYST:NAME “MyScope”

SYSTem:DATE <Year>,<Month>,<Day>
Specifies the internal date for the instrument.

Parameters:
<Year> Default unit: a
<Month> Range: 1to 12
<Day> Range: 1 to 31
Default unit: d
Example: SYSTem:DATE 2014,10,1
Sets the device date to october 1st in the year 2014
SYSTem:DATE?
Returns 2014,10,1)
Usage: SCPI confirmed
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SYSTem:TIME <Hour>,<Minute>,<Second>
Specifies the internal time for the instrument.

Parameters:

<Hour> Range: 0 to 23
Default unit: h

<Minute> Range: 0 to 59
Default unit: min

<Second> Range: 0 to 59
Default unit: s

Example: SYSTem:TIME 12,15,0
Sets the time to quarter past twelve.
SYSTem:TIME?
Returns 12,15,0

Usage: SCPI confirmed

SYSTem:TREE?
Returns a list of implemented remote commands.

Usage: Query only
SYSTem:SET <Setup>

Defines or queries the device settings that can be saved and load manually with
SAVE/RECALL --> Device Settings.

Parameters:
<Setup> 488.2 block data
Usage: SCPI confirmed

SYSTem:ERRor:[NEXT]? <Error>

Queries the error/event queue for the oldest item and removes it from the queue. The response
consists of an error number and a short description of the error. Positive error numbers are
instrument-dependent. Negative error numbers are reserved by the SCPI standard.

Return values:
<Error> Error/event_number, “Error/event_description>[;Devicedependent info]”
If the queue is empty, the response is 0,”No error”

Usage: Query only
SCPI confirmed
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SYSTem:ERRor:ALL? <Error>

Queries the error/event queue for all unread items and removes them from the queue.

The response is a comma separated list of error number and a short description of the error in
FIFO order. Positive error numbers are instrument-dependent. Negative error numbers are
reserved by the SCPI standard.

Return values:

<Error> List of: Error/event_number,“Error/event_description>[;Devicedependent info]”
If the queue is empty, the response is 0,“No error”

Usage: Query only
SCPI confirmed

SYST:PRESet

Resets the instrument to the default state, has the same effect as *RST.

Usage: Event

SYSTem:BEEPer[:IMMediate]

Generates a beep sound on the device

Usage: Event

SYSTem:BEEPer:TRIG:STATe <Trigger_Beep>

Enables a beep sound, if the device is triggering.

Parameters:

<Trigger_Beep> ON | OFF

SYSTem:BEEPer:CONTrol:STATe <Control_Beep>

Enables a beep sound, if a control has been limited (e.g. the end of the range of a rotary sensor).

Parameters:

<Control_Beep> ON | OFF

SYSTem:BEEPer:ERRor:STATe <Error_Beep>

Enables a beep sound, if an error is occured.

Parameters:
<Error_Beep> ON | OFF
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2.14 Status Reporting

2141

STATus:OPERation Register

The commands of the STATus:OPERation subsystem control the status reporting structures of
the STATus:OPERation register:

See also:

e chapter 1.6.1, ,Structure of a SCPI Status Register”

e  STATus:OPERation Register”

The following commands are available:

STATUS:OPERATIONICONDITION? oottt snsnsssesssnnnnes 223
STATUS:OPERatiON:ENABIE <ENADIE>  ..ooiiiiiiiiiiiieeeiie e aeeveeeeeanaes 223
STATus:OPERation:NTRansition <Negative_Transition>  .......ccccvviiiiiiiiiiiiiiiee e 223
STATus:OPERation:PTRansition <Positive_TranSitioN>  ........uuvvurieiiirieiiireeieieeeierererereeeeereeeeen. 223
STATUS:OPERGtIONEVENT? oottt 224

STATus:OPERation:CONDition?
Returns the of the CONDition part of the operational status register.

Return values:
<Condition> Range: 1 to 65535
Condition bits in decimal representation.
ALIGnment (bit 0),
SELFtest (bit 1),
AUToset (bit 2),
WTRigger (bit 3)

Usage: Query only

STATus:OPERation:ENABIe <Enable>

Parameters:

<Enable> Range: 1 to 65535
STATus:OPERation:NTRansition <Negative_Transition>
Parameters:

<NegativeTransition>  Range: 1 to 65535
STATus:OPERation:PTRansition <Positive_Transition>

Parameters:
<PositiveTransition> Range: 1 to 65535
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STATus:OPERation[:EVEN{t]?

Return values:
<Event> Range: 1 to 65535

Usage: Query only

2.14.2 STATus:QUEStionable Registers

The commands of the STATus:QUEStionable subsystem control the status reporting structures of
the STATus:QUEStionable registers:

0 | CHANRel 0 | TEMP WARM
1 | CHANREIZ 1 | TEMF ERRar
2 2
3 3
4 4
5 5
6 G
T 7
8 8
& 9
10 10
11 1
12 12

STATus:QUEStionable 13 13
14 14

1] 15 15

1

2 : . . .

3 [coveroad —__STAT:QUES:COV & STAT:QUES:TEMP

4 | TEMPeratura

5

[+

7

B | NOALigndata

o | LInit

1? %STAT:QUEE:LIH

STAT:QUES:MASK

E MASK 0 | MASK1 0 | MEAST

14 1 1 | MEASZ

15 z z
3 3
4 4
5 a3
3] 3]
T T
a ]
9 9
10 10
11 1
12 12
13 13
14 14
15 15

Fig. 2.1: Structure of the STATus:QUEStionable register
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See also:
e chapter 1.6.1, ,Structure of a SCPI Status Register”
e  STATus:QUEStionable Register”

The following commands are available:

ST ATUS I PRESET ettt an et tn e nn e tntnnnnnnnnns 225
STATus:QUEStionable:CONDITION? ..o 225
STATus:QUEStionable:COVerload:CONDITION?  .ooiiiiiiiiieece et 225
STATus:QUEStionable: LIMit:CONDItION?  ..ocueiiiece e 225
STATus:QUEStionable:MASKICONDITION?  ..uiiiiiiciiicieee e 225
STATus:QUEStionable:COVerload:ENABIe <Enable> ... 226
STATus:QUEStionable:ENABIe <Enable> ... 226
STATus:QUEStionable:LIMit:ENABle <Enable> ..o 226
STATus:QUEStionable:MASK:ENABIe <Enable> ..., 226
STATus:QUEStionable:COVerload[:EVENT]? oo 226
STATus:QUESHIoNable[:EVENL? e, 226
STATus:QUEStionable: LIMIt:EVENT]? ..o, 226
STATus:QUEStionable:MASKEEVENL]? oo, 226
STATus:QUEStionable:COVerload:NTRansition <Negative_Transition>  ........ccccccovvvieeiinierennn 226
STATus:QUEStionable:LIMit:NTRansition <Negative_Transition>  .......cccccoovvviiieiiieeceieee, 226
STATus:QUEStionable:MASK:NTRansition <Negative_Transition>  .......c..cccoeeieiiviieceeee, 226
STATus:QUEStionable:NTRansition <Negative_Transition>  ....ccccoeeiiiiiiiiiiieeee e 226
STATus:QUEStionable:COVerload:PTRansition <Positive_Transition> ...........cccocvviviiiiiiiiinnnnn. 227
STATus:QUEStionable:LIMit:PTRansition <Positive_Transition> .........ccccceieeiiiiiiiiiiieeee e 227
STATus:QUEStionable:MASK:PTRansition <Positive_Transition> ........ccccccceeiiiiiiiiiiecieeccn, 227
STATus:QUEStionable:PTRansition <Positive_TranSition>  ....oooooiiiiie e 227
STATus:PRESet

Resets all STATUS:QUESTIONALBLE registers.

Usage: Event

STATus:QUEStionable:CONDition?

STATus:QUEStionable:COVerload:CONDition?
STATus:QUEStionable:LIMit:CONDition?

STATus:QUEStionable:MASK:CONDition?

Returns the contents of the CONDition part of the status register to check for questionable in-
strument or measurement states. Reading the CONDition registers does not delete the contents.

Return values:
<Condition> Condition bits in decimal representation

Range: 1 to 65535

Usage: Query only
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STATus:QUEStionable:ENABIle <Enable>

STATus:QUEStionable:COVerload:ENABIe <Enable>
STATus:QUEStionable:LIMit:ENABIe <Enable>
STATus:QUEStionable:MASK:ENABIle <Enable>

Sets the enable mask that allows true conditions in the EVENTt part to be reported in the sum-
mary bit. If a bit is set to 1 in the enable part and its associated event bit transitions to true, a
positive transition occurs in the summary bit and is reported to the next higher level.

Parameters:

<Enable> Bit mask in decimal representation
Range: 1 to 65535

Example: STATus:QUEStionable:MASK:ENABIe 24

Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:ENABIe register
part: 24 =8 + 16 =23 + 24

STATus:QUEStionable[:EVENt]?

STATus:QUEStionable:COVerload[:EVENt]?

STATus:QUEStionable:LIMit[:EVENt]?

STATus:QUEStionable:MASK[:EVENt]?

Returns the contents of the EVENTt part of the status register to check whether an event has
occurred since the last reading. Reading an EVENTt register deletes its contents.

Return values:
<Event> Event bits in decimal representation
Range: 1 to 65535

Usage: Query only

STATus:QUEStionable:NTRansition <Negative_Transition>
STATus:QUEStionable:COVerload:NTRansition <Negative_Transition>
STATus:QUEStionable:LIMit:NTRansition <Negative_Transition>
STATus:QUEStionable:MASK:NTRansition <Negative_Transition>

Sets the negative transition filter. If a bit is set, a 1 to O transition in the corresponding bit of the
condition register causes a 1 to be written in the corresponding bit of the event register.

Parameters:
<NegativeTransition>  Bit mask in decimal representation
Range: 1 to 65535

Example: STATus:QUEStionable:MASK:NTRansition 24
Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:NTRansition
register part: 24 =8 + 16 = 23 + 24
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Command Reference

STATus:QUEStionable:PTRansition <Positive_Transition>
STATus:QUEStionable:COVerload:PTRansition <Positive_Transition>
STATus:QUEStionable:LIMit:PTRansition <Positive_Transition>
STATus:QUEStionable:MASK:PTRansition <Positive_Transition>

Sets the positive transition filter. If a bit is set, a 0 to 1 transition in the corresponding bit of the
condition register causes a 1 to be written in the corresponding bit of the event register.

Parameters:
<PositiveTransition> Bit mask in decimal representation
Range:1 to 66535
Example: STATus:QUEStionable:MASK:PTRansition 24

Set bits no. 3 and 4 of the STATus:QUEStionable:MASK:PTRansition
register part: 24 =8 + 16 = 23 + 24
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3 SCPI Commands

in alphabetic order

ACQUITEIAVAIIADIE? oo 40
ACQUIre:AVERAGE I COMPIEIE? ..o 35
ACQuire:AVERage:COUNt <Average_COoUNT>  ...oooiiiiiiiiiie e 35
ACQUIre:COUNt <MaxXACGCOUNTS ittt e et ae e e e e 39
ACQuire:FILTer:FREQency <Filter_FreqUeNCY> ... 37
ACQuire:HRESoIUtion <HIgh_RES> i 39
ACQuire:INTerpolate <INterpolation= ........cciiiiiiiiiie e 35
ACQuire:MODE <ACQUISIION_IMOGE>  ...iiiiiiiiiie e 34
ACQuire:PEAKdetect <Peak_DEtECt> ... 39
ACQUITEIPOINTSIARATE? oo 37
ACQuire:POINts[:VALue] <Record_Length> ... 39
ACQuire:REALtime <RaNdom_Sampling> ..o 39
ACQUITE:SEGMENTEA:STATE  ovtiiiiie e e e e e e e 40
ACQUITE IS R AT e et 38
ACQUIre:STATe <AQUISITION_STATE>  ouiiiiiie et 38
ACQUIre:TYPE <AQUISTTION_TYPE> oo 38
ACQuire:WRATe <Waveform_Rate>  .......ccociiiiiii e 35
AUTOSCAIE ettt e et e e e e e e e e e e e e e e e e e a bbb aaaeeaeaaa 34
BUS<b>:CAN:BITRate <Bit_RaAte> ..o 182
BUS<b>:CAN:DATA:SOURCE <SOUICES  .oiiiiiiiiiiiiiieee e 181
BUS<b>:CAN:FCOUNt? <Frame_COUNT> oo 185
BUS<b>:CAN:FRAME<n>:ACKState? <Acknowledge_State> .......ccccccviiiiiiiiiiiiieieiiiiieeenn, 187
BUS<b>:CAN:FRAME<n>:ACKValue? <Acknowledge_Value> ............c.cccooviiiiiiiiiiiiieeen 189
BUS<b>:CAN:FRAME<n>:BCOUNt? <Byte_CoUNt> . ...cociiiiiiiiiiiiiiiiiccce e 191
BUS<b>:CAN:FRAME<n>:BSEPosition? <BitStuffing_ErrorPosition> ..........c.ccccccinin. 190
BUS<b>:CAN:FRAME<n>:BYTE<0>:STATe? <Byte_Status> .....cccccovvviiiiiiieeee e 191
BUS<b>:CAN:FRAME<n>:BYTE<0>:VALue? <Byte_Value> ........cccccceeiiiiiiiiiiiiieeiie 191
BUS<b>:CAN:FRAME<n>:CSState? <Checksum_State> .....ooiiiiiiiiee e 188
BUS<b>:CAN:FRAME<n>:CSValue? <Checksum_Value> ........cccccoiii 189
BUS<b>:CAN:FRAME<n>:DATA? <Frame_Data> ........cccccoiiiiiiiiiiiee e 187
BUS<b>:CAN:FRAME<n>:DLCState? <DatalLength_CodeState> ............cccoceeiviiiiiiiieeeeene . 188
BUS<b>:CAN:FRAME<n>:DLCValue? <DataLength_CodeValue> ...........cccoevrviiiiieiiiiinnnnen.n. 189
BUS<b>:CAN:FRAME<n>:IDSTate? <ldentifier_State> .......ccccoeiiiiiiiiiiii e 188
BUS<b>:CAN:FRAME<n>:IDTYpe? <ldentifier_Type> .....coooiiiiiiie e 190
BUS<b>:CAN:FRAME<n>:IDValue? <ldentifier_Value> .......ccoooiiiiiiie e 190
BUS<b>:CAN:FRAME<n>:STARL? <Start_ TIME>  ooeeeeie e 186
BUS<b>:CAN:FRAMe<n>:STATUS? <Frame_StatuS> ........oiiiiiiiiiiiiee e 186
BUS<b>:CAN:FRAME<N>:STOP? <Stop_TiMe> . ioiiiiiieiie e 186
BUS<b>:CAN:FRAME<n>TYPE? <Frame_Type> .....ccccoiiiiiiiiiiiiiiiee e 187
BUS<b>:CAN:SAMPIlepoint <Sample_Point> .. ..ot 182
BUS<b>:CAN:TYPE <Signal_Type> oot 181
BUS<b>:DSIGNals <BitS_Signals> .o 148
BUS<b>:DSIZe <DISplay_SiZe> ...oooiiiiiieee e 148
BUS<b>:FORMat <FOrmMats> ..o 148
BUS<b>:12C:CLOCK:SOURCE <SOUICES  .oviiiiiiiiie e 163
BUS<b>:12C:DATA:SOURCE <SOUICES  wiviiiiiiiiiiiiiiiie ettt 163
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BUS<b>:12C:FCOUNt? <Frame_COoUNt> i 166
BUS<b>:12C:FRAMe<n>:AACCess? <Acknowledge> . ...ccccccciiiiiiiiiiiiiieicccieee e, 168
BUS<b>:12C:FRAME<N>ACCESS? <ACCESS>  iiiiiiiieiei ittt 167
BUS<b>:12C:FRAMe<n>:ACOMplete? <Address_Complete> .....cccociiiiiiiiiiiiiiiiieeeecciiee. 170
BUS<b>:12C:FRAMe<n>:ADBStart? <Ack_StartTimes> ..o 169
BUS<b>:12C:FRAMe<n>:ADDRess? <Address_Value> .......ccccoi 168
BUS<b>:12C:FRAMe<n>:ADEVice? <Slave_Address> ........ccccceeviieiiiiiiieeeeeeeee e 169
BUS<b>:12C:FRAMe<n>:AMODe? <Address_Mode> .....ccccccceeiiiiiiiiiiiiiei e 168
BUS<b>:12C:FRAMe<n>:ASTart? <Start_TimMe> . .occcciiiiiii e 169
BUS<b>:12C:FRAMe<n>:BCOunt? <ByteCount_InFrame> .........cccccoiiiiiiiiiiiiiiiieecceciie. 170
BUS<b>:12C:FRAMe<n>:BYTE<0o>ACCess? <Acknowledge> .......ccccccceiiiiiiiiiiiiiieiiiiiieee. 172
BUS<b>:12C:FRAMe<n>:BYTE<0>ACKStart? <Ack_StartTimes> .....ooiieeeieiiee e 172
BUS<b>:12C:FRAMe<n>:BYTE<o>COMPlete? <Byte_Complete> .......cccceviiiieiiiiiiinen.. 173
BUS<b>:12C:FRAMe<n>:BYTE<0>STARt? <Start_Time> .....ccccceviiiiiiii 171
BUS<b>:12C:FRAMe<n>:BYTE<o>VALue? <Byte_Value> ........cccoiiiiiiiiiiiiiiiiieeeceeiie, 171
BUS<b>:12C:FRAMe<n>:DATA? <DataWords_InFrame> .........ccccoiiiiiiiiiiiiiiiiiiceeeeeciiieee, 170
BUS<b>:12C:FRAMe<n>:STARt? <Start_TimMe> . .occiiiiiiii e 166
BUS<b>:12C:FRAMe<n>:STATUS? <STate> ....iiiiiiiiiiiii i 166
BUS<b>:12C:FRAMe<n>:STOP? <Stop_TiMe>  ..rviiiiiiiiieiee e 167
BUS<b>:LABEl <Label> oo 149
BUS<b>:LABEISTATE <STAtE> oot 149
BUS<b>:LIN:BITRate <Bit_RaAte> .....cciiiioiiiiece e 198
BUS<b>:LIN:DATA:SOURCE <SOUIMCES  .iviiiiiiiiiiiiiiiiee ettt ettt 197
BUS<b>:LIN:FCOUNt? <Frame_COUNT> ..ot 200
BUS<b>:LIN:FRAME<n>:BCOuNt? <Byte_CouNnt> ... 205
BUS<b>:LIN:FRAME<n>:BYTE<0>:STATe? <Byte_StatusS> .......cccccviiiiieiiiiiiiiiiieeee e 205
BUS<b>:LIN:FRAME<n>:BYTE<0>:VALue? <Byte_Value> .......cccccoiiiiiiiiiiiiieieeec 205
BUS<b>:LIN:FRAME<n>:CSSTate? <Checksum_State> .....cccooiiiiiiiiiiiiiie e 204
BUS<b>:LIN:FRAME<n>:CSValue? <Checksum_Value> .........ccccoiiiiiiiiiiiiiiiiieee e 204
BUS<b>:LIN:FRAME<n>:DATA? <Frame_Datas> ........ccccviiiiiieeeeeeeee e 202
BUS<b>:LIN:FRAME<N>:IDP_ValUB? ..o 203
BUS<b>:LIN:FRAME<n>:IDSTate <ldentifier_State> . ......ccccooeiiiiiiiii e 203
BUS<b>:LIN:FRAME<n>:IDValue? <ldentifier_Value> .. ......oeiiiiiieee e 203
BUS<b>:LIN:FRAME<N>:START? <Start_TIMe> oo 201
BUS<b>:LIN:FRAME<n>:STATUS? <Frame_StatusS> ...t 201
BUS<b>:LIN:FRAME<N>:STOP? <StOP_TIME>  ..iiiiiiii i 202
BUS<b>:LIN:IFRAME<N>ISYSTAIE? oo 204
BUS<b>:LIN:FRAME<n>:VERSion? <Frame_Version> .........cccccomiiiiiiiiieiiiiiiiiieee e 202
BUS<b>:LIN:POLarity <Polarity> .. .o 197
BUS<b>:LIN:STANdard <Standard>  .....coooiiiii e 197
BUS<b>:PARallel:DATA<mM>:SOURCE <SOUICE> ...oiiiiiiiiiiiiiie e 150
BUS<b>:PARAIBEFCOUNT? e 150
BUS<b>:PARallel:FRAME<N> IDATA? oo 152
BUS<b>:PARallel:FRAME<N> STARL? .ot 151
BUS<b>:PARallel:FRAME<N>STATE? ..o 151
BUS<b>:PARallel:FRAME<N>:STOP? ..o 151
BUS<b>:PARallel:WIDTh <Bus_Width> ... 150
BUS<b>:POSIHION <POSIIONS  ..oiiiiiiiiiiiiee e 148
BUS<b>:SPEBORDEr <Bit_ OrdErs ..o 155
BUS<b>:SPI:CLOCK:POLarity <Polarity> ... 154
BUS<b>:SPI:CLOCK:SOURCE <SOUICES  .uviiiiiiiieeciee e 153
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BUS<b>:SPI:CS:POLarity <POIAMTY> oo 153
BUS<b>:SPI:CS:SOURCE <SOUICES  euiiiiiieiiie e 153
BUS<b>:SPI:DATA:POLarity <POIArity> ..o 154
BUS<b>:SPI:DATA:SOURCE <SOUICES  .uuiiiiiiiiiiiiiii e 154
BUS<b>:SPLEFCOUNT? <Frame_COUNT> oo 156
BUS<b>:SPIEFRAMe<n>:DATA? <Data>  ...oooiiiiii i 158
BUS<b>:SPI:FRAMe<n>:START? <Start_TIMeE>  .ooiiiiiiiiiiiiiee e 157
BUS<b>:SPI:FRAMe<N>:STATUS? <STAtUS> ..iiiiiiiiiiiie it 157
BUS<b>:SPI:FRAMe<n>:STOP <Stop_TIME>  ..oooiiiiiiiiee e 157
BUS<b>:SPI:FRAMe<n>:WCOuUNt? <Word_Count> .. ..ccoiiiiiiiiiiiiiiiiecceeeeeceee e 158
BUS<b>:SPI:FRAMe<n>:WORD<0>MISO? <Data> .....ccccociiiiiiiiiiiieeeeeeeeeeeeee e 159
BUS<b>:SPI:FRAMe<n>:WORD<0>MOSI? <Data> .....ccocoiiiiiiiiiiiiiieeeeeeeeeee e 159
BUS<b>:SPI:FRAMe<n>:WORD<0>STARt? <Start_Time> ......cccccviiiviiiiiiiee e 158
BUS<b>:SPI:FRAMe<n>:WORD<0>STOP? <Stop_Time> ...ccoiiiiiiiiiii 159
BUS<b>:SPI:SSIZe <SymDOI_SIZE> ..o 155
BUS<b>:SSPI:BITime <Burst_IdIeTImMe> ... 161
BUS<b>:SSPI:BORDEr <Bit_Orders> ..o 161
BUS<b>:SSPI:CLOCK:POLarity <POIarity> ....coiiiiiiiiiiiiiiiie e 160
BUS<b>:SSPI:CLOCK:SOURCE <SOUMCE>  ..iiiiiiiiiiiiiee e 160
BUS<b>:SSPI:DATA:POLarity <POIarity> ..o 161
BUS<b>:SSPI:DATA:SOURCE <SOUIMCES  .oviiiiieiie e 160
BUS<b>:SSPI:SSIZEe <SYMDOI_SIZE> e 162
BUS<D>ISTATE <STAE>  ooiiiiiiii e 147
BUS<D>TYPE <TYPE> oo e 147
BUS<b>:UART:BAUDrate <Baudrates> .........oooiiiiiiiie e 175
BUS<b>:UART:BITime <BUrst_IdIeTIME> ..o 176
BUS<b>:UART:DATA:POLarity <Polarity> ... 174
BUS<b>:UART:DATA:SOURCE <SOUICE>  ..iiiiiiiiiiiiiii et 174
BUS<b>:UART:FCOUNt? <Frame_Count> ..o 177
BUS<b>:UART:FRAMe<n>:WCOuUNt? <Word_Count> . ..ccccciiiiiiiiiiiiiice e 178
BUS<b>:UART:FRAMe<n>:WORD<0>:STATe? <Frame_Status> ......cccccovveeiviiiiieceeeeee 179
BUS<b>:UART:FRAMe<n>:WORD<0>:STOP? <Stop_Time> .....ccocviiiiiiiiiiiiiiiiiieeee e 179
BUS<b>:UART:FRAMe<n>:WORD<0>:VALUE? <Value> .......cccceiiiiiiiiiiiiiiiieee e 178
BUS<b>:UART:FRAMe<n>:WORD:STARt? <Start_TiMe> ..o 178
BUS<b>:UART:PARItY <Parity> ..o 175
BUS<b>:UART:SBIT <StopBit_NUMDEr> ..o 175
BUS<b>:UART:SSIZe <Symbol_SIiZe>  .viiiiiiiiii e 174
B A L e, 28
CALCulate:MATH<m>:ARIThmetics <ArthmetiCS> .......cccoiiiiiiiiiie e 133
CALCUIAte:MATH <M > I DATA? e 121
CALCulate:MATH<M>:DATAIENVEIOPE? ..o 122
CALCulate:MATH<m>:DATA:ENVelope:HEADEI?  ....oooieeiiieee e 122
CALCulate:MATH<mM>:DATA:ENVelope: XINCrement?  ......oooociiiiiieieieiiieieee e 123
CALCulate:MATH<m>:DATA:ENVelope: XORIGIN? ..o, 123
CALCulate:MATH<m>:DATA:ENVelope:YINCrement? ......cccocviiiieeiiiiiiiiieee e 123
CALCulate:MATH<m>:DATA:ENVelope:YORIGIN? e 124
CALCulate:MATH<m>:DATA:ENVelope:YRESOIUtION? ..o 124
CALCulate:MATH<M>:DATAIHEADEI? .o 121
CALCulate:MATH<M>:DATAXINCIEMENT?  1oiiiiiiiiiiiiiie et 124
CALCulate:MATH<M>:DATAXORIGIN? oot 125
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CALCulate:MATH<mM>:DATAYINCIEMENT?  oooiiiiiiiiiiiiee et 125
CALCulate:MATH<mM>:DATA:YORIGIN? oo, 125
CALCulate:MATH<mM>:DATAYRESOIUTION?  1oiiiiiiiiiiee e 126
CALCulate:MATH<m>[:EXPRession][:DEFine] <RemComplEXpr> .....ccoociiiiiiiiiiiiicceie 120
CALCulate:MATH<mM>:FFT:AVERAGE:COUNL oottt 134
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:ADJuStEd?  .......evvviiiiiiiiieiiiiiiiiiiiiiiiiiiens 134
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]: AUTO <SpanRBW_Coupling> ............. 135
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution]:RATio <SpanRBW_Ratio> .................. 135
CALCulate:MATH<m>:FFT:BANDwidth[:RESolution][:VALue] <Resolution_BW> ................ 135
CALCulate:MATH<m>:FFT:CFRequency <Center_Freq> ......cccccciiiiiiiiiiiiiieeecccceeee e 135
CALCulate:MATH<M>FFTIFULLSPAN oo 136
CALCulate:MATH<mM>:FFT:MAGNItUude:SCALE ..o 134
CALCulate:MATH<mM>:FFT:SPAN <Freq_Span> ..o 136
CALCulate:MATH<m>:FFT:SRATe? <Sample_Rate> ......ccccoeiiiiiiiiieceeeeeeee e 138
CALCulate:MATH<mM>:FFT:STARt <Start_Freq>  ...oooooiiiioe e, 136
CALCulate:MATH<mM>:FFT:STOP <StOp_Freq> viiiiieeeeee e, 136
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Position> ........ccccooiiiiiiiiieeeeee 138
CALCulate:MATH<m>:FFT:TIME:POSition <Window_Width> ..........cccoiiiiiiiiie, 138
CALCulate:MATH<m>:FFT:TIME:Range <Window_Position> ........ccccciiiiiiiiiiiiieeeeee 138
CALCulate:MATH<m>:FFT:TIME:RANGe <Window_Width> ... 137
CALCulate:MATH<m>:FFT:WINDowW:TYPE <WiNdOW_TYPE> ....vvviiiiiiiieeiiiieiiiiiieeiieiiveiieeveiens 137
CALCulate:MATH<mM>:LABEl <Label> ..o, 121
CALCulate:MATH<mM>:LABELSTATE <State> ..ot 122
CALCulate:MATH<mM>:POSIition <POSItION> ...t 120
CALCulate:MATH<M>:SCALE <SCalE>  oiiiiiiiiii e 119
CALCulate:MATH<M>:STATE <STAte> oo 119
CALCUIAtE: QM AT N D AT A ? e e e, 116
CALCulate:QMATNDATAIHEADEI? oo 117
CALCulate:QMATh:DATAXINCIrEMENT? oo 117
CALCulate:OMATh:DATAXORIGIN? oo 117
CALCulate:OMATh:DATAYINCIEMENT? oo, 117
CALCulate:OMATh:DATANNYORIGIN? oo, 118
CALCulate:QMATh:DATAIYRESOIUTION? e 118
CALCulate:QMATh:OPERation <Operation> ......coiiiiiiiiiiiei e 116
CALCulate:QMATN:POSItIoN <POSITION>  .oeiiiiiiiii e 116
CALCulate:QMATN:SCALE <SCaAIE> ..o 116
CALCulate:QMATN:SOURGCE SIMN>  ooiiiiiiiii ettt e e e e e e e e 115
CALCulate:OMATNISTATE <STAtE>  .oiiiiieiii e 115
(07 A I | o] = (oY o N SRR 61
CALIDIAtIONISTATE? et 61
CHANnNel<m>:ARIThmetics <TrAMthMETIC> ..o 36
CHANnNel<m>:BANDwidth <Bandwidth _Limits oo 42
CHANRNel<m>:COUPIING <COUPIING> oot 41
CHANNEIKMS I DATA? e 53
CHANRNEl<M>:DATAIENVEIOPE? .o 54
CHANRNel<m>:DATAIENVEIOPeHEADEI? oo 54
CHANnNel<m>:DATA:ENVelope: XORIGIN? e 55
CHANRNel<m>:DATAENVelope:YINCrement? ..o 55
CHANnNel<m>:DATAENVEIOPe:YORIGIN? oo 56
CHANRNel<m>:DATA:ENVelope:YRESOIUTION? o oo 56
CHANRNEI<M > DATAIHEADEI? oot e e tabraaa s 53
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CHANRNEel<mM>:DATAIPOINTS <POINTS>  .iiiiiiiiiiiiiiiiiie e 56
CHANRNEl<mM>:DATAIXINCIEMENT? oottt e et 55
CHANRNEl<mM > DATAIXORIGIN? et 55
CHANRNEl<mM>:DATAIYINCIEMENT? oottt 55
CHANNEI<M>DATAIYORIGIN? oottt e et e e 56
CHANRNEl<mM>:DATANYRESOIUTION? oo 56
CHANnRNel<m>:ENVelope:DATAIXINCIEMENT?  ..oeiiiiiiieieeeiieieeeeieeeeieeeeeeeeeeeeaaaeeaeaeaeaeeeveeeesanananees 55
CHANRNel<m>:HISTory:CURRent <CUITACOIAX>  oiviiiiiiiiiiiiiit et 45
CHANnNel<m>:HISTory:PLAYer:SPEed <TimePerACO> .....ccocoiviiiiiiiiiiiiieeeeeeeee e 46
CHANRNel<m>:HISTory:PLAYer:STATE <STate> ...iiiiiiiiiiiiiiiiiie e 45
CHANnNel<m>:HISTory:REPLay <AUto_Repeat> .......cccccoiiiiiiiiiiee e 45
CHANRNEl<mM>:HISTory: TSABSOIUIE? oo 46
CHANRNEl<M>HISTONY:TSDAtE? .ottt e e e e 46
CHANRNEl<mM > HISTOrY:TSREIGTIVE?  ..oeieiiiiieieieieeeeet e aaaneeseseseseananees 47
CHANRNEl<M>LABEl <Lab@l> i 44
CHANRNEl<mM>:LABELSTATE <SIAtE> oottt 44
CHANRNEl<M>:0FFSEt <OffSET>  oiiiiiiiiiii e 42
CHANRNel<m>:0OVERIoad <OVErload> ... 43
CHANRNel<m>:POLarity <POIarity> ..o 42
CHANRNel<mM>:POSItION <POSITION>  ..iiiiiii e 42
CHANNEl<M>RANGE <RANGE>  .ooiiiiiiii e 41
CHANRNEISM>:SCALE <SCAIE> ittt 41
CHANRNEI<M>SKEW <SKEW> oo 43
CHANRNEISM>ISTATE <STATE> ittt et 40
CHANnNel<m>:THReShOId:FINDIBVEI  .....oooieeiieiieee e 44
CHANRNel<mM>:THREShOIA:HYSTEIESIS e 44
CHANnNel<m>:THReshold <Threshold> ... 43
CHANnNel<m>:TYPE <Decimation_MoOdE> ... 36
SO T TSRS 28
CUR SOOI > AR et 84
CURSOr<mM=>:FUNCHON STYPE>  otiiiiiiiiiiiiiee ettt e et e e eaaare e 85
CURSOIr<mM>IRESUI? oot 89
CURSOIr<mM>1SNPEAK<N> oo 89
CURSOr<mM>:SOURCE <SOUMCE>  ..iiiiiiiiiiiie e 86
CURSOIr<mM>1SPPeAK N> i 89
CURSOI<M>ISSCREEBN oo et 89
CURSOIr<mM>ISTATE <STATE> 1ottt et e e e e e e e e e e etabaaaae s 84
CURSOI<MSISWAVE oot e et a e 89
CURSor<m=>:TRACKING:SCALE[:STATE] <State> ..ooiiiiiiiiieii e 88
CURSor<m>:TRACKING[:STATE] <STAtE>  ..vviiiiiiiiiiiiiieee e 86
CURSor<m>:XTPosition <XpOSItIONT> oot 87
CURSor<m>:X2P0Sition <XPOSItION2>  oieiiiiiii e 87
CURSor<m=>:X3P0Sition <XPOSIION3>  oiiiiiiiiiii it 87
CURSor<m=>:XCOUPING <COUPIINGS  oeriiiiee e 88
CURSOr<m=>:XDELIAIINVEISE?  .ooiiiiiiiiiiiie ettt 90
CURSOr<m>:XDELIA[:VALUEB]? e e 90
CURsor<m>:XRATIO:UNIT <UNIt> oo 91
CURSOr<mM = XRATIO:VALUECT? oo 91
CURSor<m>:YTP0oSItion <YPOSItIONT > ooiiiiiiiiei e 87
CURSor<m>:Y2P0oSition <YPOSItIONZ>  uueiiiiiie et 87
CURSOr<m=>:Y3P0oSItion <YPOSItIONS>  iiieiiiiiii ittt e e e etaaa e e 88
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CURSor<m=>:YCOUPIING <COUPIINGS™  1oiiiiiiiiiiie ettt 88
CURSOr<m>:YDELLA:SLOPE? ..ottt ittt ettt e stbe e staeesnbe e 90
CURSOr<mM > YDELLA[:VALUE]? oo 90
CURSOr<m=>:YRATIO:UNIT <UNIt> oottt 91
CURSOIr<mM = Y RATIO VA LUB]? oottt esenenenenes 92
DISPIaY:DIALOGICLOSE oo 218
DISPIay:DIALOGIMESSAGE it 218
DISPIaY:GRIDISTYLE <SUYIE> ittt bbb be e enbe e e e 81
DISPlay:INTensity:BACKIght <INtENSITY> oo 79
DISPlay:INTensity:GRID <INTENSITY> oo 79
DISPlay:INTensity:WAVeform <INteNSITY> ..o 79
DISPlay:LANGuage:ADD <Language>,<File_Path> . ..o 219
DISPlay:LANGuage:CATalog? <LanguUages>  ..cc.oiiiiouiiie it 220
DISPlay:LANGUAgE <LaNQUAGES  .iiiiiiiiiiiiiiiece ettt e e e et aaa s 219
DISPlay:LANGuage:REMOVE <LanNQUages> .....oooiiiiiiiiieiiiiiieee et 219
DISPIaY:MODE <MOGE> ..ottt ettt enae e 76
DISPlay:PALEtte <Palettes> .o 77
DISPIay:PERSISTENCEICLEAr  .iiiiiiiiiiiieii e 80
DISPlay:PERSistence:INFinite <Inf_Persistences> ... 80
DISPlay:PERSISIENCE:STATE <STATE> oo 80
DISPlay:PERSIistence: TIME:AUTO <AUTO>  oiiiiiiiiiiiiiieee ettt 80
DISPlay:PERSIstence:TIME <TIME> .o 80
DISPIAY:STYLE <SIYIE>  1iiiiiii ittt e e s e e e e b e e e beeenbe e et beennaee e 81
DISPlay:VSCReen:ENABIe <ENables> oo 77
DISPlay:VSCReen:POSItIoN <POSITION>  ...uiiiiiiiiiii e 77
DISPIay: XY XSOUICE SSOUICES  .oiiiei ittt 78
DISPIaY: XY Y TSOUICE SSOUMCES  .oiiiiiiiieiiitie ettt aa e 78
DISPIaY: XY Y2S0UICE SSOUMCES  oiiiiiiiieiiiie ettt et e e e e e aaaaee e 78
DISPIay:XY:ZMODE <MOAE>  .oiiiiiiiiiiiieii e 78
DISPIay:XY:ZSOUICE SSOUICE>  .iiiiiiiiiiiiiiiee ettt e e e e e e e e et a e 79
DISPlay:XY:ZTHReshold <Z_Threshold> ... 79
DVIMIENABIE ittt ettt ettt ettt ettt etae et 146
DVM<m>:RESURLEACTUAI? oo 146
DVM<m>:RESUR[:ACTUAISTATUS oo 146
DVM<MSISOURCE  ciiieiiiii ettt ettt ettt ettt e ettt e e ettt etb e e et e e ntaeennbeeareeennnean 145
DAY B g P I o SO PPPURTR 145
DVIMEIPOSIION ittt ettt ettt e e skt e e st e e st e e e tb e e stb e e e tbeestbeestbeesnbesntaeensbeeas 146
FESE VaAlUBS e 29
B S R 7 ittt e et et aae e 29
EXPort:SEARCh:NAME <FileNamMe> ..o 104
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